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1 INTRODUCTIE 

1.1 AANLEIDING 

Voorliggend document betreft een draaiboek voor het opstellen van verschillende typen Baseline maatregelen. Het 

draaiboek draagt bij aan het realiseren van een uniformere werkwijze bij het bouwen van Baseline maatregelen.  

 

Het draaiboek, opgesteld in opdracht van RWS-WVL en afgestemd met de RWS-ON, RWS-ZN en RWS-WNZ, vervangt de 

inmiddels sterk verouderde dienstspecificaties. Een deel van de info uit de dienstspecificaties is nu opgenomen in het 

Dataprotocol Baseline. Daarnaast zijn een aantal schematisatie handleidingen/instructies gebruikt bij het completeren 

van het draaiboek. 

 

De gebruikte bronnen voor het draaiboek worden weergegeven in Tabel 1. Deze documenten zijn aangeleverd door 

RWS-ON. Bij het gebruik van deze bronnen is gelet op de datum van het document. Een nieuw document prevaleert 

wanneer eenzelfde onderwerp wordt besproken. Op deze manier is het nieuwste inzicht verwerkt in dit draaiboek. 

Voor het draaiboek Ruwheid en overige featureclasses is gebruik gemaakt van teksten van Witteveen+Bos (2025)1. 

De informatie over vegetatieleggerklassen is overgenomen uit het concept RBK 7.0. 

 

Tabel 1: Gebruikte bronnen 

BRON  AUTEUR DATUM 

BASELINE MAATREGELEN, EISEN EN RICHTLIJNEN RWS-ON 6-7-2007 

DIENSTSPECIFICATIES INVOER BASELINE 4, VERSIE 7.0 RWS-DID 8-11-2011 

AANVULLENDE SCHEMATISATIE-PRINCIPES BASELINE RWS-ON 1-7-2015 

20200205_AANPAK SCHEMATISEREN MAATREGELEN BASELINE VECHT_BIJLAGE_3 ? 5-2-2020 

MEMO VERSCHILANALYSE (GEDEELTELIJK) ? 16-11-2021 

 

1.2 DOEL 

Het doel van dit draaiboek voor het opstellen van Baseline maatregelen ten behoeve van de zesde generatie modellen 

(gemaakt in Baseline 7) is het bieden van een uniforme en transparante werkwijze voor het opbouwen van maatregelen 

op basis van de meest actuele inzichten. Daarnaast poogt het draaiboek de toegankelijkheid voor nieuwe Baseline 

gebruikers te vergroten. Het draaiboek dient gebruikt te worden in combinatie met de Baseline 7 Help en het Baseline 

7 Dataprotocol. Daarnaast geeft het draaiboek voorbeelden van te gebruiken tools die beschikbaar zijn in ArcGIS Pro.  

 

Dit draaiboek bestaat uit 5 onderdelen: 

1. Algemene informatie Baseline maatregelen 

2. Draaiboek hoogte-informatie 

3. Draaiboek lodingen 

4. Draaiboek ruwhied 

5. Draaiboek overige Featureclasses 

6. Draaiboek Baseline clip featureclasses en modelboundaries 

 
1 Witteveen+Bos (2025). Draaiboek Baseline maatregelen. Versie definitief, 1 april 2025, 145194/25-005.144. 
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Het onderscheid in de eerste 3 draaiboeken is gemaakt omdat dit aansluit op de cyclus van actualiseren van Baseline 

data; lodingen worden voor veel gebieden jaarlijks geactualiseerd, ecotopen/ruwheid om de zes jaar en hoogte-

informatie alleen als er in een gebied een ontwikkeling heeft plaats gevonden. Het draaiboek met overige 

featureclasses beschrijft de benodigde acties wanneer andere featureclasses dan in de voorgaande 3 draaiboeken 

beschreven, moeten worden aangepast of uitgebreid. Dit zijn over het algemeen minder voorkomende typen Baseline 

aanpassingen. Het draaiboek Baseline clip featureclasses en modelboundaries is alleen benodigd in het geval van 

gebiedsuitbreidingen (dijkteruglegging / nieuw watersysteem in Baseline-NL). 

 

Het gebruik van de verschillende onderdelen wordt gedefinieerd door de begrenzing van de (gemiddelde) water-

/oeverlijn; gebieden die normaal gesproken onder water liggen worden over het algemeen middels lodingen 

geactualiseerd, gebieden boven water middels een actualisatie uit over het algemeen (3D) topografische bestanden. 

Ecotoopkarteringen bestrijken veelal zowel droge als natte gebieden, in de ecotoopkartering is de 

inundatiefrequentie/relatieve hoogteligging vaak onderdeel van de classificatie. 

 

 
Figuur 1: Begrenzingen draaiboeken 

Als er sprake is van een nog niet gerealiseerde ontwikkeling dan wordt een Baseline maatregel gebaseerd op een 

ontwerptekening, waarin vaak zowel de “droge” als “natte” delen zijn opgenomen. Dan is er echter geen sprake van 

lodinginformatie maar van onder water ontwerp lijnen. In dat geval kan het draaiboek hoogte-informatie worden 

doorlopen. En voor hetzelfde ontwerp kan ook het draaiboek ruwheid worden gebruikt. 

Hoofdstuk 3 bevat het draaiboek ten behoeve van de “droge” hoogtegegevens in de Baseline database, te weten de 

FeatureDataset “Elevation”. Voor het verwerken van “natte” hoogtegegevens wordt verwezen naar hoofdstuk 4; het 
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draaiboek lodingen. In hoofdstuk 5 komt het draaiboek ruwheid aan de orde. De werkwijze voor het aanpassen van 

overige featureclasses, nog beschreven in de andere draaiboeken komt tot slot in hoofdstuk 6 aan de orde. 

 

Het draaiboek is als volgt opgebouwd: Er wordt gestart met een algemene introductie over Baseline maatregelen. 

Daarna worden de 3 afzonderlijke draaiboeken beschreven in de volgende volgorde; eerst worden mogelijke bronnen 

beschreven welke gebruikt kunnen worden voor het opstellen van de maatregel. Vervolgens wordt beschreven welke 

verschillende Feature Classes gebruikt kunnen worden binnen de workflow van het opstellen van de daadwerkelijke 

maatregel. Daarna wordt per Feature Class uitgelegd wanneer deze gebruikt dient te worden en welke uitzonderingen 

er van toepassing zijn. Er worden eveneens tools aangereikt welke de gebruiker kan inzetten om het gewenste resultaat 

te bereiken. Het is de verantwoordelijkheid voor de gebruiker om de resultaten te controleren. 

 

Merk daarbij op dat dit draaiboek niet bedoeld is als GIS-cursus. Er wordt een zekere basiskennis van ArcGIS (desktop of 

Pro) verondersteld bij het beschrijven van de verschillende onderdelen. Bovendien wordt enige basiskennis van 

hydraulische modellen gewenst om de draaiboeken te kunnen begrijpen. 

  



 

030255 – Draaiboek Baseline maatregelen 
 
 

WSP 
Juli 2025 

pagina 10/81 
  

 

2 ALGEMENE INTRODUCTIE 
MAATREGELEN 

2.1 BASELINE DATABASES 

Een Baseline database is een mappenstructuur met daarin een ESRI GIS Filegeodatabase met daarin een aantal 

Featureclasses die samen een gebiedsbeschrijving vormen van een watersysteem (zie Baseline 7 Dataprotocol). Deze 

database wordt met behulp van een stekker “Conversion to D-Flow FM” omgezet naar D-Hydro invoer bestanden. 

 

In het verleden waren er een groot aantal Baseline databases van verschillende modelgebieden in omloop. Het beheer 

en onderhoud van al deze databases was enorm veel werk. In 2020 zijn alle regionale Baseline databases 

samengevoegd in één landelijke Baseline database; Baseline-NL. Daarmee is het beheer en onderhoud efficiënter 

geworden. Elk jaar leveren de regionale diensten van RWS nieuwe maatregelen aan waarmee de landelijke database 

wordt geactualiseerd. Het beheer en onderhoud van de databases is door RWS gedelegeerd aan Deltares. 

2.1.1 BASELINE-NL_LAND EN BASELINE-NL_ZEE 

De gebiedsschematisatie van Baseline-NL omvat het totale beheergebied van Rijkswaterstaat m.u.v. de Midden-

Limburgse en Noord-Brabantse Kanalen, Twentekanaal en de vaarweg van Lemmer naar Delfzijl. Daarnaast is ook de 

totale Noordzee, Waddenzee en het Noordwest Europese Continentaal Plat in deze gebiedsschematisatie opgenomen. 

De dekking van Baseline-NL is op zee groter dan alleen het RWS-Hoofdwatersysteem, maar omvat in ieder geval de 

RWS-beheergebieden: Rijn Maasmonding, Rijntakken, Maas, IJsselmeer, IJsselvechtdelta, Veluwerandmeren, 

Markermeer, Waddenzee, Noordzee, Zuidwestelijke Delta, Noordzeekanaal en Amsterdam-Rijnkanaal. 

De gebiedsschematisatie is opgedeeld in twee delen, een landdeel en een zeedeel. Het land-deel wordt weergegeven in 

het Rijks-Driehoeks coördinatenstelsel en het verticale referentievlak is ten opzichte van Normaal Amsterdams Peil 

(NAP). Het zee-deel (vanaf 20 mijl uit de Nederlandse kust) wordt weergegeven in het WGS84 coördinatenstelsel en het 

verticale referentievlak is ten opzichte van de Mean Sea Level (MSL). 

Vanwege het gebruik van deze verschillende coördinatenstelsels is het datamodel van een land-database anders dan 

die van een zee-database. Een en ander staat verder toegelicht in de Baseline 7 Help en het Baseline 7 Dataprotocol. 

2.1.2 LANDELIJKE VERSUS REGIONALE BASELINE DATA 

Vanuit de landelijke Baseline database worden uitsnedes gemaakt ten behoeve van regionale 

watersystemen/modelgebieden, zoals Rijntakken, Maas, Rijn-Maasmonding, Zuidwestelijke Delta, et cetera. Deltares 

beheert een filegeodatabase met daarin de clip-contouren om deze regionale uitsnedes te maken. 

2.1.3 ACTUEEL VERSUS BEHEER & ONDERHOUD 

Er wordt onderscheid gemaakt in twee typen gebiedsschematisaties/databases; enerzijds heb je schematisaties die zo 

goed mogelijk de geometrie van de rijkswateren beschrijft in een bepaald jaar, dit zijn de zogenaamde j-schematisaties, 

j19 betekent in dit geval het jaar 2019. Daarnaast wordt voor vergunningverlening gebruik gemaakt van beheer en 

onderhoud schematisaties (beno), dit zijn j-schematisaties aangevuld met vergunningen, projecten die met grote 

waarschijnlijkheid zullen worden gerealiseerd en bijvoorbeeld de vegetatielegger. Schematisatie beno19 staat voor het 

beno in het jaar 2019. Achterliggende reden voor dit onderscheid is dat operationele hoogwatervoorspelling gebruikt 
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maakt van de actuele j-schematisaties, terwijl bij vergunningaanvragen een beno-schematisatie wordt gebruikt, hierin 

zit een theoretische situatie (veelal worst-case) waarin ook nog niet-gerealiseerde ontwikkelingen zijn opgenomen. 

2.2 WAT IS EEN BASELINE MAATREGEL? 

2.2.1 FILOSOFIE 

De Baseline filosofie gaat er van uit dat het doorvoeren van wijzigingen in gebiedsschematisaties en de geometrie van 

modellen altijd via de applicatie Baseline zelf loopt. De applicatie werkt met lijsten en genereert logbestanden waarmee 

de historie van een Baseline database en de hier van afgeleide D-Hydro navolgbaar en reproduceerbaar is.  

Een Baseline gebruiker\modelleur is prima in staat om buiten Baseline om geodata in de Baseline database te 

manipuleren of om direct in D-Hydro bestanden wijzigingen aan te brengen, maar daarmee is de reproduceerbaarheid 

van de Baseline database en het bijbehorende D-Hydro model niet langer gegarandeerd. 

2.2.2 DEFINITIES 

Alvorens dieper in te gaan op Baseline maatregelen worden hier in het kort enkele definities gegeven van in dit 

draaiboek gebruikte termen. 

 

Modelschematisatie 

Modelschematisaties zijn numerieke wiskundige modellen van het watersysteem. Voor de uitvoering van haar 

kerntaken rondom de Nederlandse hoofdwatersystemen gebruikt en ontwikkelt Rijkswaterstaat modelschematisaties. 

De zesde generatie modelschematisaties zijn gebaseerd op de D-HYDRO Suite software. 

 

Gebiedsschematisatie 

De onderliggende geografische gegevens voor de modelschematisaties van Rijkswaterstaat zijn verzameld in de 

bijbehorende Baseline-NL/Zee databases. Een gebiedsschematisatie is een regionale uitsnede uit de Baseline-NL/Zee 

databases. 

 

Referentie 

Een Baseline referentie is een door RWS vastgestelde gebiedsschematisatie. Dit kan zowel een landelijke als een 

regionale Baseline database zijn en het kan een actuele of beno versie zijn. Bij het uitvoeren van een modelstudie 

vraagt de initiatiefnemer via IPLO een modelschematisatie met bijbehorende gebiedsschematisatie aan. De 

modelschematisatie wordt dan referentiemodel genoemd en de gebiedsschematisatie de Baseline referentie of 

kortweg referentie. 

 

Maatregel 

Een Baseline maatregel is een beschrijving van een wijziging van een referentie. Deze wijziging kan betrekking hebben 

op één of meerdere Featureclasses uit de referentie, en kan een kleine lokale verandering beschrijven (zoals de 

verlaging van één krib) maar ook een verandering die het gehele gebied wijzigt (een nieuwe peiling van het zomerbed 

of een actuele ecotoopkartering). Omdat een Baseline maatregel vaak de geometrie op een locatie in de referentie heel 

specifiek wijzigt hoort deze maatregel ook altijd bij een referentie. De werking van dezelfde maatregel op een andere 

referentie is daarom niet gegarandeerd. Dit wordt verder uitgelegd in paragraaf 2.2.3. 

Baseline maatregelen kunnen daadwerkelijke veranderingen in een gebied bevatten of een ontwerpsituatie van een 

nieuw initiatief. In het eerste geval spreken we van een actualisatie maatregel, in het tweede geval van een 

ontwerpmaatregel. 
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Variant 

Een Baseline variant is (een kopie van) een referentie waarin met behulp van de Baseline applicatie één of meerdere 

Baseline maatregelen zijn opgenomen zodat een nieuwe gebiedsschematisatie ontstaat. Dit proces wordt weergegeven 

in Figuur 2. Het opnemen van maatregelen in een variant wordt ook wel inmixen genoemd en wordt in de applicatie 

Baseline uitgevoerd met behulp van de functie ‘Assimilate Measures”. 

 

 
Figuur 2: Workflow Baseline en relatie tussen verschillende begrippen. 

2.2.3 WERKING VAN MAATREGELEN 

Een Baseline maatregel bevat twee belangrijke elementen: 

1. Featureclasses met vlakken waarmee objecten uit een referentie kunnen worden verwijderd dan wel 

afgesneden, de zogenaamde erase-bestanden 

2. Featureclasses met nieuwe objecten, de zogenaamde toevoeg-bestanden 

 

Als voorbeeld wordt hier een kadeverlegging beschreven ofwel het verleggen van een “Elevated_line”. In deze situatie 

worden twee bestanden in de maatregel opgenomen. Het eerste bestand geeft aan binnen welk gebied de oude 

“Elevated_line” verwijderd dient te worden: de erase-Feature Class. Het tweede bestand is de beschrijving van de 

nieuwe ligging van de “Elevated_line” (een toevoeg- Feature Class). Bij het inmixen van deze maatregel in de Baseline 

referentie worden eerst alle “Elevated_lines” verwijderd die binnen de omtrek van de erase- Feature Class liggen, 

daarna wordt de nieuwe “Elevated_line” uit de toevoeg- Feature Class toegevoegd. Het resultaat is een variant op de 

referentie, waarin de betreffende “Elevated_line” is aangepast. Dit proces wordt weergegeven in Figuur 3. In het linker 

figuur is een Elevated_line uit de referentie zichtbaar. In het middelste figuur is met het groene vlak de erase Feature 

class weergegeven. Binnen dit vlak wordt de bestaande lijn verwijderd. Vervolgens wordt de rode lijn toegevoegd. Het 

resultaat (de variant) wordt weergegeven in het rechter figuur. 
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Referentie    Mixactie      Variant 

Figuur 3: Voorbeeldfiguur van een mixactie. De zwarte stippellijn stelt een bestaande Elevated_line voor, het groene vlak de erase 

Feature Class en de rode lijn de nieuwe toe te voegen Elevated line. 

Middels deze werkwijze kan een Baseline maatregel heel selectief in een variant op één locatie één object wijzigen, de 

overige featureclasses die onder het groene erase vlak liggen worden immers niet gewijzigd.  

2.2.4 AFHANKELIJKHEID MAATREGEL EN REFERENTIE 

Gevolg van bovenstaande werkwijze is wel dat een maatregel altijd bij een specifieke referentie hoort. Als de 

betreffende aan te passen kade door een actualisatie in een nieuwe referentie op een net andere locatie ligt (dit kan 

door bijvoorbeeld een iets andere inwinmethode van de brongegevens), zal het erasevlak van de maatregel de 

gewijzigde kade weliswaar wegknippen maar dan zal de toegevoegde nieuwe kade niet meer aansluiten op de kadelijn 

uit de referentie waardoor een gat in de kade kan ontstaan. Dit kan in het hiervan afgeleide model leiden tot een 

verkeerd stroombeeld. Daarom is het goed om te beseffen dat een maatregel een afhankelijkheid heeft van een 

referentie. Toepassing van dezelfde maatregel op een andere referentie dient altijd met zorg te gebeuren. 

2.2.5 OVERLAPPENDE MAATREGELEN 

In de praktijk komt het vaak voor dat er meerdere overlappende maatregelen op dezelfde locatie liggen. 

Zo kan er in een stuk rivierbed een actualisatie van het zomerbed plaatsvinden middels een nieuwe peiling. 

Tegelijkertijd kan er in de aangrenzende uiterwaard een ontwikkeling hebben plaatsgevonden waardoor hier een 

actualisatie maatregel moet worden toegepast. Ook kan er een nieuwe ecotopenkartering beschikbaar zijn en 

misschien liggen er ook nog wel (overlappende) vergunningen in het gebied die de daadwerkelijke veldsituatie 

overrulen. 

Bij het samenstellen van een actuele of mogelijk historische geometrie of bij het maken van een ben0 

gebiedsschematisatie is de volgorde van het mixen van maatregelen daarom ook van belang.  

Daarom wordt in de metainformatie van een maatregel vaak een geldigheidsdatum opgenomen; dit is het moment/jaar 

vanaf wanneer de maatregel geldig is. 

2.3 EISEN AAN EEN MAATREGEL 

Baseline maatregelen dienen te voldoen aan een aantal eisen die in de volgende paragrafen worden beschreven. Deze 

eisen hebben betrekking op de naamgeving, bestandsopbouw, erase- en toevoeglijst, een metadata-document en 

logbestanden met controles van de maatregel. Daarnaast dient een maatregel te voldoen aan eisen ten aanzien van 

inhoudelijke consistentie.  
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2.3.1 NAAMGEVING 

Er zijn twee naamgeving-conventies, namelijk voor actualisatie- en vergunningsmaatregelen. In dit draaiboek wordt 

enkel ingegaan op actualisatiesmaatregelen. Daarom wordt hier alleen die naamgeving besproken. 

De naamgeving van individuele Baseline 6 maatregelen is als volgt:  

- 2 letters, geeft de naam van het waterlichaam aan, bijvoorbeeld ma voor Maas en ij voor IJssel (in Bijlage 1) 

worden de mogelijkheden weergegeven.) 

- een underscore 

- maximaal 20 karakters om de maatregel te omschrijven. Gebruikelijk is om minimaal de naam van de locatie 

aan te geven. 

- een underscore 

- een letter en een cijfer. De eerste versie van een maatregel begint met a1. Het cijfer geeft het versie nummer 

van deze maatregel weer. Als in de maatregel een fout is aangetroffen en deze wordt verbeterd dan verandert 

de 1 in een 2. Dit geldt enkel wanneer de maatregel nog niet is opgenomen in Baseline-NL. Als de maatregel al 

wel is opgenomen in Baseline-NL wordt de verbetering van de fout opgenomen in een nieuwe maatregel. Als 

in hetzelfde gebied een andere maatregel wordt bedacht krijgt deze de letter b en als eerste cijfer een 1.  

- Let er op dat maatregelnamen geen spaties of vreemde leestekens bevatten. 

 

 Voorbeelden voor maatregel namen zijn dan: 

- rt_bruggen_j19_a5 (maatregel voor bruggen in de Rijntakken in j19_6) 

- ma_eco17_a1 (maatregel over de gehele Maas met een beschrijving van de ecotopenkartering 2017) 

 

Aanbevolen wordt om bij actualisatiemaatregelen overleg met de regionale dienst/opdrachtgever te voeren om te 

zorgen voor namen die niet al in gebruik zijn, en te zorgen voor consistentie in de namen. 

2.3.2 BESTANDSOPBOUW 

De Baseline boom (maatregel-database) bevat op de eerste plaats de Baseline databestanden (erase- en 

toevoegbestanden). Ten tweede bevat deze een metadata document dat de maatregel en de argumentatie van de 

opname-beslissingen beschrijft. Tot slot bevat de maatregel-database de bestanden append_list en erase_list, waarin 

opgenomen is welke Baseline databestanden aangepast worden. Deze bestanden worden opgeslagen in de map 

‘metainfo’. In deze map staan ook de logbestanden van de controle op protocol en content. 

 

De vereiste datastructuur voor Baseline maatregelen is opgenomen als bijlage A van het Dataprotocol. Alle toegepaste 

bronbestanden dienen opgenomen te worden in de map “data/source”. Dit kan als ESRI-Shapefile maar 

rasterbestanden worden als ESRI-grid, Erdas Imagine-img of (Geo)tiff-bestand opgeleverd. Ook toegeleverde 

bronbestanden zoals grids van lodingen, CAD- tekeningen etc. worden in deze map geplaatst. 

2.3.3 ERASE- EN TOEVOEGLIJST 

In de map metainfo/lists is een erase- en een append_list.txt opgenomen. De inhoud van deze bestanden is een lijst 

met de namen van de erase-Feature Classes waarmee Feature Classes in de variant gewist moeten worden of de 

toevoeg-Feature Classes waarmee Feature Classes bij het verwerken van de maatregel worden toegevoegd aan de 

variant. 

 

Deze lijsten kunnen geautomatiseerd worden aangemaakt middels Baseline preparation tool 11. 
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2.3.4 METADATA DOCUMENT 

Bij het opbouwen van een maatregel worden allerlei keuzes gemaakt: over de schematisatie (een onderdeel wel of niet 

opnemen, of hoe iets op te nemen), over het gebruik van tools (converteren of filteren van data), het gebruik van 

nieuwe ruwheidscodes maar ook over samenhang met andere maatregelen bijvoorbeeld. Het is belangrijk dat al dit 

soort informatie wordt vastgelegd. Daarom is afgesproken dat bij elke maatregel een Word-bestand gevoegd wordt 

genaamd ‘metadata_<maatregelnaam>.docx’ waarin deze informatie wordt vastgelegd. In dit bestand wordt ook 

informatie toegevoegd over verschillende aspecten van de maatregel, namelijk:  

• Het gebied waar de maatregel zich bevindt 

• De precieze locatie van de maatregel 

• Naam van het gebied 

• De rivierkilometers tussen welke de maatregel zich bevindt 

• Begrenzing van de maatregel (welke delen wel of niet veranderd) 

• Alle gebruikte databronnen (bv. welke de basis, welke als aanvulling) 

• Algemene keuzes die zijn gemaakt bij het realiseren van de maatregel 

• Algemene afwijkingen van dit document (bv. alle hoogtelijnen uit AHN) 

• Per feature class bronnen noemen en specifieke keuzes. 

Dit bestand wordt opgeslagen in de map ‘metainfo’. 

 

Zoals eerder beschreven is er een sjabloon voor dit document opgenomen in hieronder. 

 

Het is van groot belang dat het metadata document tijdig en juist wordt ingevuld, omdat inhoudelijke controle 

(juistheid van protocol, inhoud en hydraulische werking) van de opgeleverde maatregel anders niet mogelijk is en 

verder omdat maatregelen ook voor andere toepassingen kunnen worden gebruikt. Voor de volgorde van inmixen van 

een maatregel is het van belang aan te geven vanaf welke datum de maatregel geldig is en voor welke referentie deze 

gemaakt is. Ook dient de meta-informatie een overzichtskaartje van het maatregelgebied te bevatten. 

Het metadata sjabloon is opgenomen in bijlage 2. 

2.3.5 PROTOCOL- EN CONTENTCHECK 

Na afronding van de bouw van de maatregel wordt er altijd een protocol- en contentcheck uitgevoerd. In Baseline kan 

dit met prearation tool “13. Check variant/Measure” worden gedaan.  

Met behulp van de protocolcheck wordt een controle op het datamodel uitgevoerd. Dit houdt in dat gecontroleerd 

wordt of alle onderdelen van de File Geodatabase voldoen aan het datamodel, zie ook het Baseline dataprotocol. 

Hierbij valt te denken aan Feature Classes, veldnamen en eigenschappen. De contentcheck bevat een inhoudelijke 

controle. Hierbij valt te denken aan dubbele punten op eenzelfde locatie met een verschillende hoogte, 

land_use_polygons zonder een ROUGHNESS_CODE, teenhoogtes die hoger zijn dan de kruinhoogte etc. Van beide 

checks wordt een logfile weggeschreven in “metadata/logs’. Beide controles mogen GEEN errors bevatten. Die moeten 

worden opgelost. Warnings mogen wel blijven, maar verdienen wel aandacht in de metadata. 

2.3.6 PROEFMIX 

De ultieme test of een maatregel bij een mixactie tot een correcte variant leidt is om de maatregel daadwerkelijk in een 

variant in te mixen. Hierbij is het handig om de variant eerst te clippen met een polygoonbestand met een extent die 

wat groter is dan de toe te passen maatregel, bijvoorbeeld het gebied tot 1 kilometer bovenstrooms en 

benedenstrooms van de maatregel. Deze zogenaamd proefmix gaat een stuk sneller dan een proefmix in een volledige 

gebiedsschematisatie. Het resultaat van de proefmix kan visueel gecontroleerd worden. Hierbij moet worden 

gecontroleerd of het resultaat voldoet aan de verwachtingen (hoogtemodel/overlaten/ruwheden) en dat dit 

hydraulisch functioneert zoals beoogd.  
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Figuur 4: Proefmix; variant is Rijntakken, rode contour = maatregel, zwarte contour = clipcontour variant tbv proefmix 
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3 DRAAIBOEK HOOGTEINFORMATIE 

3.1 INLEIDING 

Dit hoofdstuk beschrijft de werkwijze voor het maken van Baseline maatregelen van de droge (boven water gelegen) 

delen van het watersysteem; te weten de uiterwaarden en oevers van de rivieren, kanalen, meren en kust.  

 

Het gaat in dit hoofdstuk vooral om de hoogte van deze gebieden. Hoofdstuk 4 (draaiboek lodingen) gaat in op de 

onder water gelegen delen en het landgebruik hiervan wordt beschreven in hoofdstuk 5, het draaiboek ruwheid. 

 

Dit hoofdstuk is als volgt opgebouwd; eerst wordt de terminologie (paragraaf 3.2) en definities (paragraaf 3.3) van 

hoogteinformatie beschreven, daarna de functie er van binnen Baseline en D-Hydro (paragraaf 3.4). In paragraaf 3.5 

worden beschikbare brongegevens voor het opbouwen van hoogteinformatie benoemd. In paragraaf 3.6 en 3.7 worden 

specifieke details van hoogtelijnen en -punten beschreven. Paragraaf 3.8 tenslotte beschrijft de workflow bij het 

opbouwen van een Baseline maatregel.  

3.2 TERMINOLOGIE 

In een Baseline database zijn twee soorten informatie met betrekking tot hoogte van belang, namelijk het 

bodemhoogtemodel en de zogenaamde overlaten. Deze worden beschreven aan de hand van Figuur 5. In deze figuur 

zie je in A. een standaard doorsnede door een rivier met een aantal elementen. Op plaatsen met steile hellingen (rood 

in B) treedt energieverlies op als er water overheen stroomt (verder toegelicht in paragraaf 3.3.7). Deze zogenaamde 

overlaten worden in Baseline apart geschematiseerd als vertikale muurtjes (Figuur 5 C) waarbij de kruin- en teenhoogte 

van de muurtjes van belang is voor dit energieverlies. De overige hoogte-informatie is opgenomen in het 

bodemhoogtemodel (Figuur 5 D). 

 

Overlaten 

Overlaten zijn lijnvormige verhogingen in het landschap zoals zomerkades, kribben en steilranden/terreinsprongen. De 

volgende typen hoogtelijnen zijn opgenomen in het overlatenbestand, tussen haakjes staan de namen van de 

bijbehorende Baseline featureclasses): 

 

• Kade (Elevated_line_routes, type Local embankment) 

• Krib (Elevated_line_routes, type Groyne) 

• Primaire kering (Elevated_line_routes, type Primary embankment) 

• Hoogteverschillijn (Terrain_jump_3d_routes) 

 

In (Figuur 5 D) is bij de rode pijlen te zien dat afgezien van hoogteverschillijnen de overlaten niet zijn opgenomen in het 

bodemhoogtemodel. Dit heeft als reden dat overlaten smalle elementen zijn en daarmee is er een kans dat ze via het 

bodemhoogtemodel niet of maar deels in de roosterprojectie van de bodem terecht zouden komen, met als gevolg 

lekkages van bijvoorbeeld een zomerkade. Door ze als lijnelementen op te nemen worden overlaten gegarandeerd in 

de schematisatie meegenomen, ongeacht de resolutie van het rekenrooster. 

 

Bodemhoogtemodel 

Het bodemhoogtemodel (elevation_model_terrain) beschrijft de maaiveldligging van het watersysteem, zowel boven 

als onder water. Dit hoofdstuk is beperkt tot de boven water gelegen delen van het watersysteem, hoofdstuk 4 

(draaiboek lodingen) gaat in op de onder water gelegen delen. Het hoogtemodel is een combinatie van een aantal 

onderliggende bestanden, namelijk hoogtelijnen en hoogtepunten. De volgende typen hoogtepunten en -lijnen zijn 

opgenomen in het hoogtemodel, tussen haakjes staan de namen van de bijbehorende Baseline featureclasses): 
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• Winterbedhoogtes (surfacelevel_points) 

• Plashoogtes (waterbody_bedlevel_points), zie hoofdstuk 4 (draaiboek lodingen) 

• Zomerbedhoogtes (bedlevel_points), zie hoofdstuk 4 (draaiboek lodingen) 

• Breuklijn (Terrain_edge_3d_lines) 

• Hoogteverschillijn (Terrain_jump_3d_routes) 
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Figuur 5: Zijaanzicht Schematische weergave van A. een rivierbed, B. overlaten in rood, C. geschematiseerde overlaten in rood, D. 

bodemhoogte 
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3.3 DEFINITIE 

In onderstaande paragrafen wordt een definitie van de verschillende typen hoogtelijnen gegeven. 

Voor elk van deze Feature Classes wordt in het Baseline 7 Dataprotocol de vereiste bestandsopbouw beschreven, 

evenals de vertaling naar D-HYDRO. 

3.3.1 BREUKLIJN (TERRAIN_EDGE) 

De breuklijn geeft een overgang in bodemhoogte weer. Dit is bijvoorbeeld de overgang van een flauw talud naar een 

horizontaal terrein of de plaats waar de helling van het talud verandert, zie Figuur 6.  

Ook een iso-hoogtelijn zal vaak een breuklijn worden. In het geval van een maatregel die een ontwerp beschrijft komt 

aan de rand van de maatregel een insteeklijn (bij een ophoging wordt dit een breuklijn, bij een verlaging een breuklijn 

of hoogteverschillijn, afhankelijk van het talud, zie volgende paragraaf).  

 

 
Figuur 6: Zijaanzicht Dwarsdoorsnede terreinophoging met flauwe taluds. 

Voor elk punt (vertex) op de breuklijn dient alleen de hoogte van het maaiveld te worden aangegeven. De hoogte kan 

langs een breuklijn variëren.  

3.3.2 HOOGTEVERSCHILLIJN (TERRAIN_JUMP) 

Een hoogteverschillijn is een breuklijn aan de bovenzijde van een steil talud, hierbij wordt 1: 7 als grens voor steil 

gehanteerd. Bij een hoogteverschillijn is er per definitie slechts aan één kant sprake van een talud. Een 

hoogteverschillijn komt voor bij wat grotere hooggelegen terreinen (bijv. hoogwatervrije vlakken en gebouwen), steile 

rivieroevers of bij afgravingen (klei - en zandputten). De kruin -als dit al als zodanig kan worden opgevat- , is dus breder 

dan 10 meter (zie Figuur 7).  

 

 
Figuur 7: Zijaanzicht Dwarsdoorsnede terreinverhoging met steil talud. 

De hoogteverschillijn ligt op de locatie van de (evt. fictieve) kruinlijn. Aan de onderkant van het talud komt een 

breuklijn (teenlijn). Elk punt (event) op de hoogteverschillijn dient te worden voorzien van een aantal 

hoogteparameters: de kruinhoogte (de bodemhoogte ter plaatse van de bovenkant van het talud), de kruinbreedte 

(standaardwaarde 10 m), de bodemhoogte van de onderkant van het talud (teenhoogte), de bodemhoogte aan de 

andere kant van de hoogteverschillijn (geen talud, deze is gelijk aan de kruinhoogte) en tot slot de taludhelling links en 
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rechts. Voor de taludhelling aan de zijde van de taludsprong dient de werkelijke helling te worden ingevuld. Voor de 

taludhelling aan de andere zijde de default standaardwaarde (1:4), omdat deze helling geen fysieke betekenis heeft. De 

hoogte waarden van de parameters van de lijnen kunnen in de lengterichting (langs de lijnen) variëren.  

 

Door nieuwe kennis blijkt de harde grens van 1:7 niet terecht. Ook taluds van 1:7 en flauwer geven een 

stromingsweerstand door zogenaamde ‘overlaatwerking’, die met het flauwer worden van het talud wel steeds minder 

wordt. Dit inzicht mag alleen worden gebruikt bij het verflauwen van een bestaand talud. De hoogteverschillijn wordt 

dan ook toegepast voor een talud met een helling van 1:7 of flauwer. Zie ook de toelichting in paragraaf 3.3.7. Voor 

nieuw aan te leggen taluds geldt nog steeds dat het talud van een hoogteverschillijn steiler is dan 1:7  

 

3.3.3 KADES (ELEVATED_LINE, TYPE LOCAL EMBANKMENT) 

Een kade is een smalle, langgerekte verhoging in het terrein met aan weerszijden een steil talud. De breedte van de 

kruin is maximaal 10 m.  

Kades kunnen verschillende functies hebben, bijvoorbeeld als grondlichaam voor een weg, stroomgeleiding, 

waterkering voor de zomerperiode (zomerkaden). Ook kribben worden beschouwd als een kade. Meestal zijn kaden 

aangelegd (kunstmatig). Maar ook terreinruggen, die aan de bovenstaande kenmerken voldoen, worden als een kade 

beschouwd.  

De kade wordt weergegeven als een enkele lijn (in het midden in de lengterichting van de kade). Elk punt (event) op de 

kadelijn dient te worden voorzien van een aantal parameters: een aantal hoogtes, namelijk de kruinhoogte (hoogste 

punt op de kade in de dwarsdoorsnede), de kruinbreedte, de hoogte van de bodem links en rechts naast de taluds van 

de kade en tot slot de taludhelling links en rechts (zie figuur 3). De waarden van de hoogtes kunnen in de lengterichting 

van de kade variëren.  

 

 
Figuur 3. Zijaanzicht Dwarsdoorsnede kade   

 

De laaggelegen teenlijnen, die de bodemhoogte naast de kade schematisch weergeven, dienen als breuklijn te worden 

beschouwd.  

 

Door nieuwe kennis blijkt de harde grens van 1:7 niet terecht. Ook taluds van 1:7 en flauwer geven een 

stromingsweerstand door de zogenaamde ‘overlaatwerking, die met het flauwer worden van het talud wel steeds 

minder wordt. Dit inzicht mag alleen worden gebruikt bij het verflauwen van het talud van een bestaande kade. Zie ook 

de toelichting in paragraaf 3.3.7. Voor nieuw aan te leggen kaden geldt nog steeds dat het talud van een kade steiler is 

dan 1:7.   

 

De laaggelegen teenlijnen, die de bodemhoogte naast de kade schematisch weergeven, dienen als breuklijn te worden 

beschouwd.  
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3.3.4 KRIBBEN (ELEVATED_LINE, TYPE GROYNE) 

Kribben zijn een bijzondere vorm van een kade. Langs kribben ontbreekt meestal (een deel van) de teenlijn, omdat deze 

zich onder water bevindt. De overige elementen van een kade worden ook weergegeven bij een krib. Kribben liggen 

direct langs de rivier en zorgen voor een gelijkmatige breedte van de rivier en daarmee voor geconcentreerde stroming. 

3.3.5 PRIMAIRE KERINGEN (ELEVATED_LINE, TYPE PRIMARY EMBANKMENT) 

Ook primaire keringen zijn een bijzondere vorm van kades, ze vormen namelijk de grens van het watersysteem. 

Primaire keringen zijn kades met een bijzondere status; ze vormen de scheding tussen het rivierbed en binnendijkse 

gebieden en vormen daarmee meestal de harde grens van hydrodynamische modellen. 

3.3.6 INSTEEKLIJN 

De term insteeklijn wordt gebruikt bij een kunstmatige verhoging of verlaging in het terrein. Bij een hoogwatervrij 

terrein, kade of primaire kering is de insteeklijn de lijn die de onderzijde van het talud markeert en dan fungeert de lijn 

als breuklijn. Bij een zand- of kleiwinning is het juist de lijn die de bovenkant van de afgraving aangeeft,afhankelijk van 

de talud helling is de insteeklijn een hoogteverschillijn (steiler dan 1:7) of breuklijn (flauwer dan 1:7). 

 

Bij modelactualisaties wordt de grens van het te actualiseren gebied vaak als insteeklijn beschouwd, dan is het een 

fictieve lijn. De insteeklijn ligt daar waar het maaiveld verandert en niet rond de hele maatregel. Daar waar in de 

referentie al een lijn aanwezig is, hoeft geen extra lijn te worden toegevoegd. Bij actualisaties wordt alleen data 

toegevoegd die daadwerkelijk is ingemeten. Indien de actualisatie een vergraving of ophoging betreft dan wordt de 

insteeklijn daarvan altijd ingemeten. 

Bij ontwerpsituaties wordt de buitengrens van het ontwerp als insteeklijn gezien.  

Buiten de insteeklijn blijft de terreinsituatie dus gelijk. 

3.3.7 OVERLATEN 

Overlaten zijn lijnvormige verhogingen in het landschap zoals kades, kribben en steilranden/terreinsprongen. Het 

bijzondere van een overlaat is de sterke vertraging van de stroming aan de benedenstroomse zijde. Het sterk vertragen 

van het stromende water veroorzaakt een grote turbulentie en de aanwezigheid van een (bodem)neer. Hierdoor treedt 

er een groot energieverlies op in vergelijking met het energieverlies door bodemwrijving.  

 

Het energieverlies veroorzaakt een hogere waterstand bovenstrooms van de overlaat. In Figuur 8 is de stroming over 

een kade schematisch aangegeven. De pijl geeft de stroomrichting en -snelheid aan.   

 

 
Figuur 8: Zijaanzicht Dwarsdoorsnede en stroming over een kade   
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Boven de kruin van de overlaat wordt het water versneld, waarna het achter de overlaat wordt vertraagd. Naast de 

bekende vormen van overlaten als kaden en kribben wordt elke plaats waar een sterke stroomvertraging kan optreden, 

gezien als een overlaat. Dit betekent dat ook kademuren en steile taluds in het maaiveld (hoogteverschillijn bij helling 

steiler dan ca 1:7) als overlaten worden beschouwd.   

 

De grootte van het energieverlies (∆E) wordt bepaald door de stroming (afvoer over de overlaat, de energiehoogte E1) 

en de afmetingen van de kade (kruinhoogte en drempelhoogte ‘d’). Hoe hoger de kade en/of drempelhoogte des te 

groter het energieverlies.  

 

De invloed van de overlaatvorm is in D-Flow FM te berekenen door de zogenaamde Villemonte parameters 

(kruinbreedte, taludhellingen) aan te passen. Voor het aanpassen van de vorm van een bestaande overlaat 

(bijvoorbeeld het verflauwen van een talud) is het noodzakelijk dat de overlaatvorm in de referentie berekening goed 

moet zijn geschematiseerd, d.w.z. dat deze overeenkomt met de werkelijke dan wel de vergunde kruinbreedte en 

taludhellingen.  

 

3.3.8 SAMENVATTING HOOGTELIJNEN/OVERLATEN 

Het begin en eind van een talud(vlak) worden begrensd door breuklijnen (met punten op verschillende NAP-hoogten). 

De laag gelegen breuklijn is de teenlijn van het talud en de hooggelegen breuklijn is de kruinlijn van het talud.   

 

Als de taludhelling steiler is dan 1:7 dan wordt de hooggelegen breuklijn (kruinlijn) gedefinieerd als een 

hoogteverschillijn (en dus als een overlaat met energieverliezen in de D-FLOW FM-berekening).  

 

Als de kruinbreedte kleiner is dan 10 m en beide taluds zijn steiler dan 1:7, dan wordt voldaan aan de definitie van een 

kade (en dus als een overlaat met energieverliezen in de D-FLOW FM-berekening). De beide kruinlijnen 

(hoogteverschillijnen) van de kruin van de kade worden dan vervangen door één kadelijn in het midden van de kruin 

(met NAP-hoogten gelijk aan het hoogste punt in de dwarsdoorsnede).  

 

Bij een effectberekening met een andere overlaatvorm, onder anderen bij andere taludhellingen, dient ook een flauw 

talud weergeven te worden door een hoogteverschillijn of een kadelijn (en dus als een overlaat met energieverliezen in 

de D-FLOW FM-berekening). 

 

Voor het aanpassen van de vorm van een bestaande overlaat (bijvoorbeeld het verflauwen van een talud) is het 

noodzakelijk dat de overlaatvorm in de referentie berekening goed moet zijn geschematiseerd, d.w.z. dat deze 

overeenkomt met de werkelijke dan wel de vergunde kruinbreedte en taludhellingen.  

 

Het 1:7 criterium is niet van toepassing voor het simuleren van gestroomlijnde overlaten. Hierdoor wordt het risico 

weggenomen dat het energieverlies ter plaatse van gestroomlijnde overlaten niet goed in D-FLOW FM berekend wordt 

omdat de hellingshoek niet meer als overlaat herkend wordt.  

3.4 FUNCTIE 

3.4.1 BODEMHOOGTEMODEL 

De Baseline functie “Conversion to D-Flow FM”, ook wel Bas2fm genoemd, vertaalt “elevation_model_terrain” naar 

<model name>_net.nc. De hoogtes worden ter plekke van de cell nodes (default) of cell centers “geprikt” in het 

“elevation_model_terrain”. Het resultaat van deze conversie is in ArcGIS te inspecteren; cell nodes en cell centers zitten 

in respectievelijk <model name>_net.gdb\depth_fm en face_depth_fm. 
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Voor kust- en zeemodellen wordt de hoogte ter plekke van de cell nodes niet geprikt maar gemiddeld. Hierbij wordt de 

hoogte ter plekke van de cell nodes of cell centers bepaald door het middelen van de hoogte in het 

“elevation_model_raster” binnen representatieve polygonen rondom de cell nodes. Deze polygonen zitten in <model 

name>_net.gdb\ZonalFc. Dit wordt gedaan door in de functie “Conversion to D-Flow FM” “Use elevation Interpolation” 

aan te vinken. 

 

Voor uitgebreidere informatie wordt verwezen naar Appendix 3 van de Baseline Help. 

3.4.2 OVERLATEN 

De Baseline functie “Conversion to D-Flow FM” vertaalt “elevated_line_routes” en “terrain_jump_3d_routes” naar 

<model name>_fxw.pliz. D-Hydro zorgt zelf voor de projectie van deze overlaten op het rooster.  

De zogenaamde “snapped features” die D-Hydro wegschrijft bevatten shapefiles van deze geprojecteerde versie en 

kunnen in ArcGis worden bekeken. 

 

Voor uitgebreidere informatie wordt verwezen naar Appendix 3 van de Baseline Help. 

3.5 BRONNEN 

De hoogte-informatie binnen Baseline (Feature Dataset Elevation) is afkomstig uit verschillende bronnen. Hieronder 

worden de meest gebruikte bronnen opgesomd. Deze worden daarna afzonderlijk besproken. 

• DTB 

• AHN 

• BGT 

• Top10NL 

• Ontwerp-tekeningen (CAD en/of GIS) 

• Handmatig gedigitaliseerd 

• Terrestrische metingen 

• Laseraltimetriedata 

 

Merk op dat het zeker niet is uitgesloten dat er nog andere bronnen mogelijk zijn. 

• Luchtfoto's verticaal 

• Luchtfoto's oblique (onder een schuine hoek) 

• Satellietopnames (Sentinel, satellietdataportaal): vaak actueler 

• Veldbezoek 

• Streetview Google 

 

Voordat er goed met de verschillende databronnen gewerkt kan worden zijn een aantal bewerkingen nodig. Voor elke 

bron geldt dat deze ruim afgeknipt dient te worden op het interessegebied. De overige bewerkingen worden per bron 

behandeld. 

3.5.1 DTB 

Het Digitaal Topografisch Bestand, afgekort DTB is het belangrijkste (en voorkeur) bronbestand voor alle hoogte-

elementen in het winterbed.  

 

Het DTB is het standaard geo-informatiebestand voor Rijkswaterstaat en het ministerie van Infrastructuur en 

Waterstaat. Het DTB bevat gedetailleerde 3D-informatie (schaal 1:1000). Voor waterwegen staan er in het DTB 
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bijvoorbeeld dijken, kades, sluizen, oevers, kribben, duikers, afrasteringen en vaarwegsignaleringen. Het bestand bevat 

tevens hoogte-informatie van het maaiveld en bepaalde objecten zoals de hoogte van geluidsschermen. Ook 

breuklijnen, zoals kanten van een talud, worden ingemeten en in het bestand opgenomen.  

 

In Tabel 2 wordt een overzicht gegeven welke standaard codes uit het DTB dienen te worden opgenomen in de 

corresponderende Feature Classes in Baseline 6. Merk hierbij op dat elke lijn door de modelleur moet worden 

beoordeeld. Geverifieerd moet worden of de toegekende code in de specifieke situatie juist is (en daarmee de 

gebruikte Feature Class in Baseline 6). Het kan voorkomen dat codes verkeerd toegekend zijn, echter het kom ook voor 

dat een lijn twee betekenissen heeft (bijvoorbeeld een raster/hekwerk en een hoogteverschillijn), en er maar één code 

is opgenomen. Maak daarom altijd een hoogtemodel van het volledige DTB met daarbij de volgende aandachtspunten: 

• Neem zowel punten, lijnen als vlakken op in het TIN. 

• Maak een selectie in deze 3 bestanden van LAYER = 1 om bruggen te verwijderen. 

• In het huidige DTB zijn alle waterniveaulijnen en maaiveldlijnen om gebouwen verwijderd. De hoogte-

informatie is nu opgenomen in de bijbehorende vlakken. Deze vlakken moeten dus eerst geselecteerd worden 

en omgezet naar 3D lijnen.  

Beoordeel op basis van het opgebouwde TIN of je relevante lijnen mist en voeg deze lijnen toe aan de juiste 

featureclass. 

 

Tabel 2: Relatie DTB code en Baseline Featureclass 

FEATURE CLASS BIJBEHORENDE CODES UIT  

DTB-Lijnen DTB-Vlakken DTB-Punten 

TERRAIN_JUMPS H05 (hoogteverschillijn)2 

R3105 (damwand) 

ZH7 (bovenkant talud) 1 

R3107 (kademuur)3 

MD27 (maaiveldlijnen algemeen)4 

  

ELEVATED_LINES; GROYNE R0501 (kribrug)   

ELEVATED LINES; LOCAL 
EMBANKMENT 

H0701 (kade) 

MD31 (kruinlijn) 

R17 (coupure) 

  

ELEVATED LINES; PRIMARY 
EMBANKMENT 

MD30 (winterbedlijn) 

MD31 (kruinlijn)5 

  

TERRAIN_EDGE ZH1 (breuklijn soft) 

ZH6 (talud onderkant) 

ZH5 (insteek sloot) 

T0105 (insteek sloot) 

W09 (waterniveaulijn/oeverlijn) 

MD17 (mvln geb/kunstw/instal) 

MD49 (haven) 

W0101 (rivier) 

W0301 (kanaal) 

W030703 (sloot) 

W0701 (plas) 

W0705 (vijver) 

 

 

2 Bovenkant talud lijnen ZH7 en H05 moeten soms vervangen worden door een local embankment. 
3 Muren kunnen zowel in lijnen zitten als in vlakken. 
4 Verticale taluds zoals kademuren worden in het DTB vaak aangegeven met maaiveldlijnen algemeen. Dit geldt voor 

zowel onder- als bovenzijde. De bovenkant van een verticaal talud dient als Terrain_jump te worden opgenomen 
(mits het maaiveld aan één zijde op gelijke hoogte ligt als de kademuur. De onderkant van het talud wordt dan een 
Terrain_edge, op een minimale afstand van 10 centimeter van de Terrain_jump. 

5 Bij het gebruik van MD31 moet worden gecontroleerd (bijvoorbeeld met AHN4 en/of luchtfoto’s) of er op die locatie 
een Primary Embankment aanwezig is. Dit is niet overal het geval, immers wordt niet overal het winterbed begrensd 
door een Primary Embankment. 
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FEATURE CLASS BIJBEHORENDE CODES UIT  

DTB-Lijnen DTB-Vlakken DTB-Punten 

SURFACELEVEL_POINTS   H03 (hoogtepunt) 

3.5.2 AHN 

Het Actueel Hoogtebestand Nederland (AHN) is de digitale hoogtekaart van Nederland. Het bevat gedetailleerde 

informatie en wordt opgebouwd met gemiddeld acht hoogtemetingen per vierkante meter. 

 

Het AHN wordt geleverd in verschillende resoluties en verschillende versies. Verschillende versies hebben betrekking 

op verschillende inwinjaren (en soms op de specificaties van inwinning). Ook de dekking op de grens land-water kan 

verschillen. Meer info op ahn.nl. De te gebruiken resolutie hangt af van het doel waarvoor de gegevens worden 

gebruikt. Er zijn twee typen bestanden: 0.5*0.5 m en 5*5 m. Beide hebben hun eigen functie (zie verderop). Merk wel 

op dat er enkel gebruik gemaakt dient te worden van de “DTM” versie. Dit betreft de gefilterde informatie met 

maaiveld gegevens. Dit betekent dat bijvoorbeeld vegetatie en bebouwing hieruit is gefilterd.  

3.5.3 BGT 

De Basisregistratie Grootschalige Topografie (BGT) is een digitale kaart van Nederland. Hierop zijn gebouwen, wegen, 

waterlopen en terreinen vastgelegd. Deze kaart is op 20 centimeter nauwkeurig en bevat daarmee veel detail.  

 

Merk hierbij op dat de BGT geen hoogte informatie bevat. Deze bron zal dan ook altijd in combinatie met het AHN 

gebruikt moeten worden. 

3.5.4 TOP10NL 

Wanneer er geen lijninformatie beschikbaar is kan er gebruik gemaakt worden van TOP10NL. TOPNL bestanden zijn 

objectgerichte topografische bestanden op diverse schaalniveaus. Deze bestanden maken onderdeel uit van de Basis 

Registratie Topografie (BRT). De bestanden zijn uniform, consistent en bovendien landsdekken (PDOK, 2022). 

 

Merk hierbij op dat de TOP10NL geen hoogte informatie bevat. Deze bron zal dan ook altijd in combinatie met het AHN 

gebruikt moeten worden. 

3.5.5 ONTWERPTEKENINGEN 

In het geval van planstudies of vergunningsaanvragen zal er niet gewerkt kunnen worden met de hiervoor genoemde 

bronnen omdat de voorgenomen activiteiten nog niet zijn gerealiseerd en daarom ook nog niet in deze bronnen zijn 

opgenomen. In deze gevallen dient er gebruik gemaakt te worden van ontwerptekeningen. Deze tekeningen kunnen in 

alle formaten zijn welke te visualiseren zijn in ArcGIS. In de praktijk zal dit betekenen dat dit CAD-tekeningen of GIS-

bestanden zijn. 

3.5.6 HANDMATIG GEDIGITALISEERD 

In uitzonderlijke gevallen is het mogelijk dat er geen brongegevens zijn voor bijvoorbeeld overlaten.  

Het is echter wel mogelijk dat deze op bijvoorbeeld luchtfoto’s wel zichtbaar zijn (en bekend vanuit gebiedskennis). 
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Deze kunnen dan handmatig gedigitaliseerd worden, waarna er handmatig een hoogte aan kan worden toegekend op 

basis van het AHN. 

3.5.7 TERRESTRISCHE METINGEN 

In enkele gevallen zullen er op een nadere manier ingewonnen hoogtegegevens beschikbaar zijn om te verwerken in de 

Baseline maatregel. 

3.5.8 LASERALTIMETRIEDATA 

Soms zijn er specifieke laseraltimetrie metingen voorhanden. Deze dienen op een vergelijkbare wijze als het AHN te 

worden verwerkt.  

3.5.9 VERSCHILLEN TUSSEN DE BRONNEN 

Tussen de eerder genoemde bronnen bestaan op verschillende aspecten verschillen: 

• In tijd: let op inwindatum en kijk of het gebied misschien veranderd is; 

• In geografische ligging en nauwkeurigheid: BGT en TOP10 minder nauwkeurig, kan leiden tot verschuivingen; 

• In volledigheid: DTB is soms onvolledig: kleine hoogtesprongen in het verlengde van lijnen met grote sprongen 

ontbreken vaak. AHN is minder nauwkeurig in de ligging van muren; 

• AHN 0.5 m is heel nauwkeurig in XY; 

• DTB heeft als voordeel dat het 3D lijninformatie bevat. 

 

3.6 HOOGTELIJNEN 

In dit hoofdstuk worden alle hoogtelijnen beschreven. Het gaat hierbij om alle hoogtelijnen die gebruikt worden bij het 

aanmaken van het hoogtemodel en/of voor het opnemen van overlaatwerking binnen de gebiedsbeschrijving. Alle 

eisen en richtlijnen voor de hoogtelijnen worden toegelicht.  

 

Een algemene richtlijn voor hoogtelijnen is dat alleen data wordt toegevoegd welke zinvol is voor het opbouwen van 

het hoogtemodel. Hoe meer data wordt toegevoegd, hoe langer het duurt om het hoogtemodel op te bouwen of te 

actualiseren.  

3.6.1 ALGEMEEN 

Hoogtelijnen zijn binnen Baseline ondergebracht in de Feature Dataset “Elevation”. Er zijn drie soorten hoogtelijnen: 

Elevated_line_routes, Terrain_edge_3d_lines en Terrain_jump_3d_routes. Een verschil tussen deze hoogtelijnen is of 

deze in het hoogtemodel terugkomen en/of deze bij de conversie naar D-HYDRO of SWAN worden opgenomen in het 

overlatenbestand. 

  

Tabel 3: Rol van de verschillende hoogtelijnen. 

TYPE BODEMHOOGTEMODEL OVERLATEN 

ELEVATED_LINE_ROUTES Nee Ja 

TERRAIN_EDGE_3D_LINES Ja Nee 
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TYPE BODEMHOOGTEMODEL OVERLATEN 

TERRAIN_JUMP_3D_ROUTES Ja Ja 

 

Het onderscheid tussen de verschillende lijnen wordt gemaakt op basis van het feit of overlaatwerking optreedt.  

Overlaatwerking treedt op wanneer sprake is van een steil talud. Hiervoor wordt de grens van 1:7 gehanteerd (8,13 

graden). Bij een dergelijk steil talud laat de stroming los, treedt turbulentie op en ontstaat een bodemneer. Hierdoor 

treedt energieverlies door bodemwrijving op. Dit extra energieverlies moet worden meegenomen in hydraulische 

simulaties. Door nieuwe kennis blijkt de harde grens van 1:7 niet terecht. Ook taluds van 1:7 en flauwer geven een 

stromingsweerstand door zogenaamde ‘overlaatwerking’, die met het flauwer worden van het talud wel steeds minder 

wordt.  Het hangt af van de situatie welke hoogtelijn in welke situatie moet worden gekozen. Daarnaast geldt binnen de 

Feature Class Elevated_line_routes nog een onderscheid. Hierop wordt ingegaan in de specifieke paragrafen.  

 

Voor planmaatregelen is het gebruik van deze harde grens van 1:7 akkoord, waarbij 1:7 geen hoogteverschillijn meer is. 

Voor actualisatiemaatregelen is deze grens minder hard omdat ook andere overwegingen een rol spelen. Bv. de wens 

om zoveel mogelijk doorlopende kades en hoogteverschillijnen te hebben, en niet een afwisseling van 

hoogteverschillijn (steil) en breuklijn (flauw). 

 

Bij het berekenen van het energieverlies wordt gebruik gemaakt van de hoogte van de overlaat ten opzichte van het 

maaiveld. Dit wordt bepaald door kruin- en teenhoogtes (links en rechts) te bepalen. Wanneer de teenhoogtes worden 

toegekend is de kijkrichting van de lijn leidend, zie ook figuur 9. Er wordt ook gebruik gemaakt van de kruinbreedte en 

taludhellingen en ook deze laatste wordt toegekend afhankelijk van de lijnrichting. De standaardwaarden hiervoor zijn: 

kruinbreedte: 10 m, taludhelling links/rechts: 4 (dus 1:4). 

 

 
Figuur 9: Bovenaanzicht Richting lijn en bepaling linker- en rechterzijde. De richting van de lijn is onafhankelijk van de stroming. 

Hieronder wordt voor de verschillende hoogtelijnen beschreven wanneer deze moeten worden toegepast. Daarbij is 

het echter goed om te weten dat uniformering moet plaatsvinden. Als op basis van de richtlijnen blijkt dat een 

hoogtelijn afwisselend een terrain_jump en een elevated_line of een terrain_jump en een terrain_edge gekozen dient 

te worden, is het aan de modelleur om zijn/haar expertise toe te passen om de lijn op een juiste manier op te nemen in 

de schematisatie. Het doel hiervan is om binnen het model zoveel mogelijk eenduidigheid te creëren en hoogtelijnen 

over zo groot mogelijke afstand te laten lopen. 

3.6.2 TERRAIN_JUMP_3D_ROUTES 

In het algemeen geldt dat zowel insteeklijnen als andere hoogtelijnen (in het horizontale vlak) aan de bovenzijde van 

een steil talud (steiler dan 1:7) worden opgenomen als terrain_jump_3D_routes. Hierop zijn enkele uitzonderingen van 

toepassing. Deze worden in paragraaf 3.6.5 beschreven.  
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Voor planmaatregelen is het gebruik van deze harde grens van 1:7 akkoord, waarbij 1:7 geen hoogteverschillijn meer is. 

Voor actualisatiemaatregelen is deze grens minder hard omdat ook andere overwegingen een rol spelen. Bv. de wens 

om zoveel mogelijk doorlopende kades en hoogteverschillijnen te hebben, en niet een afwisseling van 

hoogteverschillijn (steil) en breuklijn (flauw). 

 

 

De terrain_jump_3D_routes wordt aan de bovenzijde van het steile talud geschematiseerd. De onderzijde wordt als 

terrain_edge geschematiseerd (zie paragraaf 3.6.7). Naast dat een terrain_jump_3D_route aan de bovenzijde van een 

steil talud moet liggen, geldt altijd dat of ELEVATION_RIGHT of ELEVATION_LEFT gelijk moet zijn aan ELEVATION (Z-

waarde van de route). De teenhoogte van de punten op deze hoogtelijn zijn dus aan de ene zijde gelijk aan de 

kruinhoogte en aan de andere zijde gelijk aan de hoogte van de terrain_edge, welke de onderzijde van het steile talud 

weergeeft. Welke zijde welke hoogte heeft, hangt af van de richting van de lijn.  

 

Het is mogelijk dat meerdere terrain_jumps parallel, dicht bij elkaar lopen. Zorg in dat geval altijd dat deze lijnen 

dezelfde lijnrichting hebben. Dit is belangrijk voor de conversie naar D-HYDRO. Op deze manier wordt gewaarborgd dat 

in het geval meerdere lijnen naar de dezelfde roosterlijn geprojecteerd worden, de juiste kruin- en teenhoogtes worden 

opgenomen om de juiste mate van energieverlies te berekenen. Dit geldt overigens voor alle overlaten. 

 

 
Figuur 10: Bovenaanzicht Illustratie verschillende hoogtelijnen bij een getrapt talud, blauwe en rode lijn zijn bovenzijde talud. 

3.6.3 ELEVATED_LINE_ROUTES 

De Feature Class Elevated_line_routes bestaat uit drie typen lijnen. Elk van deze drie typen definiëren een overlaat met 

overlaatwerking. Het onderscheid in deze lijnen wordt gemaakt door het veld “TYPE” in de Feature Class. 

 

Tabel 4: Onderscheid Elevated_lines_routes 

OVERLAAT NAAM TYPE 

KRIB Groyne 1 

KADE Local Embankment 2 

BANDIJK Primary Embankment 3 
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Elk van deze drie lijnsoorten wordt in andere situaties toegepast. Omdat kribben en kades relatief smalle elementen 

zijn (t.o.v. het rekenrooster), worden ze geschematiseerd als overlaat. Overlaten worden in D-HYDRO subgrid 

afgehandeld. 

 

Belangrijk aspect van deze lijnen is dat geen van deze lijnen terugkomt in het hoogtemodel. Dit is dan ook een aspect 

waar de modelleur op moet letten bij het schematiseren. Het is niet toegestaan dat een van deze onderdelen van de 

schematisatie in het hoogtemodel zichtbaar is, omdat hierdoor het effect van de overlaat zal worden overschat. 

 

Een essentieel punt bij het schematiseren van Elevated_Lines is het toepassen van de juiste kerende hoogte. Dit 

betekent dat elk punt de hoogste hoogte uit het dwarsprofiel moet bevatten. Dit geldt alleen voor kades en kribben.  

Bandijken worden op de buitenkruiinlijn gelegd en zijn feitelijk een hoogteverschillijn. 

 

Een hulpmiddel hierbij is de functie Focal Max. Wanneer deze functie gebruik is kan het resulterende raster gebruikt 

worden om de hoogtes te bepalen. Hierbij wordt geadviseerd om altijd de fijnst beschikbare resolutie van het 

hoogteraster te gebruiken, bij AHN is dit 0.5x0.5m. 

3.6.4 GROYNE 

Een groyne (krib) is een smalle, langgerekte ophoging in het rivierbed welke een stroomgeleidende functie heeft. De 

meeste kribben hebben steile, verharde taluds (steiler dan 1:7). In de referentieschematisaties zijn over het algemeen 

slechts over een gedeelte van de oever (het droge gedeelte) teenlijnen (terrain_edges) aanwezig nabij de krib. Het 

kribvak is veranderlijk door morfologische processen waardoor beperkte informatie beschikbaar is. Daarom is het bij 

het schematiseren van kribben voldoende om in het natte gedeelte de teenhoogtes te bepalen, zonder teenlijn. Bij het 

aanpassen van bestaande kribben is het voldoende om de kruin- en teenhoogtes aan te passen. Nieuwe insteeklijnen 

zijn niet benodigd, tenzij deze bewust zijn gewijzigd.  

 

Focal Max kan worden gebruikt om de hoogste waarde aan een hoogtelijn te koppelen. De 
Functie Focal Max kan worden aangeroepen via “Spatial Analyst Tools>Neighborhood>Focal 
Statistics”. Voorwaarde hiervoor is dat het hoogtebestand een raster betreft. Als de 
brondata dus in een ander formaat is zal dat eerst omgezet dienen te worden naar raster. 
Vervolgens kan het bronraster worden ingeladen. Kies bij Statistics Type voor “Maximum” en 
voor de Neighborhood voor “Rectangle”.  Kies vervolgens goede waarden voor “height” en 
“Width”. Een goede setting hiervoor is 5 en 10 “Map units”. Hierbij wordt er vanuit gegaan 
dat er gebruik gemaakt wordt van meters. In een dergelijk geval zoekt de functie de 
maximale waarde 5 meter naar boven en 10 meter opzij. 
 
NB. Deze functie geeft NIET automatisch de hoogste hoogte in dwarsrichting (loodrecht op 
de lengterichting van de hoogtelijn). Deze functie zoekt in een vast vooraf aangegeven 
gebied. Dit kan dus ook in lengterichting zijn. Dit kan betekenen dat de verkeerde hoogte 
toegekend wordt, en dat de hoogste hoogte in dwarsrichting wordt gemist. Altijd geldt: alle 
resultaten dienen gecheckt te worden. Situaties waarin deze methodes mogelijk niet werken 
zijn: een hoog terrein naast de kade, of scherpe hoeken in de kade, of twee parallelle kades. 
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Vaak geldt bij een krib dat in het DTB wel een hoogtelijn om de krib heen loopt. Dit is meestal de waterniveaulijn ten 

tijde van de opname. In een dergelijk geval wordt deze waterniveaulijn/oeverlijn rondom de krib verwijderd en sluiten 

de oeverlijnen van de aangrenzende kribvakken aan op elkaar, zie Figuur 11. NB. In dit geval is er wel sprake van 

kruisende hoogtelijnen.   

 

De standaardwaarden voor kribben zijn: 

kruinbreedte 2.5 m 

taludhelling links/rechts 3 (dus 1:3) 

Wanneer blijkt dat een krib toch een flauw talud heeft, kan dit worden opgenomen in de attribuuttabel in de velden 

SLOPE_LEFT/RIGHT. Hierin wordt de helling ingevuld, ofwel een 3 geeft een helling van 1:3 aan. Hier wordt door D-

HYDRO rekening mee gehouden in de simulatie.  

 

Kribben hebben een verplichte lijnrichting, namelijk altijd van oever richting rivieras (zie Figuur 11). 

 
Figuur 11: Bovenaanzicht Voorbeeld hoe de teenlijn van een krib dient te worden geschematiseerd. 

 

3.6.5 LOCAL EMBANKMENT 

Een Local Embankment (kade) is een smalle langgerekte ophoging van het maaiveld met aan weerszijde een steil talud 

(steiler dan 1:7). Volgens het Baseline protocol kan een dergelijke ophoging op twee manieren worden gemodelleerd, 

namelijk met een kadelijn (een Local Embankment binnen Elevated_line_routes) of door middel van twee 

terrain_jumps. De keuze is afhankelijk van de kruinbreedte in relatie tot de resolutie van het rekenrooster en de functie 

van de ophoging. Voor planmaatregelen is het gebruik van deze harde grens van 1:7 akkoord, waarbij 1:7 geen kade 

meer is. Voor actualisatiemaatregelen is deze grens minder hard omdat ook andere overwegingen een rol spelen. Bv. 

de wens om zoveel mogelijk doorlopende kades en hoogteverschillijnen te hebben, en niet een afwisseling van kade 

(steil) en breuklijn (flauw). 

 

Een smalle ophoging is in het Baseline bodemhoogtemodel goed zichtbaar maar valt veelal weg op het moment dat de 

bodem wordt geprojecteerd op het rekenrooster. Hierin schuilt de moeilijkheid voor schematisatie. Een 
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gebiedsschematisatie wordt roosteronafhankelijk gemaakt waardoor niet bepaald kan worden of een ophoging smal is 

ten opzichte van het rooster. Daarom is hiervoor een richtlijn opgenomen in het protocol, deze richtlijn wordt 

weergegeven in Figuur 12. Bij een kruinbreedte kleiner dan 10 meter wordt een Local Embankment gekozen. Bij een 

bredere kruin wordt gekozen voor twee terrain jumps. Hiervan kan worden afgeweken als de ophoging een belangrijke 

functie heeft voor bijvoorbeeld de inundatiefrequentie of stroombeelden van een uiterwaard. In een dergelijk geval 

heeft het de voorkeur om een Local Embankment op te nemen in de schematisatie. Bij beide opties is het noodzakelijk 

dat een teenlijn aan beide zijden wordt opgenomen. Deze teenlijn moet altijd aan de onderkant van het talud liggen.  

 

Wanneer een ophoging varieert in breedte is het mogelijk dat een overgang ontstaat van een Local Embankment naar 

twee terrain_jumps. Deze twee type overlaten moeten met elkaar worden verbonden om te voorkomen dat er in het 

model lekkages ontstaan ter plekke van de overgang. Op de aansluiting van deze lijnen dienen punten te liggen met 

dezelfde hoogtes. De aansluiting kan op de wijzen zoals weergegeven in Figuur 12 middels een verbindingslijn. Dit 

wordt dan een hoogteverschillijn. 

 

Naast de hiervoor genoemde standaardsituaties kan het voorkomen dat op een brede ophoging (breder dan 10 meter), 

een extra ophoging aanwezig is, zoals in Figuur 13 en Figuur 14. Omdat de kruin breder dan 10 meter is, moet deze 

ophoging in principe worden geschematiseerd met twee terrain_jumps. Als echter op de kruin een hoger deel ligt, kan 

het zijn dat de kerende hoogte op deze manier niet goed wordt weergegeven in het model als er alleen 

surface_level_points of een terrain_edge wordt gebruikt. In dat geval wordt een extra Local Embankment lijn 

toegevoegd over het hoogste deel van de ophoging.  

- De teenhoogtes van deze lijn zijn gelijk aan de kruinhoogtes van de terrain_jumps. Extra terrain_edge lijnen 

aan de benedenzijde van de Local Embankment zijn niet benodigd, tenzij er nog een verlaging zit tussen de 

local embankment en de terrain_jump (bij rode pijl in Figuur 13). 

- De teenhoogtes van de terrain_jumps worden bepaald op basis van de terrain_edges aan de onderzijde van 

het talud. 

 

 

 
Figuur 13: Zijaanzicht brede kade met lokale verhoging 

 

Figuur 12: Bovenaanzicht voorbeeld van een geconstrueerde aansluiting tussen twee terrain_jumps (zwart) en een local 

embankment (rood) 
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Figuur 14: Bovenaanzicht van een hoge grond met daaroverheen een Local Embankment. 

Een tweede uitzonderingssituatie geldt als een Local Embankment direct naast een waterlichaam is gelegen of als de 

Local Embankment geheel op een hoog vlak is gelegen. Van deze situaties is in Figuur 15 een voorbeeld gegeven. 

1. In het eerste voorbeeld is aan de linkerzijde van de figuur een terrain_edge zichtbaar. Deze vormt de linker 

teenlijn van de Local Embankment. Aan de rechterzijde loopt het talud van de Local Embankment direct door 

in het talud van de oever. In dit geval is het netjes om handmatig een terrain_jump toe te voegen. De hoogte 

hiervan kan worden bepaald met een bronbestand (voorkeur, bijvoorbeeld DTB), of dezelfde hoogte als de 

terrain_edge links krijgen, als het maaiveld links van de Local Embankment min of meer vlak is. Door de extra 

lijn wordt de hoogte van het maaiveld geïnterpoleerd tussen de terrain_edge en terrain_jump (rode 

gestippelde lijn in de figuur). Wanneer de extra lijn niet wordt toegevoegd, wordt het hoogtemodel 

geïnterpoleerd tussen de twee terrain_edges. Hierdoor ontstaat een talud dat in werkelijkheid niet bestaat en 

kan er een onrealistisch hoogtemodel ontstaan. Door de bovenstaande werkwijze te volgen wordt een 

realistischer hoogtemodel gevormd. De teenhoogte van de Local Embankment aan de rechterzijde wordt 

gevormd door de terrain_jump. 

2. In het tweede voorbeeld kan hetzelfde principe als hierboven beschreven worden toegepast. Hierbij wordt het 

verhoogde vlak wel opgenomen in het hoogtemodel, maar de smallere ophoging (Local Embankment) niet. 
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Figuur 15: Zijaanzicht van een Local Embankment naast een waterlichaam (boven)of op een hoog vlak (onder) 

 

Een laatste aandachtspunt bij het toepassen van Local Embankments is de wijze hoe wordt omgegaan met op- en 

afritten. Hierbij kunnen twee situaties worden onderscheiden:  

- De op- of afrit ligt in het talud van de kade. In dit geval hoeft de op- of afrit niet apart worden opgenomen. Wel 

dienen de lijnen die de op- of afrit weergeven verwijderd te worden en de teenlijn moet doorlopen (Figuur 16). 
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Figuur 16: Bovenaanzicht schematisatievoorbeeld van een op- of afrit binnen het talud van een kade/bandijk. 

- De op- of afrit ligt buiten het talud. In dat geval moet de op- of afrit als een Local Embankment worden 

geschematiseerd, welke dwars op de andere Local Embankment is gelegen. Wederom moet de teenlijn 

doorlopen. Een voorbeeld van deze situatie is weergegeven in Figuur 17. 

 

 

 
Figuur 17: Bovenaanzicht schematisatievoorbeeld van een op- of afrit buiten het talud van een kade/bandijk. 

3.6.6 PRIMARY EMBANKMENT 

Als laatste bestaat het type Primary Embankment. Deze geeft de primaire waterkering weer en is in principe altijd 

gelegen op de buitenkruinlijn van de dijk, aan de zijde van het waterlichaam.  

 

Overgang Baseline 5 naar Baseline 6 

In Baseline 5 waren Primary Embankments opgenomen in het bestand bandijk. De bandijk had een kruinhoogte en 

(buitendijkse) teenhoogte. Default werd deze teenhoogte als breuklijn in het hoogtemodel opgenomen. De kruinhoogte 
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werd in principe niet gebruikt in het model want vlak naast de bandijk ligt de grens van sectie 3 en deze werd als 

oneindig hoge muur in het model opgenomen. 

 

Vanaf Baseline 6 is er voor gekozen om bandijk/primaire keringen als overlaat/elevated line op te nemen. Dit biedt de 

mogelijkheid om een modelschematisatie uit te breiden naar het binnendijkse gebied en overstromings- of 

dijkdoorbraaksimulaties uit te voeren. 

 

De Converter die Baseline 5 data omzet naar Baseline 7 dupliceert de bandijk en schrijft de lijnen enerzijds weg naar 

Terrain_edge_3D_lines met de oorspronkelijke teenhoogte van de bandijk en anderzijds naar Elevated_line_routes type 

Primary Embankment, met de oorspronkelijke kruinhoogte van de bandijk (zie Figuur 5 C en D, beiden aan de 

linkerzijde). De oorspronkelijke buitendijkse teenhoogte wordt hierbij zowel aan de linker- als rechterteenhoogte 

toegekend. 

 

In de 5de generatie modellen is het overgrote deel van de bandijken daarom eigenlijk een lijn met aan één kant (de 

rivierzijde) een talud en teenlijn. Vanaf Baseline 6 is het echter een elevated line waardoor aan beide zijden een talud 

en teenhoogte moeten worden opgegeven. De buitendijkse teenhoogte (en taludhelling) wordt afgeleid uit de teenlijn 

aan de rivierzijde. Bij gebrek aan een binnendijkse teenhoogte is de keuze gemaakt om deze gelijk te stellen aan de 

buitendijkse teenhoogte. Hetzelfde geldt voor de taludhelling. 

 

Nieuwe bandijken in Baseline 7 

Bij het aanmaken van een nieuwe bandijk dient de bandijklijn ook te worden omgezet naar een terrain edge lijn met 

dezelfde vertices, waarbij de kruinhoogte van de terrain edge lijn gelijk is aan de teenhoogte van de bandijk. 

 

De standaardwaardes voor de events van primary embankments zijn: 

kruinbreedte 3 m 

taludhelling links/rechts: 4 (dus 1:4). 

 

Let op dat een bandijkwijziging ook een aanpassing van Featureclass sections betekent omdat de bandijk 10 centimeter 

aan de binnenzijde van de buitengrens van section 3 ligt (paragraaf 6.3.5). Een aanpassing van de buitengrens van 

sectie 3 heeft ook consequenties voor de bestanden waarmee vanuit Baseline-land regionale clips worden gemaakt en 

de bestanden model_boundaries die bij de conversie naar D-Flow FM worden gebruikt om de D-Hydro input bestanden 

te begrenzen (hoofdstuk 7). 

 

Als er binnendijks gebied wordt toegevoegd (bv. voor overstromings- berekeningen), dan moet de primary 

embankment worden verplaatst naar de as van de waterkering met de juiste kruinhoogte, kruinbreedte en 

taludhellingen, en dient de terrain edge lijn te worden verwijderd. 

 

Als de waterkering in het modelgebied ligt (bv. bij de Maaskades of verbindende waterkeringen), dan ligt de primary 

embankment in de as van de waterkering. 

 

3.6.7 TERRAIN_EDGE_3D_LINES 

Terrain_edge_3D_lines zijn kniklijnen in het hoogtemodel waarbij sprake is van een flauw talud (flauwer dan 1:7).  

Het gaat dan om: 

• waterniveaulijn van rivier meer of plas, 

• lijnen die een terreinafscheiding weergeven; deze verduidelijken de indeling van bv. een bebouwd terrein, 

zoals de begrenzing van verharding, 

• maaiveldlijn om gebouwen, 

• ter plekke van een bandijk (primary embankment), 



 

030255 – Draaiboek Baseline maatregelen 
 
 

WSP 
Juli 2025 

pagina 37/81 
  

 

• soms kunnen ook luchtfoto's een aanwijzing geven over diepe en ondiepe delen. Gebruik zoveel mogelijk 

informatie om de aanname te verbeteren. 

• Andere soorten lijnen zijn isolijnen. Deze kunnen afgeleid worden uit rasters zoals het AHN. Het kunnen lijnen 

zijn die het waterniveau van een plas weergeven. Of een lijn die een hoger of lagergelegen terrein weergeeft. 

Toevoegen van dit soort lijnen is van belang voor een goed hoogtemodel, en zorgt ervoor dat er minder 

hoogtepunten nodig zijn. Bovendien maken ze de schematisdatie "leesbaarder" omdat de topografie 

herkenbaarder wordt. 

 

Grens land/water 

Er is altijd een waterniveaulijn om een plas nodig in de vorm van een breuklijn. Ook als de bron het AHN is kan deze 

worden gemaakt als isolijn. Van plassen uit BGT of Top10 kan de begrenzing een breuklijn worden. 

 

Bodems van plassen/havens 

Daarnaast worden met dit type lijn de onderzijden van taluds aangegeven en diepteligging van plassen wanneer 

dieptemetingen niet beschikbaar zijn. Dit kan het geval zijn bij niet ingemeten plassen, maar ook bij ontwerpen welke 

nog niet zijn gerealiseerd. Als diepte-informatie niet beschikbaar is, wordt een standaard benadering gevolgd, zie Figuur 

18: 

• Bij een ondiepe, brede plas (bijvoorbeeld een kleiput of nevengeul/strang) wordt een bodemlijn 

geschematiseerd op een afstand van 5 meter van de insteeklijn (rand van de vergraving) met een hoogte die 2 

meter lager ligt dan de gemiddelde hoogte van het maaiveld ter plaatse.  

• Een diepe plas (bijvoorbeeld een zandwinput) krijgt een bodemlijn op 30 meter van de insteeklijn, met een 

hoogte van 5 meter lager dan de gemiddelde maaiveldhoogte. Indien de lijninformatie van de plas uit het DTB 

wordt gehaald, is het ook nodig om de waterniveaulijn op te nemen. Wanneer de waterniveaulijn moet 

worden opgenomen, wordt deze standaard benadering toegepast vanaf de waterniveaulijn en niet vanaf de 

insteeklijn.  

 

 
Figuur 18: Bovenaanzicht Schematische weergave van de diepte van een plas bij het ontbreken van gegevens. 
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Ook kan het zo zijn dat peilingsinformatie beschikbaar is, maar dat deze onvolledig is. Dit kan betekenen dat maar een 

gedeelte van de plas is ingemeten of dat de metingen niet tot de plasrand doorlopen. In een dergelijk geval dient naast 

de insteeklijn ook een bodemlijn geschematiseerd te worden. Hiermee wordt voorkomen dat een gedeelte van de plas 

wordt opgevuld door de triangulatie bij het aanmaken van het hoogtemodel.  

 

 

Sloten 

Insteeklijnen van smalle sloten worden opgenomen met een breuklijn. De reden hiervoor is dat er nauwelijks wervels 

kunnen ontstaan die de stroming beïnvloeden en er dus geen overlaat nodig is. Tevens is dit de reden dat de 

bodemhoogte van smalle sloten niet wordt opgenomen in het model. Tenzij dit een verbinding is tussen grotere 

plassen.  

 

Bijzondere situatie: een verticale kademuur langs de rivier 

De kademuur zelf wordt opgenomen met een terrain jump (Figuur 19). Hiernaast ligt een terrain edge lijn die het 

waterniveau weergeeft. Deze kan uit het DTB afkomstig zijn, of handmatig gemaakt worden door een lijn op 10 cm 

afstand te maken. Op 10 cm afstand van de waterniveaulijn wordt handmatig een terrain edge lijn gelegd die de 

bodemhoogte aan de onderkant van de kademuur weergeeft. De hoogte hiervan wordt afgeleid uit lodingsgegevens, of 

de hoogte wordt aangenomen. 

 

 
Figuur 19: Zijaanzicht van schematisatie van een kademuur. 

1) Voor het toepassen van een lijn op vaste afstand van een al bestaande lijn kan het beste 
“Copy Parallel” uit de Modify features -pane in Edit mode worden gebruikt. Wanneer in 
plaats van deze tool de functie “Buffer” wordt gebruikt worden onnodig veel vertices 
aangemaakt, met een overdaad aan punten als gevolg. 
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3.6.8 ERASE FEATURECLASSES VOOR HOOGTELIJNEN 

De erase feature classes voor hoogte informatie moet met speciale aandacht worden geschematiseerd. De erase 

feature classes hebben effect op het hoogtemodel wat uiteindelijk wordt geconstrueerd. Door het verwijderen van 

hoogtelijnen kunnen losse uiteinden ontstaan en wordt een hoogte afgeleid zonder tussenkomst van de modelleur. In 

het geval van 3D-lijnen wordt een interpolatie toegepast. Bij 2D-lijnen is dit meestal de hoogte van het vorige punt, 

waardoor een horizontale lijn ontstaat. 

 

Erasevlakken moeten zodanig gekozen worden dat alle gewijzigde hoogtelijnen worden verwijderd/vervangen door 

nieuwe informatie. Deze keuze is gebaseerd op de nieuwe hoogte-informatie, en de referentie-schematisatie. 

 

Om een onjuist hoogtemodel te voorkomen, moet de grens van een erase feature class met zorg worden gekozen. 

Hierbij wordt een hoogtelijn welke doorsneden wordt door het erase-vlak verwijderd tot vlak bij het eerstvolgende 

punt op deze lijn (Figuur 20). Vervolgens kan de nieuwe hoogtelijn/insteeklijn daarop worden aangesloten. Merk hierbij 

op dat de kruinhoogte (en eventueel teenhoogte(s)) gelijk moeten zijn aan het punt uit de referentie wanneer op de 

referentie wordt aangesloten.  

Hierbij is het van belang om restanten van hoogtelijnen in het model te controleren. Wanneer deze geen functie meer 

hebben, dienen deze in het geheel te worden verwijderd. Een voorbeeld hiervan is een hoogtelijn uit de referentie die 

min of meer parallel loopt aan een insteeklijn (en deze misschien zelfs kruist). De restanten buiten de insteeklijn 

verliezen hun functie omdat de puntdichtheid op een insteeklijn groot is, waardoor de oorspronkelijke terreinligging 

niet veel verandert door het verwijderen van deze restanten. 

 

Het zorgvuldig aanmaken van erase featureclasses is met name van belang bij terrain_jumps_routes en 

elevated_line_routes. Deze worden immers vertaald naar overlaten (Fixed Weirs) in D-HYDRO. Wanneer de aansluiting 

van deze lijnen niet goed is, bestaat het risico dat een gat in het overlaten bestand ontstaat. Dit kan grote gevolgen 

hebben op het stroombeeld.  

Dit geldt echter ook voor breuklijnen; als deze door een onnauwkeurige erase featureclass niet meer aansluiten kan 

een foutief hoogtemodel ontstaan. 

 

Een erase Feature class mag uit meerdere polygonen bestaan. Het is echter niet toegestaan dat deze polygonen elkaar 

overlappen. 

Figuur 20: Bovenaanzicht van een erasevlak bij een T-splitsing van 2 hoogtelijnen. 



 

030255 – Draaiboek Baseline maatregelen 
 
 

WSP 
Juli 2025 

pagina 40/81 
  

 

3.7 HOOGTEPUNTEN 

Naast de verschillende hoogtelijnen bestaan ook hoogtepunten binnen het Baseline protocol. Deze bestaan uit drie 

typen: bedlevel_points, waterbody_bedlevel_points en surfacelevel_points. De eerste twee typen geven de natte 

waterbodem weer, en laten we binnen dit draaiboek buiten beschouwing. De aanpak van deze typen hoogtepunten 

wordt behandeld in het draaiboek “Lodingen” (hoofdstuk 4). Hier gaan we enkel in op de surfacelevel_points.  

 

Met de surfacelevel_points wordt een glooiender geheel van het hoogtemodel opgebouwd. Het is met hoogtepunten 

niet mogelijk om strakke taluds en scherpe contouren te modelleren. Het is dan ook niet gewenst om taluds met 

hoogtepunten te schematiseren. Dit dient altijd met hoogtelijnen te gebeuren.  

 

Hoogtepunten worden voornamelijk gebruikt bij actualisatie- of revisiemaatregelen. Er dienen voldoende 

surfacelevel_points te worden opgenomen, zodanig dat de terreinligging goed wordt weergegeven. Bij geaccidenteerd 

terrein zijn meer punten nodig dan bij vlak terrein. Ook op vlak terrein zijn punten nodig om kleinere hoogteverschillen 

weer te geven. De aanwezigheid van punten maakt het eenvoudiger om toekomstige actualisatiemaatregelen aan te 

sluiten op de referentie. Surfacelevel_points dienen altijd binnen het SECTION=3 vlak van section_polygons te zijn 

gelegen. 

 

Het is niet toegestaan om punten te dicht bij hoogtelijnen op te nemen in de gebiedsschematisatie. In de regel is het 

proces om de punten te verwijderen maatwerk, wel wordt alles binnen 1 meter verwijderd. Punten met vrijwel 

dezelfde hoogte als de hoogtelijn zouden verwijderd kunnen worden. Grote verschillen in hoogte tussen een punt en 

een lijn vlakbij elkaar zijn reden om de schematisatie te controleren want dat is niet logisch. Op kribben (groynes) en 

binnen de teenlijnen van kades (local embankments) en bandijken (primary embankments) mogen geen hoogtepunten 

liggen, ongeacht de afstanden. 

 

Standaard worden hoogtepunten uit DTB overgenomen (zie Tabel 2 in paragraaf 3.5.1). De puntdichtheid van deze 

hoogtepunten is echter beperkt, dus mogelijk dienen ook andere bronnen te worden gebruikt. Als het DTB niet 

beschikbaar is of te weinig punten bevat, wordt bij de afleiding van surfacelevel_points gebruik gemaakt van het AHN 

of andere beschikbare hoogtebronnen. AHN is beschikbaar in verschillende resoluties en hier moet met zorg worden 

gekeken welke puntdichtheid in de Baseline database wordt toegevoegd. Omzetting van een raster met resolutie van 

25 meter resulteert mogelijk in het missen van scherpe overgangen. Omzetting van een raster met resolutie van 0,5 

meter resulteert dan weer in een veel te hoge puntdichtheid. Alternatief is om met de ArcGis functie “Raster To 

Multipoint” een filtering van relevante punten uit een raster te halen. Het resultaat bestaat uit multipoints die dan nog 

wel naar (single) points moeten worden omgezet.  

 

Elke cel wordt omgezet naar een surfacelevel_point waarbij de celwaarde wordt gekoppeld aan de “ELEVATION” van 

het punt. De volgende gebieden moeten worden uitgesloten van opname: oppervlaktewateren, bruggen, pijlers en 

gebouwen.  

 

Surfacelevel_points mogen niet in een regelmatig rooster liggen. Dit met het oog op de reproduceerbaarheid van het 

resulterende hoogtemodel. Het hoogtemodel wordt aangemaakt met behulp van een “Nearest Neighbour” techniek. 

Wanneer alle punten of gelijke afstand van elkaar liggen (dit gebeurt als de punten zijn omgezet vanuit een raster zoals 

AHN) is niet te voorspellen welke punten de hoogste weging krijgen bij het aanmaken van het hoogtemodel. Om dit te 

voorkomen kan gebruik gemaakt worden van Preparation Tool 7 “Reposition points in regular grid” in de Baseline 

Toolbar. Met behulp van deze tool worden alle punten random met maximaal 1 millimeter verschoven.  
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3.8 WORKFLOW 

3.8.1 INLEIDING 

In voorgaande paragrafen is uitvoerig stil gestaan bij de verschillende Featureclasses die hoogtelijnen en hoogtepunten 

beschrijven en op welke manier deze geïnterpreteerd en geschematiseerd moeten worden. 

In deze paragraaf wordt een stappenplan gegeven voor het opbouwen van de hoogtegegevens van een maatregel. 

Hieronder staan de stappen in een lijst, daarna worden de stappen verder toegelicht. 

 

1. Maak een lege Baseline maatregel 

2. Zet routen en events om naar lijnen en punten 

3. Bepaal grens van maatregel gebied 

4. Selecteer bronnen 

5. Bouw een hoogtemodel inclusief de insteeklijn 

6. Classificeer de verschillende terreinelementen 

7. Opschonen lijnen 

8. Maak punten op lijnen 

9. Ken kruinhoogtes toe 

10. Maak hoogtepunten featureclasses 

11. Maak erase featureclasses 

12. Maak een proefmix 

13. Ken teenhoogtes toe 

14. Rond maatregel af 

3.8.2 MAAK EEN LEGE BASELINE MAATREGEL 

Gebruik hiervoor Baseline preparation tool “Create variant\measure”. Houdt bij de naamgeving van de maatregel 

rekening met de naamgevingsconventies van Rijkswaterstaat (zie Bijlage 1). 

3.8.3 ZET ROUTEN EN EVENTS OM NAAR LIJNEN EN PUNTEN 

Het datamodel van hoogtelijnen in Baseline is complex en bestaat uit routes en events. De route beschrijft de ligging 

van een hoogtelijn, de events zijn opgeslagen in event-tabellenen bevatten informatie over kruin- en teenhoogtes, 

kruinbreedtes en taludhellingen. De hoogtelijnen die in het bodemhoogtemodel worden gebruikt zijn opgeslagen als 

3D-lijnen en hiervan wordt de kruininformatie opgeslagen in de vertex van de lijn.  

Het rechtstreeks wijzigen van deze informatie is lastig. Daarom wordt de informatie bij het bouwen of wijzigen van een 

Baseline maatregel altijd eerst omgezet van routes en events naar lijnen en punten. Dit kan met Baseline preparation 

tool “01. 3D-lines, routes and events to lines and points”. De resulterende lines- en point-featureclasses zijn in ArcGis 

toegankelijker om te editten. De tool kan per hoogtelijnen Featureclass worden uitgevoerd maar ook in batch voor alle 

hoogtelijnen Featureclasses in een maatregel. 

 

NB. De twee voorgaande stappen (create measure en R&E to L&P) kunnen worden gecombineerd door ze een keer 

afzonderlijk uit te voeren en de resulterende maatregel op te slaan als “lege_maatregel”. Deze “lege_maatregel” met 

lijnen en punten in plaats van routes en events kan elke keer bij het maken van een nieuwe maatregel worden 

gekopieerd, dat scheelt weer een extra handeling. 
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3.8.4 BEPAAL GRENS VAN MAATREGEL GEBIED 

Bij een actualisatie of ontwerp is altijd een opname- of plangrens aanwezig. Dit is de grens tussen het onveranderde 

maaiveld en de aanpassing van het maaiveld. Om te zorgen dat het hoogtemodel buiten deze grens zo min mogelijk of 

niet wordt aangepast, is het noodzakelijk om een zogenaamde insteeklijn te construeren. Deze insteeklijn begrenst het 

aanpassingsgebied en kan zowel een terrain_edge_3d_line zijn of een terrain_jump_3d_route. Dit hangt af van het 

talud (zie hoofdstuk 3.6). Om te zorgen dat de insteeklijn het beoogde doel behaalt moet een hoge puntdichtheid 

worden gehanteerd. De richtlijn is dat de afstand tussen twee punten ongeveer 5 meter is. De hoogte van deze punten 

moet worden bepaald op basis van het hoogtemodel waarin wordt geactualiseerd, bijvoorbeeld het hoogtemodel uit 

de aangeleverde referentie.  

Let bij de locatie van de ligging van deze insteeklijn ook op de doorsnijding van hoogtelijnen uit de referentie, kies de 

locatie van de doorsnijding zorgvuldig (zie ook paragraaf 4.3.4.). 

3.8.5 SELECTEER BRONNEN 

De beschikbare brongegevens voor de actualisatie of het ontwerp zijn beschreven in paragraaf 3.5. Maak een keuze bij 

meerdere bronnen en houdt hierbij rekening met de aanbevelingen uit paragraaf 3.5.1 t/m 3.5.9. 

Voeg brongegevens samen en knip ze iets ruimer af buiten de grens die in de vorige stap is bepaald. Zet eventuele 

beschikbare hoogterasters om naar punten conform de werkwijze beschreven in paragraaf 3.7. 

3.8.6 BOUW EEN HOOGTEMODEL INCLUSIEF DE INSTEEKLIJN 

Drie typen hoogtelijnen kunnen worden toegepast (zie hoofdstuk 3.6). Voor het toepassen van hoogtelijnen gelden 

diverse eisen en richtlijnen, welke in dit hoofdstuk zijn beschreven. 

 

Om een wijziging in het hoogtemodel te schematiseren kan gekozen worden om iso-hoogtelijnen op te nemen in de 

gebiedsschematisatie. Dit doet echter geen recht aan het principe dat alleen data wordt toegevoegd wanneer dit zinvol 

is voor het aanmaken van het hoogtemodel. Daarom worden in principe alleen hoogtelijnen toegevoegd op kniklijnen 

binnen het hoogtemodel. Dit kunnen de boven- en onderzijde van een talud zijn, maar ook een kniklijn waar de helling 

van een talud wijzigt. Het talud tussen de opgegeven hoogtelijnen wordt door de triangulatie bepaald tijdens het 

aanmaken van het hoogtemodel. Hierdoor is het ook niet verplicht dat elk punt op de hoogtelijn dezelfde hoogte heeft. 

Dit kan per punt op de lijn verschillen. 

Soms kan wel zinvol zijn om een iso-hoogtelijn opte nemen, bijvoorbeeld voor breuklijnen als AHN de bron is. Het is 

niet altijd mogelijk om de juiste punten te selecteren, en dan kan een lijn handig zijn. Ook de oeverlijn van een plas obv 

AHN is een isolijn. 

 

Volgende stap is om met alle geselecteerde relevante brongegevens een TIN te construeren. Hierbij kan de eerder 

geconstrueerde insteeklijn / gebiedsgrens als grens voor het TIN worden gebruikt. 

Visualiseer dit TIN in ArcGis boven op de Baseline database van de referentiesituatie en hanteer dezelfde 

hoogtelegenda voor dit Tin als voor de referentiehoogte. Nu is goed te zien wat de actualisatie of het ontwerp voor 

ruimtelijke impact heeft en hoe de aansluiting op de omliggende referentie globaal verloopt. Ook is nu snel te zien of er 

bepaalde lijnen in de bronbestanden ontbreken. Zo ja, voeg deze dan toe en bouw een nieuw TIN. 

3.8.7 CLASSIFICEER DE VERSCHILLENDE TERREINELEMENTEN 

Als het TIN uit voorgaande stap de nieuwe situatie voldoende correct weergeeft kun je de hellingen van het TIN 

visualiseren in hellingen flauwer of steiler dan 1:7 (zie kader hierna). Lijnen boven aan een steile hellingen dienen als 



 

030255 – Draaiboek Baseline maatregelen 
 
 

WSP 
Juli 2025 

pagina 43/81 
  

 

terrain_jump te worden opgenomen of, als het een smalle verhoging betreft dienen het elevated_lines te worden, zie 

paragraaf 3.6. De overige lijnen worden terrain_edges. 

 

Verplaats de geclassificeerde lijnen naar de daarvoor toegewezen Featureclasses. Dat kan in een edit-sessie.  
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Visualiseren hellingshoeken in ArcGIS Pro 

-Ga in de TOC op het hoogtemodel staan en druk rechtermuisknop\Symbology 

-Kies tabblad “symbolyze your layer using a surface”  

 
-Kies vervolgens “Slope”  

 
 

-Pas het aantal classes aan naar 2 en zet method op “Manual interval” 

-Pas de laagste “break value” aan naar 8.13 (dit is gelijk aan de grens 1:7) 

 
Resultaat van voorgaande stappen is dat alle hellingen steiler dan 1:7 rood ingekleurd worden 
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3.8.8 OPSCHONEN LIJNEN 

Nadat lijnen in de juiste featureclasses zijn geplaatst dienen ze te worden opgeschoond. Hoedt hierbij rekening met het 

volgende: 

 

1. Zorg dat lijnen uit het bronbestand bestaan uit single parts, dit doe je in een editsessie door alle lijnen 

selecteren en met de “advanced editing toolbar” een “explode multipart features” uit te voeren. 

2. Zorg dat in elkaars verlengde liggende lijnen van hetzelfde type worden samengevoegd tot één doorlopende 

lijn. Dit kan in een edit sessie met ”merge”, dit werkt alleen goed als de opeenvolgende lijnstukken ook 

dezelfde richting hebben. Maak hiervoor de lijnrichting zichtbaar (zie kader), selecteer een lijn met afwijkende 

richting, kies “edit vertices” en “flip” de richting middels het menu onder de rechtermuisknop. 

 
3. Schoon de lijninformatie op; soms bevatten lijnen afkomstig uit een Autocad bestand of resulterend uit een 

buffer operatie een enorme hoeveelheid vertices, deze zijn vaak overbodig. Je verwijdert ze met 

ArcToolbox\editing tools\generalize. 

4. Zorg voor correcte aansluitingen van lijnen op lijnen uit de referentie, zie ook paragraaf 3.6.8. 

5. In principe mogen dezelfde typen hoogtelijnen elkaar niet kruisen; deze moeten op elkaar aansluiten. Zoals 

twee breuklijnen. Verschillende typen hoogtelijnen kunnen elkaar in bepaalde situaties snijden. Voorbeelden 

zijn: 

a. Een krib mag door de breuklijn op de oever heen. 

b. Een kade mag door een hoogteverschillijn heen als deze kade naar een hoog terrein loopt en verder 

loopt op het terrein. 

6. Geef de lijnen unieke nummers, dit doe je in de attribuut tabel met een field calculator “NUMBER = 

OBJECTID”. 
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3.8.9 MAAK PUNTEN OP LIJNEN 

Nadat alle lijnen zijn bewerkt is het tijd om hier punten op aan te maken. Dit kan met Baseline preparation tool “02. 

Position point on polylines”. Elke lijn moet een uniek nummer hebben. Let hierbij op de aanbevelingen over de 

puntdichtheid op een lijn. 

 

NB. De tool werkt niet in een edit-sessie, sluit deze eerst af. 

 

Om de triangulatie goed te laten verlopen wordt een minimale puntdichtheid op de hoogtelijnen van 20 meter 

aanbevolen. De range van puntdichtheid ligt voor hoogtelijnen tussen de 5-20 meter. Lokaal kan hiervan worden 

afgeweken om bijvoorbeeld een bocht nauwkeurig te schematiseren, zie ook Figuur 21). Op elke vertex van een 

hoogtelijn is het vereist een punt te schematiseren waarop de hoogte wordt gedefinieerd, ook wanneer de afstand 

tussen 2 vertices kleiner is dan 5 meter.  

 

 

In ArcGis kun je de lijnrichting zichtbaar maken met behulp van de symbology.  Ga in de 
Table of Contents op de featureclass staan waarvan je de lijnrichting zichtbaar wil maken, 
druk rechtermuisknop en kies “symbology”. Klik vervolgens op het symbol en scroll naar 
beneden en selecteer “Arrow Line 1”. Nu is de lijnrichting zichtbaar en daarmee is ook de 
definitie van links en rechts helder. 
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Figuur 21: Bovenaanzicht Illustratie puntdichtheid hoogtelijnen, de rode lijn is de insteeklijn, de zwarte lijnen zijn andere hoogtelijnen. 

Standaard maakt preparation tool 02 alleen punten aan op de vertices van de lijnen. Wanneer bij preparation tool 02 

“2. overwrite existing points” wordt aangevinkt en bij “4 Interval (optional)” een waarde (in meters) wordt ingevuld dan 

worden er behalve op de bestaande vertices ook vertices en punten aangemaakt conform het opgegeven interval. 

Hiermee is het dus mogelijk om de puntdichtheid op lijnen te beïnvloeden. Preparation tool 02 werkt op een selectie 

van lijnen, daarmee is het dus mogelijk om de puntdichtheid op lijnen binnen dezelfde Featureclass te variëren.  

3.8.10 KEN KRUINHOOGTES TOE 

Nadat alle lijnen in de 3 featureclasses elevated_line_lines, terrain_jump_lines en terrain_edge_lines zijn voorzien van 

punten kan de kruinhoogte (ELEVATION_CREST) worden toegekend aan alle bijbehorende punten. Dit kan met 

Preparation tool 03 “Set crest elevation”. Deze tool werkt op een lijnenselectie en gebruikt verder een TIN, terrain of 

raster als input voor de hoogtebepaling. Daarmee is het mogelijk om voor bijvoorbeeld de insteeklijn die de 

gebiedsgrens vormt het elevation_model_terrain uit de referentie als elevation model bron te kiezen, terwijl voor de 

overige lijnen in het ontwerp een ontwerptin als elevation model bron wordt gekozen. Ook is het mogelijk om alleen de 

kruinhoogte met een bepaalde waarde te vervangen door een waarde uit een elevation model. Dit is met de optie 

“Only change elevations of points with this value (optional)” mogelijk. 

Vanzelfsprekend kan de kruinhoogte ook gewoon via een field calculator in de attribuut tabel op een puntenselectie 

worden uitgevoerd als er uit een ontwerp een bepaalde hoogte wordt overgenomen. 

Nadat alle kruinhoogtes zijn toegekend is het nog handig om de attribuut tabellen van de point featureclasses te 

controleren. De default hoogte voor de met tool 02 aangemaakte punten = -9999. Controle van de attribuut tabel op 

deze waarde kan een gebruiker helpen vergeten punten op te sporen. 

 

NB. Het toekennen van teenhoogtes bij elevated_lines en terrain_jumps gebeurt in een latere stap. 

3.8.11 MAAK HOOGTEPUNTEN FEATURECLASSES 

Als een actualisatie naast hoogtelijnen ook hoogtepunten bevat dan dienen deze vanuit de bronbestanden in de juiste 

featureclass te worden geplakt. “Droge” hoogtepunten komen in surface_level_points. “”Natte” hoogtepunten in 

bedlevel_points of watebody_bedlevel_points. De verwerking van de natte hoogtes wordt verder beschreven in het 

draaiboek lodingen (hoofdstuk 4). De verwerking van surface_level_points is beschreven in paragraaf 3.7. 
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3.8.12 MAAK ERASE FEATURECLASSES 

Nadat alle toe te voegen hoogte-informatie is opgenomen is het tijd om erase featureclasses te maken. De 

aandachtspunten hierbij staan beschreven in paragraaf 3.6.8. Ook voor hoogtepunten dienen erase featureclasses te 

worden gemaakt. 

3.8.13 MAAK EEN PROEFMIX 

Nu is in principe alle informatie voor het maken van een bodemhoogtemodel gereed. 

Er wordt nu geadviseerd om een zogenaamde proefmix te doen. 

Hierbij wordt de conceptmaatregel in het referentiemodel gemixt waarna het elevation_model_terrain visueel 

geïnspecteerd kan worden. 

 

Alvorens de proefmix te kunnen doen zijn eerst nog een paar handelingen nodig: 

• Lijnen en punten naar routes en events, dit kan met Preparation tool 06. Lines and points to Routes and 

events. 

• Aanmaken van de measure_contour_polygon, dit kan met Preparation tool 08. Create measure contour. 

• Aanmaken erase- en appendlist, dit kan met Preparation tool 11. Create Erase- and appendlist, zie ook 

paragraaf 2.3.3. 

• Protocolcheck; alvorens te mixen dient er een geldige protocolcheck te zijn, dit gebeurt met 

Baseline\Tools\Check variant/measure en dan check protocol, zie ook paragraaf 2.3.5. 

• Maak een geclipte versie van de referentie rondom dec maatregel, zie ook paragraaf 2.3.6. 

• Maak in deze variant een measure_list.txt met verwijzing naar de maatregel. 

 

Daarna stel je de actieve variant in op de geclipte referentie en maak een proefmix via Baseline\Tools\Assimilate 

measures.  

 

Bekijk vervolgens het aangemaakte elevation_model_terrain en de nieuwe terrain_jumps en elevated_lines. Repareer 

eventuele foutjes in erase_features, lijnen, punten of in kruinhoogtes. Herhaal daarna de proefmix in een nieuwe kopie 

van de geclipte referentie (NB. 2x mixen van dezelfde maatregel in een variant kan foutieve resultaten opleveren). 

3.8.14 KEN TEENHOOGTES TOE 

Als je tevreden bent over je elevation_model_terrain en de nieuwe terrain_jumps en elevated_lines is er nog één 

belangrijke stap nodig, namelijk het toekennen van de correcte teenhoogtes aan terrain_jumps en elevated_lines. 

Run hiervoor eerst weer preparation tool “01. 3D-lines, routes and events to lines and points”.  

Daarna kunnen teenhoogtes (ELEVATION_LEFT en ELEVATION_RIGHT) worden toegekend. 

Dit kan met preparation tool “04. Set toe elevation” waarbij je als bron voor je elevation model je laatste proefmix kunt 

opgeven, in dat geval zoekt de tool automatisch naar breaklines in het elevation_model_terrain naast de lijn waar je 

teenhoogtes van wilt bepalen. Preparation tool 04 heeft dezelfde flexibele mogelijkheden als Preparation tool 04 

(paragraaf 3.8.10). Maar je kunt ook op basis van een beschikbare ontwerptekening handmatig teenhoogtes toekennen 

via een field calculator in de attribuut tabel. 

 

NB. Controleer de teenhoogtes goed; tool 04 is slim maar kan niet alle gevallen goed afhandelen. Dus handmatige 

correcties zijn soms nodig. 
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3.8.15 ROND MAATREGEL AF 

Na het toekennen van de teenhoogtes in je maatregel zijn er nog een paar acties nodig: 

 

• Indien een maatregel naast droge hoogte-informatie ook natte informatie en/of veranderingen in landgebruik 

bevat kunnen deze conform de draaiboeken lodingen (hoofdstuk 4) en ecotopen (hoofdstuk 5) worden 

verwerkt. 

•  Zorg dat alle objecten in de maatregel in het veld CHARACTERISTICS de naam van de maatregel hebben. Dit 

doe je met preparation tool 09. Update CHARACTERISTICS in measure. 

• Een nieuwe maatregel bevat standaard alle mogelijke featureclasses en erase_featureclasses die in het 

Baseline datamodel voorkomen. Met preparation tool 10. Clean Baseline database worden alle lege 

featureclasses uit een maatregel verwijderd. 

• Draai eventueel de preparation tools 08 en 11 opnieuw als er na de proefmix toch nog aanvullende objecten of 

featureclasses zijn toegevoegd. 

• Draai de protocolcheck en contentcheck, zie ook paragraaf 2.3.5 en herstel eventuele gerapporteerde fouten. 

• Documenteer je werkproces in het metadata document, zie ook paragraaf 2.3.4. 
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4 DRAAIBOEK LODINGEN 

4.1 INLEIDING 

Dit hoofdstuk beschrijft de werkwijze voor het maken van Baseline maatregelen van de natte (onder water gelegen) 

delen van het watersysteem; te weten het onderwaterdeel van de rivieren, kanalen, meren en kust en plassen en 

havens. 

4.2 BRONNEN 

4.2.1 BRONGEGEVENS 

De brongegevens voor lodingmaatregelen worden veelal geleverd door Rijkswaterstaat CIV. Het kan echter soms ook 

voorkomen dat deze worden geleverd door een regionale dienst of een externe partij. 

 

Deze gegevens kunnen bestaan uit ASCII-bestanden of rasters. Wanneer het ASCII-bestanden betreft dienen deze 

allereerst omgezet te worden naar rasters. Een ASCII-bestand zal de opbouw X,Y,Z hebben. Hierbij zijn de eerste twee 

kolommen de X- en Y-coördinaten en de derde kolom de bodemhoogte. Deze kan worden uitgedrukt in meter of 

centimeter ten opzichte van NAP. 

 

Over het algemeen worden er echter rasters geleverd die direct verwerkt kunnen worden. Daarnaast worden er vaak 

rasters in verschillende resoluties aangeleverd door RWS-CIV welke direct gebruikt kunnen worden. 

 

4.2.2 CONTROLES VAN DE BRONGEGEVENS 

Op alle brongrids, dus zowel de grids die gemaakt zijn uit geïmporteerde ASCII-data als de data die als grid is 

aangeleverd, dienen de volgende controles te worden uitgevoerd: 

 

1. Orientatie: gecontroleerd moet worden of het grid een hoogte weergeeft (de waarden bij de oevers zijn hoger 

dan in de as van de rivier) en geen diepte (de waarden in de as zijn hoger dan bij de oevers). Tevens dient 

gecontroleerd te worden of de waarden aan de rand van het grid logisch aansluiten bij de rest van de Baseline 

database. 

 

2. Formaat: omdat bij het maken van bathymetriemaatregelen vaak grote hoeveelheden data moeten worden 

verwerkt, wordt alleen met integer grids gewerkt. Hierbij wordt de hoogte in cm ten opzichte van NAP 

weergegeven. Welk formaat een grid heeft, is te zien bij Layer properties. Floating point grids moeten worden 

omgezet naar integer grids. Merk op dat de uiteindelijke hoogtes worden uitgedrukt in meters ten opzichte van 

NAP. 

 

3. Resolutie: elk grid dient een resolutie te hebben van 1x1 meter. Indien het brongrid een hogere resolutie heeft, 

dit omzetten naar 1x1.  
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Figuur 22: Voorbeeld van een grovere (lagere) resolutie en een fijnere (hogere) resolutie. 

4. Oorsprong: elk grid dient een oorsprong te hebben waarvan de coördinaten uit hele meters met een veelvoud 

van de resolutie bestaat, zodat de cellen van alle deelgrids exact op elkaar aansluiten / over elkaar heen liggen. 

Dit houdt in dat voor 1x1 grids de oorsprong coördinaten dient te hebben op hele meters, voor 5x5 grids op 

een veelvoud van vijf meter en voor 20x20 grids op een veelvoud van 20 meter.  Als het bronraster niet de 

juiste resolutie heeft dient contact opgenomen te worden met de leverancier, zodat een correct bestand kan 

worden geleverd. Lukt dit niet, of is dit niet mogelijk pas dan zelf de oorsprong aan. 

 

Een voorbeeld wordt gegeven in de help van ArcGIS. Dit voorbeeld wordt voor de volledigheid hieronder 

weergegeven  

 

 
Figuur 23: Voorbeeld van Shift Raster. Hierbij wordt een raster verplaatst naar een nieuwe geografische locatie gebaseerd op een 

verschuiving in x- en y-richting. 

5. Dekkingsgraad: In de maatregel mogen alleen punten worden opgenomen die komen uit de 5x5 cellen (in het 

geval van een doelresolutie van 5 meter) die tenminste een dekkingsgraad hebben van tenminste 80% van de 

onderliggende data. Deze dekkingsgraad kan worden vastgesteld met behulp van de Aggregate tool. Merk op 

dat de afspraak is dat de bronbestanden door RWS-CIV worden aangeleverd met minimaal 80% dekking. 

Mocht dat niet zo zijn dient contact opgenomen te worden met RWS-CIV voor een vernieuwde aanlevering. 

 

Alle bewerkte bronrasters dienen te worden opgeslagen in de map “data/source” van de maatregel volgens de 

volgende structuur:  

- Losse bronrasters; 

- Samengestelde raster 1 meter resolutie; 

- Samengestelde raster 5 meter resolutie (en grover wanneer van toepassing); 



 

030255 – Draaiboek Baseline maatregelen 
 
 

WSP 
Juli 2025 

pagina 52/81 
  

 

- Alle punten.  

 

 

1) Het omzetten van een raster van “Float” naar “Integer” kan gemakkelijk via “Spatial Analyst 
Tools> Math>Int”. Om voldoende detail in de data te houden wanneer deze is weergegeven 
in m+NAP dient het bronraster eerst vermenigvuldigd te worden met 100. Dit kan worden 
gedaan met via “Spatial Analyst Tools> Math>Times”. 
 

2) Wanneer een raster een te fijne resolutie heeft kan deze worden aangepast via “Spatial 
Analyst Tools> Generalization>Aggregate”. Hierbij is de in te vullen cellfactor afhankelijk van 
het bronraster. Gebruik als “Aggregation technique” altijd Mean. Het vakjes “Expand” dient 
niet aangevinkt te staan. Het vakje “Data”  dient wel aangevinkt te staan.  
 

3) De oorsprong van een raster kan op twee manieren worden opgegeven. Met beide 
methoden wordt de data dus opgeschoven. De eerste is om het raster te kopiëren met een 
snapraster. Dit kan via “Data Management Tools>Raster>Raster Dataset> Copy Raster” In 
deze tool dient dan een snapraster opgegeven te worden bij de “Environmental settings”. 
Let hierbij op dat een snapraster een volledig padverwijzing dient te krijgen, anders zal het 
niet werken. Vanzelfsprekend moet het snapraster een juiste oorsprong bevatten. 
 
Een andere manier om een raster een nieuwe oorsprong te geven is via “Data Management 
Tools>Projections and Transformations>Raster>Shift. Hiervoor dient in de layer properties 
van het bronraster het X – en Y-locatie worden opgezocht. Vervolgens kan de kleinst 
mogelijke afstand in X- en Y-richting worden bepaald om tot een getal in hele meters te 
komen. Dit getal wordt in de tool ingevoerd. 
 

1) De dekkingsgraad van de brondata in het resulterende raster kan worden bepaald met 
“Spatial Analyst Tools> Generalization>Aggregate”. De methode is gelijk zoals eerder 
genoemd onder 2) echter wordt er nu niet gekozen voor “Aggregation technique” Mean, 
maar voor SUM.  Voer deze actie uit op een kopie van het 1x1 bronraster, waarbij alle 
waarden op 1 zijn vastgesteld (dit kan via “Spatial Analyst Tools> Reclass>Reclassify”). 
Vervolgens dient het resultaat van de Aggregate actie geëxporteerd te worden naar een 
polygoon.  Een integer raster kan worden omgezet naar een polygoon middels “Conversion 
Tools>From Raster > Raster to Polygon”. Zorg er hierbij voor dat het vinkje bij “Simplify 
polygons” niet is aangevinkt. Alle 5x5 vlakken met een waarde van 20 of hoger (is gelijk aan 
80% dekking of hoger) gebruiken voor de selectie op de punten. De geselecteerde punten 
mogen worden gebruikt in de maatregel. 
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4.3 WORKFLOW 

In dit hoofdstuk wordt de volledige workflow voor het aanmaken van een maatregel met lodingdata beschreven. Hierbij 

worden de stappen gevolgd uit onderstaande stroomdiagram. Enkele stappen hieruit zijn ook hierboven beschreven. 

Dit heeft met name te maken met de brondata controleren en eventueel aanpassen. 

 

 
Figuur 24: Stroomschema workflow 
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4.3.1 SAMENVOEGEN BRONRASTERS 

Na het controleren en geschikt maken van de aangeleverde brongegevens moeten deze worden samengevoegd tot een 

vlakdekkend bestand. Omdat de verschillende brongegevens niet op hetzelfde moment zullen zijn ingewonnen, zullen 

ze ook niet exact aansluiten wat betreft de grenzen en hoogtegegevens. Voordat de bronrasters dan ook 

samengevoegd kunnen worden zal er een volgorde bepaald moeten worden. Denk hierbij aan welke informatie 

behouden moet blijven bij overlap (bijvoorbeeld altijd de meest actuele data of juist de data met de hoogste resolutie). 

Als deze volgorde vastgesteld is kunnen de bronrasters worden samengevoegd. Dit kan in ArcGIS met “Data 

Management Tools>Raster > Raster Dataset > Mosaic to new raster”. 

 

4.3.2 GENERALISEREN BRONRASTERS 

Wanneer de bronrasters alleen in een resolutie van 1 meter zijn aangeleverd dienen deze gegeneraliseerd te worden 

voor het gebruik in Baseline. Veelal wordt er voor punten in de rivier een resolutie van 5 meter toegepast, in grotere 

waterlichamen wordt 10 meter of 20 meter toegepast. Het is verstandig hierover af te stemmen met de opdrachtgever. 

Het generaliseren kan worden gedaan met de functies Spatial Analyst Tools> Generalization>Aggregate”. Hoe deze 

functie werkt is hierboven beschreven. De volgende stap is het omzetten van het samengevoegde raster naar een 

“Float” en eventueel de waarden omrekenen naar m+NAP. Er kan ook voor gekozen worden om pas om te rekenen 

naar meters wanneer er punten zijn verkregen. 

 

Vervolgens kan het Float raster omgezet worden naar punten. Zorg er hierbij voor dat de punten worden 

weggeschreven in een File GeoDatabase. Voeg aan het puntenbestand een kolom “ELEVATION” toe. Neem vervolgens 

de kolom “GRID_CODE” over naar “ELEVATION”. Reken om naar waarden in meters ten opzichte van NAP wanneer dit 

nog was gedaan. Als laatste worden de punten random met maximaal 1 millimeter verschoven met preparation tool 7 

in de Baseline toolbar. Het doel hiervan is om ervoor te zorgen dat het hoogtemodel wat door Baseline wordt gemaakt 

altijd gelijk is. Dit hoogtemodel wordt aangemaakt met behulp van een “Nearest Neighbour” techniek. Wanneer alle 

punten of gelijke afstand van elkaar liggen is niet te voorspellen welke punten er de hoogste weging krijgen bij het 

aanmaken van het hoogtemodel. Dit wordt opgelost met deze tool. 

 

De volgende stap is het selecteren van de gebieden waar de puntdata vervangen dient te worden. Hiervoor moet eerst 

een omhullende gemaakt worden van de rasterdata. Wanneer de lodingen geleverd zijn door RWS-CIV is van elk 

bronraster ook een metainfo bestand aanwezig. Deze kunnen vergelijkbaar met de bronrasters gestapeld worden, om 

zo een vlakdekkende omhullende polygoon te krijgen. Wanneer dit bestand niet aanwezig is kan de omhullende 

gemaakt worden door het raster om te zetten naar een polygoon. 

4.3.3 ONDERSCHEID BEDLEVEL_POINTS EN WATERBODY_BEDLEVEL_POINTS 

De lodinginformatie dient enkel toegevoegd te worden in de watervlakken van de Baseline referentie en binnen de 

waterniveaulijnen.  Daarnaast geldt dat “bedlevel_points” worden toegevoegd daar waar geldt dat SECTION=1 of 

SECTION=2 in het bestand “section_polygons”. Dit vlak dient dan ook geselecteerd te worden. Het is handig om dit 

bestand vervolgens los op te slaan. Het bestand “waterbody_bedlevel_points” wordt gevuld binnen alle watervlakken 

binnen “Land_use_polygons” en binnen SECTION=3 van het “section_polygons” bestand. Dit vlak dient dan ook 

gecreëerd te worden. Dit kan door alle watervlakken te selecteren en vervolgens te clippen op SECTION=3. 

 

Clip vervolgens de gemaakte omhullende bestanden van de lodingen welke voldoen aan de dekkingsgraad van 80% (zie 

hoofdstuk 4.2.2) met behulp van deze twee bestanden. Op deze wijze zijn er vlakken gemaakt waarbinnen 

“bedlevel_points” en/of “waterbody_bedlevel_points” moeten worden toegevoegd. Met behulp van deze twee 

polygonen kunnen de benodigde punten worden geclipt uit het puntenbestand wat eerder is gemaakt. Deze geclipte 
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punten kunnen vervolgens worden toegevoegd aan de gemaakte Baseline maatregel. Zoals beschreven in de allereerste 

zin van deze paragraaf mogen er enkel punten worden toegevoegd binnen de watervlakken en binnen de 

waterniveaulijnen. Dit wil zeggen dat de toegevoegde punten ook moeten passen op de geometrie van de database en 

niet alleen op de watervlakken. De natte contouren zijn afkomstig uit de ecotopenkartering en zullen dan ook afwijken 

van de geometrie (bijvoorbeeld de waterniveaulijnen). De toegevoegde lodingdata moet passen bij de geometrie. Dit 

houdt in dat er een nabewerking nodig is om de punten voorbij de waterniveaulijn te verwijderen of eventueel punten 

toe te voegen wanneer het watervlak te krap is gedefinieerd. De gebruiker kan ervoor kiezen om dit handmatig/visueel 

te doen of om de gemaakte selectievlakken aan te passen op de geometrie voordat de punten worden geclipt.  

 

NB. Bij de kust worden lodingen vaak gecombineerd met hoogtemetingen op het strand of in de duinen. Hier is het wel 

wenselijk om de data die in SECTION 3 vallen in Baseline toe te voegen in de Featureclass Surface_level_points. 

 

Vervolgens moeten de punten welke te dicht bij een hoogtelijn liggen worden verwijderd. Er is altijd naderhand een 

visuele controle nodig om te kijken of er nog punten zijn die het hoogtemodel verstoren of dat er juist toch extra 

punten nodig zijn. 

 

Tabel 5: Afstanden vanaf hoogtelijnen waarbinnen bedlevel_points en waterbody_bedlevel_points moeten worden verwijderd. 

FEATURE CLASS TE HANTEREN AFSTAND [M] 

 Bedlevel_points waterbody_bedlevel_points 

TERRAIN_JUMPS 2 2 

ELEVATED_LINES; GROYNE 10 10 

ELEVATED LINES; LOCAL EMBANKMENT 2 2 

TERRAIN_EDGE 2 2 
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Figuur 25: Voorbeeld onderscheid bedlevel_points en waterbody_bedlevel_points. 
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4.3.4 CONSTRUCTIE ERASE FEATURE CLASSES 

Wanneer alle puntinformatie is verwerkt, moet worden bepaald waar de bestaande hoogtepunten worden verwijderd. 

Hiervoor kunnen twee soorten aanpak worden gekozen. Voor de geleverde bronbestanden is gecontroleerd of er 

voldaan wordt aan de 80% dekkingsgraad voor de resulterende resolutiekeuze. Hiervoor is een polygonen bestand 

gemaakt. Deze polygonen kunnen worden gemerged (en gedissolved) en gebruikt worden als erasecontouren. 

 

Een volgende manier is het erasevlak opbouwen op basis van de daadwerkelijk toe te voegen punten. Dit kan door deze 

punten om te zetten naar een integer raster (aangeraden wordt een resolutie van 5 meter te hanteren) en vervolgens 

dit raster om te zetten naar polygonen en deze te dissolven. Het resulterende bestand kan worden gebruikt om de 

erasecontouren te vullen. 

 

De volgende erase- Feature Classes dienen gevuld te worden: 

“Erase_bedlevel_points”,“Erase_waterbody_bedlevel_points” en “erase_surfacelevel_points”. 

 

De laatste stap is het afronden van de Baseline 6 maatregel met de preparation tools 8, 9, 10 en 11 en Validatiemodule, 

In de Baseline toolbar is onder tools een functie “Check variant/Measure” waarmee de gebouwde maatregel wordt 

onderworpen aan een datamodel controle (protocolcheck) en een inhoudelijke controle (content check).  

Merk op dat bij het toepassen van preparation tool 8 in combinatie met het toevoegen van veel hoogtepunten het een 

lange tijd kan duren voordat de measure_contour is aangemaakt. Sneller is het in dat geval om de erasepolygonen 

samen te voegen en een buffer van 0,2 meter daaromheen te leggen en vervolgens dit resulterende vlak te gebruiken 

als measure_contour. 

 

Ten slotte dient er een metainfo document geschreven te worden. 
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2) Het samenvoegen van rasters kan worden gedaan met “Data Management 
Tools>Raster>Raster Dataset>Mosaic to New Raster”. Voeg hierbij de rasters toe in de juiste 
volgorde en kies Pixel_type op 16_BIT_Signed, Cellsize op de gewenste resolutie, Mosaic 
method op LAST en Mosaic Colormap op Match. Ga vervolgens naar Environment settings 
en selecteer “union of inputs” bij Extent. 

3) Het omzetten van een raster van “Integer” naar “Float” kan gemakkelijk via “Spatial Analyst 
Tools> Math>Float”. Om de data om te zetten van centimeter naar meter kan “Spatial 
Analyst Tools> Math>Divide” worden gebruikt. 

4) Het converteren van een raster naar punten kan worden gedaan met “Conversion 
Tools>From Raster>Raster to Point” 

5) Het toevoegen en berekenen van het veld “ELEVATION” wordt gedaan met “Data 
Management Tools>Fields>Add Field”. Kies hier voor een “Double”. Het berekenen wordt 
vervolgens gedaan door “Data Management Tools>Fields>Calculate Field”. Hierbij wordt bij 
de expressie gekozen voor round([grid_code],2). Op deze wijze worden de waarden direct 
afgerond op 2 decimalen. 

6) Polygonen kunnen gestapeld worden, vergelijkbaar met rasters, zoals beschreven onder 1, 
met de tool “Analysis>Overlay>Update”. 

7) Een integer raster kan worden omgezet naar een polygoon middels “Conversion 
Tools>Raster to Polygon”. Zorg er hierbij voor dat het vinkje bij “Simplify polygons” niet is 
aangevinkt. 

8) Clippen is het bijsnijden van een bestand binnen de extent van een andere polygoon. Dit kan 
worden gedaan middels “Analysis>Extract>Clip” 

9) Het toevoegen van een grote hoeveelheid puntdata aan een bestaande feature class is het 
gemakkelijkst te doen met behulp van “Data management Tools>General>Append”. Bij 
input wordt het bronbestand genoemd, bij target het te vullen Baseline bestand. Let erop 
dat het “Schema Type” op “No_Test” staat. 

10) Het verwijderen van punten nabij hoogtelijnen kan het besten worden gedaan met “Data 
Management Tools>Layers and Table Views>Select Layer by Location” in combinatie met de 
op te geven afstand tot de hoogtelijn. Vervolgens kan deze selectie uit het bestand worden 
verwijderd met “Data Management Tools>Features>Delete Features”. Merk hierbij op dat 
het belangrijk is dat de selectie nog actief is op dat moment, is dit niet het geval dan worden 
alle punten verwijderd. 
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5 DRAAIBOEK RUWHEID 

5.1 INLEIDING 

Dit hoofdstuk beschrijft de werkwijze voor het maken van Baseline maatregelen die wijzigingen in de feature dataset 

‘Roughness’ aanbrengen. 

 

De feature dataset ‘Roughness’ bevat drie Feature Classes: 

1 Land use points; 

2 Land use lines; 

3 Land use polygons. 

 

Paragraaf 5.3 beschrijft verschillende type maatregelen die binnen deze feature dataset kunnen worden gemaakt: 

uitbreidings-, actualisatie- en ontwerpmaatregelen. De bronnen die kunnen worden gebruikt voor uitbreidings- of 

actualisatiemaatregelen worden toegelicht in paragraaf 5.3. Voor actuele modellen (J-modellen) en beheer en 

onderhoud modellen (beno-modellen) worden verschillende vegetatieklassen gebruikt. Ontwerpmaatregelen 

gebruiken dezelfde vegetatieklassen als beheer en onderhoud modellen. Deze vegetatieklassen worden toegelicht in 

paragraaf 5.4. Paragraaf 5.5 bevat een workflow voor het opstellen van maatregelen.  

5.2 TYPE MAATREGELEN 

5.2.1 UITBREIDING OF WIJZIGING REFERENTIE 

Een Baseline-maatregel die wijzigingen in de feature dataset ‘roughness’ aanbrengt, kan zowel een gebied toevoegen 

aan een referentiedatabase als een wijziging aanbrengen in een bestaande schematisatie (Fout! Verwijzingsbron niet 

gevonden.). Wanneer een aanpassing in een bestaande schematisatie wordt gedaan, kan dit een ontwerp- of 

actualisatiemaatregel zijn. Een ontwerpmaatregel beschrijft een voorgenomen ontwikkeling. Een actualisatiemaatregel 

betreft het actualiseren van de vegetatie in de uiterwaarden.   

 

 
Figuur 26: Type maatregelen roughness-layers, waarbij aangegeven is of het een maatregel in een actueel model (j-schematisaties) of 

een maatregel in een beheer en onderhoud schematisatie (beno) is 
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5.2.2 ACTUEEL MODEL OF BEHEER EN ONDERHOUD MODEL 

Een maatregel beschrijft een wijziging in een actueel model (J-model) of beheer en onderhoud model (beno). In Fout! 

Verwijzingsbron niet gevonden. is weergegeven welk type maatregel in welke model wordt uitgevoerd.  

5.3 BRONNEN UITBREIDINGS- EN ACTUALISATIE-
MAATREGELEN 

In dit hoofdstuk worden de belangrijkste en meest gebruikte bronnen voor de Feature Classes in de Feature Dataset 

‘Roughness’ beschreven voor uitbreidings- en actualisatiemaatregelen. Daarnaast worden er enkele bronnen 

beschreven die eerder zijn gebruikt bij het genereren van Baseline maatregelen in gebieden waar geen reguliere 

bronnen voorhanden waren. Deze kunnen nodig zijn als de reguliere bronnen niet beschikbaar zijn.  

 

Voor al deze bronnen is al een conversiesleutel beschikbaar waarmee er een vertaling naar ruwheidscodes in Baseline 

kan worden gemaakt. Het is zeker niet uitgesloten dat er nog andere bronnen mogelijk zijn, hiervoor is echter nog geen 

conversiesleutel beschikbaar. Deze zal dan in overleg met RWS-WVL moeten worden opgesteld. Het is de keuze van de 

modelleur welke bron wordt gebruikt bij het opbouwen van de maatregel.  

  

Merk hierbij op dat deze conversiesleutels gebruik maken van handboek klassen. Hiermee zijn deze sleutels slechts te 

gebruiken voor actualisaties voor actuele modellen (de zogenaamde J-modellen). Voor de zogenaamde Beheer en 

Onderhoud modellen (BenO-modellen) dienen de vegetatieklassen uit de vegetatielegger te worden gebruikt (binnen 

het gebied waar de vegetatielegger van toepassing is). Dit geldt bijvoorbeeld bij het uitvoeren van een rivierkundige 

beoordeling van een nieuwe ontwikkeling. Alle te gebruiken vegetatieklassen zijn opgenomen in het Baseline 7 

dataprotocol, in appendix B. 

 

Tabel 5.1 Mogelijke bronbestanden (in gewenste volgorde van gebruik) 

 

Naam bronbestand Beschrijving 

Ecotopen Een ecotopenkaart wordt opgebouwd door 

meerdere informatielagen samen te voegen, zoals 

een vegetatiestructuurkaart, een 

waterdieptekaart, een overstromingsduurkaart, 

etc. De vegetatiestructuurkaart vormt hierbij de 

belangrijkste laag. De vegetatiestructuurkaart 

wordt met behulp van luchtfoto's geproduceerd 

op een schaal van 1:10.000. Een ecotoop is 

gedefinieerd als een ruimtelijk te begrenzen 

ecologische eenheid, waarvan de samenstelling en 

ontwikkeling worden bepaald door abiotische, 

biotische en antropogene aspecten samen 

(Overheid.nl, 2022).  

Het is daarmee de voorkeursbron voor het maken 

van ruwheidsmaatregelen. 

DTB Digitaal Topografisch Bestand (DTB) van de 

hoofdinfrastructuur in beheer bij Rijkswaterstaat. 

Het DTB is opgebouwd uit punt-, lijn- en 

vlakinformatie. Het detailniveau is schaal 1:1000 

(Rijkswaterstaat, 2022).  Van het vlakkenbestand 
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Naam bronbestand Beschrijving 

wordt enkel dat deel gebruikt waarvoor geldt 

LAYER=1. Dit wordt gedaan om bruggen en 

dergelijke niet mee te nemen. 

Basisregistratie grootschalige topografie (BGT) Basisregistratie Grootschalige Topografie (BGT) is 

de uniforme, gedetailleerde digitale basiskaart van 

Nederland. Alle gebouwen, wegen, water en 

groen (objecten) zijn hier eenduidig op vastgelegd. 

De kaart is op 20 centimeter nauwkeurig. 

Basisregistratie adressen en gebouwen (BAG) De BAG (Basisregistratie Adressen en Gebouwen) 

is onderdeel van het overheidsstelsel van 

basisregistraties. Gemeenten zijn bronhouders 

van de BAG. Zij zijn verantwoordelijk voor het 

opnemen van de gegevens in de BAG en voor de 

kwaliteit ervan. 

LGN4, 5 & 7 Het Landelijk Grondgebruiksbestand Nederland 

(LGN) is een landsdekkend bestand, gebaseerd op 

een combinatie van geodata (WUR, 2022). Het 

LGN is een rasterbestand met een resolutie van 

5x5 meter (vanaf 2018). 

Top10NL Basisregistratie topografie (BRT) Top10NL. TOPNL 

bestanden zijn objectgerichte topografische 

bestanden op diverse schaalniveaus. Deze 

bestanden maken onderdeel uit van de Basis 

Registratie Topografie (BRT). De bestanden zijn 

uniform, consistent en bovendien landsdekkend 

(PDOK, 2022). 

VEGWAD VEGWAD bevat kwelderkarteringen en maakt 

onderdeel uit van het programma Monitoring der 

Waterstaatkundige Toestand des Lands (MWTL). 

Deze karteringen worden onder meer gemonitord 

in het kader van KRW, natura 2000 en TMAP. 

Standaard worden de vegetaties van de kwelder- 

en schorgebieden eens in de zes jaar gekarteerd 

(monitoring). (Waterinfo-extra, 2022). 

Openstreetmap Open source geografische data. 

ATKIS 2013 ATKIS Digital Basis landscape Model (DLM) is een 

Duits project waar het landgebruik in Duitsland 

mee in kaart wordt gebracht. 

Corine Landcover Corine Landcover is een Europese open source 

landgebruikskaart met 44 klasses (resolutie van 25 

hectare). 

 

Zoals al naar voren komt in de bovenstaande tabel zijn er verschillende bronnen die op verschillende manieren worden 

gegenereerd. Daarnaast is er verschil in detail en resolutie. Daarom is het altijd van belang om het doel van de 

maatregel en het gebied in ogenschouw te nemen bij het kiezen van een geschikte bron.   
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5.4 VEGETATIEKLASSEN 

In een maatregel die een wijziging in de feature dataset ‘roughness’ aanbrengt, worden verschillende vegetatieklassen 

gebruikt voor een J- of beno-model. In een J-model worden handboekklassen gebruikt en in een beno-model worden 

vegetatieleggerklassen gebruikt. In deze paragraaf worden beide type klassen beschreven. 

5.4.1 HANDBOEKKLASSEN 

Voor maatregelen in actuele modellen (J-modellen) dienen handboekklassen te worden gebruikt. Dit zijn 

vegetatieklassen zoals beschreven in de rapporten ‘Stromingsweerstand vegetatie in uiterwaarden’ deel 16 en deel 27.  

5.4.2 VEGETATIELEGGERKLASSEN 

Voor maatregelen in beno-modellen dienen vegetatieleggerklassen te worden gebruikt. In onderstaande tekst worden 

deze vegetatieleggerklassen toegelicht. 

 

Inleiding   

In de Vegetatielegger van Rijkswaterstaat8 wordt gewerkt met 4 verschillende homogene vegetatieklassen. Deze 

vegetatieklassen worden van elkaar onderscheiden door de mate van ruwheid. Van glad naar ruw gaat het om de 

volgende vegetatieklassen:   

— gras en akker; 

— riet en ruigte;   

— bos;   

— struweel.  

 

Daarnaast zijn er 3 mengklassen gedefinieerd. Mengklassen zijn opgebouwd in percentages ruwe begroeiing (dit is 

begroeiing met een opstuwende werking bij hoogwater, zoals bos en struweel) en gladde begroeiing (gras en akker) en 

geven flexibiliteit bij het beheer van natuurgebieden.    

 

 
 

Tenslotte zijn er twee klassen met een vaste ruwheid gedefinieerd: water en bebouwd of verhard terrein. 

 

  

 
6 Velzen, E.H. et al. (2003), Stromingsweerstand vegetatie in Uiterwaarden, Deel 1. Handboek   

              versie 1-2003, RIZA rapport 2003.028. 
7 Velzen, E.H. et. al. (2003), Stromingsweerstand vegeatie in Uiterwaarden, Deel 2.  

              Achtergronddocument versie 1-2003, RIZA rapport 2003.029. 
8 Zie ook https://www.rijkswaterstaat.nl/water/waterbeheer/bescherming-tegen-het- 

   water/waterkeringen/leggers/vegetatielegger/index.aspx  
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Voor het schematiseren van vegetatie zijn slechts de volgende ruwheidscodes toegestaan:   

201: water   

202: verhard oppervlak    

1981: gras en akker   

1982: riet en ruigte   

1983: bos   

1984: struweel    

1996: mengklasse 90/10   

1997: mengklasse 70/30   

1998: mengklasse 50/50    

 

De contour van een mengklasse en de mengklasse zelf zijn onlosmakelijk aan elkaar gekoppeld. Bij het schematiseren 

van een plan mag deze koppeling niet worden verbroken voor reeds gedefinieerde mengklassen op de vegetatielegger. 

Initiatiefnemers kunnen in het geval van aanpassing van de mengklassen in het projectgebied contact opnemen met de 

rivierbeheerder over de te volgen werkwijze9.     

 

Heggen worden als aparte categorie opgenomen. Heggen en hagen zijn lijnvormige rijen van struiken of bomen. Als een 

heg smaller is dan 5 m en minimaal 5 m lang, dan dient deze als lijnelement te worden geschematiseerd. Indien een heg 

breder is dan 5 m dan dient een heg niet meer als lijnelement maar als struweel (tot 5 m hoog) of als bos (hoger dan 5 

m) geschematiseerd te worden.    

 

Solitaire bomen, bomen in kleine groepen (maximaal 3 exemplaren) en bomen in rijen of lanen dienen als punten 

geschematiseerd te worden. Bomen in rijen of lanen waarvan de kronen aaneensluiten, dienen niet als boom maar als 

bos geschematiseerd te worden.    

 

Deze manier van schematiseren sluit 1 op 1 aan bij de Vegetatielegger10, welke opgenomen is in de te gebruiken B&O-

modellen van Rijkswaterstaat. 

 

Homogene vegetatieklassen   

  

Gras en akker 

De klasse gras en akker bestaat uit onbegroeide terreinen, open kruidenvegetaties, dichte grasvegetaties en 

ruigtekruiden die in de winter bovengronds afsterven of platliggen. Het meest onderscheidende kenmerk van deze 

klasse is de afwezigheid van vegetatie of, indien wel aanwezig, een open vegetatie met een gemiddelde hoogte van 

minder dan circa 50 cm in de winter. In beperkte mate kan riet en/of ruigte en in zeer geringe mate bomen of struiken 

aanwezig zijn, in kleine eenheden van maximaal enkele vierkante meter. Door extensivering van het beheer kan dit type 

overgaan in de klasse riet en ruigte met een gemiddelde vegetatiehoogte van meer dan circa 50 cm. 

 

Riet en ruigte 

De klasse riet en ruigte bestaat uit moerasvegetaties en natte tot droge ruigten, die in de winter bovengronds niet 

afsterven of platliggen. Het meest onderscheidende kenmerk is de dominantie van kruiden met een hoogte van 1 tot 2 

m, waardoor deze klasse beduidend hoger is dan de klasse gras en akker. De moeras- en ruigtevegetaties worden veelal 

gedomineerd door een beperkt aantal soorten. De variabiliteit aan soorten is binnen de klasse echter groot als gevolg 

van variatie in voedselrijkdom en vochtigheid van de bodem. Er kunnen in beperkte mate bomen of struiken aanwezig 

zijn, in eenheden van maximaal enkele vierkante meter. Door extensivering van het beheer kan dit type overgaan in de 

klasse struweel. 

 

 
9 Zie interne werkafspraak mengklassen bij rivierkundige toetsing van vergunningaanvragen https://werkwijzer.cf-

prod.intranet.rws.nl/link/standaard/5597   
10 Vegetatielegger van de Legger Rijkswaterstaatswerken, oktober 2014.  
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Struweel 

De klasse struweel bestaat uit vegetaties die gedomineerd worden door struiken. De hoogte varieert van circa 2 tot 5 

m. Het meest onderscheidende kenmerk is naast vegetatiehoogte een dichte structuur van takken en stammen over de 

gehele hoogte. De struwelen worden gedomineerd door een beperkt aantal soorten. Er kan een ondergroei van ruigte 

aanwezig zijn. Deze klasse kan op den duur overgaan in de klasse bos, indien jonge boomvormende soorten voorkomen 

(bijvoorbeeld bij zachthoutooibos) of bomen zich tijdens de successie vestigen. 

 

Bos 

De klasse bos bestaat uit vegetaties die gedomineerd worden door opgaande bomen. De hoogte varieert van circa 5 m 

tot meer dan 15 m. Belangrijkste onderscheidende kenmerk van deze klasse ten opzichte van de klasse struweel, is 

beperkte aanwezigheid van takken en stammen in de onderste meters. De boomlaag wordt veelal gedomineerde door 

een beperkt aantal soorten. Met name bij natuurlijk bos kan een ondergroei van ruigte en struweel aanwezig zijn. 

Boomgaarden en bomenlanen met aaneengesloten kruinen staan als bos op de legger. 

5.5 WORKFLOW 

Figuur 27 toont de algemene workflow voor het opbouwen van maatregelen ten behoeve van de ‘roughness’. Hierbij 

wordt onderscheid gemaakt voor het proces voor een uitbreidings-, actualisatie- of ontwerpmaatregel (zie paragraaf 

5.2 voor een toelichting op de typen maatregelen). In deze paragraaf wordt elke stap van het getoonde proces 

beschreven. De nummering van de paragrafen komt overeen met de nummering van de stappen in Figuur 27.  

 

In de tekst zal niet in detail worden ingegaan op de eventueel benodigde acties in GIS. Dit wordt gedaan in aparte 

tekstvakken. 
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Figuur 27 Workflow voor maatregelen ten behoeve van roughness layers 

5.5.1 SELECTEREN BRONBESTANDEN 

De eerste stap voor uitbreidings- of actualisatiemaatregelen is het selecteren van de te gebruiken bronbestanden. Dit 

kan op basis van tabel 5.1 of op basis van nog niet genoemde bronnen (in het geval er een schematisatie in een gebied 

buiten Nederland wordt opgebouwd).  
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5.5.2 OPBOUWEN EN OPSCHONEN VAN BRONBESTANDEN 

De volgende stap is het opbouwen/opschonen van het bronbestand.   

Voor nieuwe elementen (die onderdeel zijn van de maatregel) geldt dat, indien van toepassing, de polygonen met de 

hoogste nauwkeurigheid bovenop moeten liggen. Slivers van polygonen die hetzelfde onderdeel beschrijven uit andere 

databronnen, moeten worden opgelost (gemerged met naastgelegen polygonen), zodat een eenduidige en logische 

ruwheidsbeschrijving ontstaat, die klopt met de geometrie. Verder mogen er ook geen gaten aanwezig zijn in de data. 

Daarnaast is het van belang om alle broncodes (kenmerkende codes uit het bronbestand welke de vegetatie 

classificeren) in één kolom te plaatsen. 

 

Het samenvoegen van punten/lijnen of vlakken bestanden kan worden gedaan met de ‘Merge’ tool. Deze  

wordt gevonden onder ‘Data Management Tools>General>Merge’. 

Overlap verwijderen omhelst de volgende stappen. Allereerst moet bepaald worden waar de overlap zich 

bevindt. Dit kan worden gedaan met behulp van ‘Analysis Tools>Overlay>Intersect’. Vul bij ‘Input Features’ 

alleen het bronbestand in. Vervolgens wordt een bestand weggeschreven waarin de overlap binnen het 

bestand wordt weergegeven. Is dit bestand leeg dan is er geen overlap en kan worden verdergegaan met 

het doorlopen van het proces. Is er wel data aanwezig in de output Feature Class dan is er overlap.  

Afhankelijk van de mate van overlap kan er worden besloten om handmatig de overlap te verwijderen in 

een editsessie binnen ArcGIS met de ‘Cut Polygon’of ‘Reshape’ tool. Wanneer het duplicaten betreft 

kunnen deze ook uit de attribuuttabel worden verwijderd.  In het geval dat het een groot aantal kleine 

oppervlaktes (slivers) betreft kan de volgende werkwijze worden gevolgd. Op basis van het resultaat van 

de ‘Intersect’ worden de duplicaten uit het bronbestand verwijderd met ‘Erase’ (Analysis Tools> 

Overlay>Erase). Daarna wordt uit het bronbestand (met de overlap erin!) een uitsnede gemaakt met ‘Clip’ 

(Analysis Tools> Extract> Clip’). De overlap uit deze uitsnede wordt verwijderd met ‘Dissolve’ (Data 

Management Tools>Generalization> Dissolve). Let hierbij goed op dat het vinkje bij ‘Create multipart 

features’ uit staat! Multiparts zijn niet toegestaan binnen het Baseline protocol, daarom is het verstandig 

om alleen met single part Feature Classes te werken. Vervolgens wordt de uitkomst van de dissolve 

samengevoegd met de uitkomst van de erase actie. Om ervoor te zorgen dat alle vlakjes een broncode 

voor de ruwheid krijgen wordt gebruik gemaakt van ‘Eliminate’( Data Management 

Tools>Generalization>Eliminate). Vervolgens kan er een Dissolve worden uitgevoerd op broncode zodat 

alle vlakken samengevoegd worden. Let wederom op het vinkje voor multipart features. Dit proces kan 

veel gemakkelijker worden voltooid door de ArcGIS Plugin ‘ET Geowizards’ met behulp van het commando 

‘Clean Polygon Layer’ Echter is dit geen standaard ingebouwde functionaliteit van ArcGIS. ET Geowizard 

kan worden gedownload via https://www.ian-ko.com/.  

Alle broncodes (hiermee worden de codes bedoeld uit de bronbestanden welke door middel van de 

conversiesleutel worden vertaald naar Baseline ruwheidscodes) kunnen worden samengevoegd door een 

kolom toe te voegen aan de attribuuttabel. Dit wordt gedaan door ‘Add Field’ (Data Management Tools> 

Fields>Add Field). Vervolgens kunnen de broncodes met de Field Calculator in de nieuwe kolom worden 

toegevoegd. Deze kolom kan dan later in het proces worden gebruikt. 

 

5.5.3 CONTROLEREN/UPDATEN LANDUSE_KEY 

In de installatiedirectory van Baseline staat de conversiesleutel (dit bestand bevat een vertaling van de gebruikte 

codering in de bronbestanden naar ruwcodes volgens Baseline protocol) waar al eerder aan is gerefereerd 

(<InstallDir><Scripts><BaselineInputModule><landuse_key.csv>). Hierin zijn de bestaande sleutels opgenomen. 

Controleer hierin of de in het bronbestand aanwezige codes ook in de sleutel aanwezig zijn (bestaande 

conversiesleutels zijn opgenomen in bijlage 3). Is dit niet het geval voeg deze dan toe. Doe dit in overleg met RWS-WVL 

zodat deze goedgekeurd zijn, en zodat deze ook opgenomen kunnen worden in een actuele versie van de algemene 
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conversiesleutel. Wanneer werkbaar (in verband met de grootte van het gebied dat aangepast wordt) wordt 

aanbevolen om de conversie(sleutel) te controleren aan de hand van een luchtfoto en een andere keuze te maken 

wanneer dat duidelijk beter past bij de luchtfoto (in vergelijking met de conversiesleutel). 

5.5.4 OMTREK VAN GEBIED DEFINIËREN 

Uitbreidings- of actualisatiemaatregel 

Voordat een nieuw gebied toegevoegd kan worden moet worden bepaald welk gebied toegevoegd dient te worden aan 

de modelschematisatie. Van dit gebied moet een shapefile/feature class gemaakt worden. Deze shapefile/feature class 

wordt later in het proces gebruikt om de bestanden af te knippen op de beoogde begrenzing. De shapefile/feature class 

dient dan ook een exacte polygoon te zijn van de omtrek van het toe te voegen gebied. Let hierbij ook op een exacte 

aansluiting op het bestaande gebied in de referentie database. Meestal wordt hier de feature class Section_polygons 

gebruikt. Met deze shapefile/feature class kan het bronbestand worden geclipt zodat alleen de relevante gebiedsdata 

wordt meegenomen.  

 

Ontwerpmaatregel 

Als eerste stap bij het opstellen van een ontwerpmaatregel wordt het projectgebied gedefinieerd. Hiervan wordt een 

feature class gemaakt. Deze feature class kan later worden gebruikt om bestaande ‘land_use_lines’ en 

‘land_use_points’ te verwijderen met behulp van erase_polygonen. 

5.5.5 OMZETTEN BRONBESTAND NAAR LAND_USE_POLYGONS 

Uitbreidings- of actualisatiemaatregel 

Vervolgens dient dit geclipte bronbestand omgezet te worden naar land_use_polygons met behulp van de 

conversiesleutel. 

 

Ontwerpmaatregel 

Bij een ontwerpmaatregel worden de land_use_polygons opgezet op basis van een ontwerp. Hier worden handmatig 

ruwheidsklassen (vegetatielegger) aan gekoppeld. 

 

NB: handboekklassen kunnen worden geconverteerd naar vegetatieleggerklassen. 

5.5.6 GEBOUWEN EN ZOMERBED IN GEBIED IDENTIFICEREN EN 
VERWIJDEREN UIT MAATREGEL 

Om te voorkomen dat informatie over bebouwing en zomerbedruwheid in de referentie wordt overschreven door de 

maatregel, moet uit de geclipte bestanden alle informatie ter plaatse van gebouwen en alle basisruwheden voor 

zomerbed en meerbodem worden verwijderd. Dit kan door deze vlakken toe te voegen aan de maatregel met 

herkenbare roughness_code 9999, waarbij de onderliggende informatie in de maatregel wordt overschreven (dit kan 

met Analysis Tools > Overlay > Update). Vervolgens kunnen de polygonen met roughnes_code 9999 worden verwijderd.  

NB. De stappen uit paragraaf 5.5.5 en 5.5.6 zijn verwerkt in Baseline preparation tool 12. Create land use polygons. 

5.5.7 TOEVOEGEN/UPDATEN VAN LAND_USE_LINES EN LAND_USE_POINTS 

Uitbreidingsmaatregel 

De volgende stap is het toevoegen van land_use_lines en land_use_points. Deze kunnen gemaakt worden op basis van 

de gebiedsuitsnede waarbinnen geactualiseerd moet worden in combinatie met de bronbestanden voor deze Feature 

Classes. De attribuuttabel kan worden toegevoegd op basis van individuele afspraken en/of het dataprotocol.  
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Ontwerp- of actualisatiemaatregel 

Bij ontwerp- of actualisatiemaatregelen dienen de bestaande land_use_lines en land_use_points eerst te worden 

verwijderd door het aanmaken van erase-polygonen. Deze kunnen gemaakt worden op basis van de omtrek van de 

maatregel. Op deze manier worden alle bestaande bomen en heggen verwijderd. Vervolgens kunnen de nieuwe 

land_use_lines en land_use_points worden toegevoegd.  

5.5.8 VERWIJDEREN VAN LAND_USE_LINES EN LAND_USE_POINTS BINNEN 
HOUT- EN/OF BOSACHTIGE LAND_USE_POLYGONS 

Belangrijk is het verwijderen van de land_use_lines en land_use_points die vallen binnen de hout- en/of bosachtige 

land_use_polygons. Hierin is immers al voorzien voor bijvoorbeeld bomen. Wanneer er dan ook nog losse bomen 

worden opgenomen wordt de ruwheid overschat. Dit geldt voor de volgende ROUGHNESS_CODES uit 

land_use_polygons: 

 

Tabel 5.2 Hout- en bosachtige vegetatie 

Roughness_code Omschrijving 

1231  handboekklasse zachthoutstruweel  

1232  handboekklasse griend  

1233  handboekklasse doornstruweel  

1242  handboekklasse productiebos hardhout  

1244  handboekklasse productiebos zachthout  

1245  handboekklasse productiebos naaldhout  

1983  leggerklasse bos  

1984  leggerklasse struweel  

1996  leggerklasse 90/10  

1997 leggerklasse 70/30 

1998 leggerklasse 50/50 

 

Het verwijderen kan worden gedaan met behulp van een erasepolygoon. Het erasepolygoon bestaat uit de hout- en 

bosachtige vlakken. De volgende erase Feature Classes dienen gevuld te worden: ‘erase_land_use_lines’ en 

‘erase_land_use_points’. 
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5.5.9 CORRIGEREN RUWHEIDSVLAKKEN PIJLERS 

Daar waar in ‘land_use_polygons’ geldt dat ROUGHNESS_CODE=3 betreffen het pijlers. De centroide hiervan dient 

opgenomen te worden in ‘bridge_points’ (zie hoofdstuk ‘Location Layers’). Dit bestand moet daarna nog worden 

omgezet naar bridge_routes en bridge_events met de preparation tools.  

 

De pijler-vlakken waarvan de centroide is bepaald dienen de ruwheidscode te krijgen van het omliggende vlak uit 

land_use_polygons. Dit kan worden gedaan met de functie ‘Eliminate’. Een uitzondering op deze werkwijze is wanneer 

er sprake is van grote pijlervoeten. Deze dienen wel in land_use_polygons te blijven. De reden is dat op deze 

pijlervoeten de echte brugpijler staat. De afmetingen van de pijlervoeten zijn zo groot dat deze in de ruwheden en 

(vaak ook) het hoogtemodel aanwezig moeten zijn. De ruwheidscode kan in dat geval worden aangepast naar verhard. 

 

1 Het clippen van een bestand kan worden gedaan met de functie ‘Clip’ (Analysis Tools> Extract> Clip)  

2 Select by Location wordt aangeroepen via ‘Data Management Tools> Layers and Table Views> Select 

Layer By Location.  Kies hier dan voor Relationship = INTERSECT.  Vervolgens wordt alle records uit de 

Input Feature Layer geselecteerd op basis van de Selecting Features.   

4 Select by Attribute wordt aangeroepen via ‘Data Management Tools> Layers and Table Views> Select 

by Attribute’. Kies hier het juiste bestand waarin geselecteerd moet worden en stel de expressie op.  

5 De centroide van een vlak kan bepaald worden met de functie ‘Feature To Point’ (Data Management 

Tools>Features>Feature to Point). Geef hierbij het bestand op dat omgezet moet worden en vink het 

vakje bij ‘Inside’ niet aan. Belangrijk is hierbij dat het een Single Part Feature Class betreft.   

6 ‘Eliminate’(Data Management Tools>Generalization>Eliminate). Met deze functie kunnen vlakken 

worden samengevoegd met andere vlakken op basis van gedeelde grens of oppervlakte. De functie 

heeft een inputbestand nodig (in dit geval het ‘land_use_polygons’ bestand). Wanneer hier de pijlers 

uit verwijderd moeten worden (omdat deze de omringende ruwheidscode dienen te krijgen) moeten 

deze vlakken geselecteerd worden (de functie werkt op selecties). Vervolgens moet de gebruiker de 

keuze maken welke optie wordt gebruikt om de vlakken samen te voegen. Dit kan zoals gezegd 

gebaseerd hebben op de langst gedeelde grens, of dat het vlak wordt samengevoegd met het grootste 

vlak waarmee een grens wordt gedeeld. 

5.5.10 AFRONDEN MAATREGEL EN OPSTELLEN METADATA 

De laatste stap is het afronden van de Baseline maatregel met de preparation tools 8, 9, 10 en 11. Preparation tool 13 

bevat de functie ‘Check variant/Measure’ waarmee de gebouwde maatregel wordt onderworpen aan een datamodel 

controle (protocolcheck) en een inhoudelijke controle (content check).  

 

Nadat een maatregel is afgerond dient er een proefmix gedaan te worden. Hiermee wordt bedoeld dat de maatregel 

wordt ingemixt zodat daarna gecontroleerd kan worden of de maatregel het beoogde doel behaalt en goed is ingepast 

in de referentie. Deze controle wordt veelal visueel uitgevoerd. Er wordt gecontroleerd of het gehele gebied is 

toegevoegd, en of de juiste ruwheden zijn toegevoegd. Dit laatste kan gedaan worden door na te gaan of de juiste 

vegetatieklassen worden weergegeven. Wanneer er bijvoorbeeld nog niet eerdere gebruikte roughness_codes zijn 

gebruikt worden deze bij ‘Set active variant’ weergegeven als ‘Not defined’ (roze vlakken). Een polygoon met 

roughness_code 0 (‘onbekend’) wordt weergegeven als wit vlak. Aangezien D-Hydro op deze locaties een default 

ruwheid veronderstelt moet hier ook een roughness_code ingevuld worden. Een voorbeeld van een visuele controle is 

bijvoorbeeld nagaan of een bos inderdaad opgenomen is als een bostype. Er kan ook worden gedacht aan een controle 

of er geen gaten in het bestand zijn ontstaan door een missend vlak of ontbrekende code in landuse_key.csv. Overlap in 

land_use_polygons is ook niet toegestaan. 

 

Ten slotte dient er een metainfo document geschreven te worden. 
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6 DRAAIBOEK OVERIGE 
FEATURECLASSES 

6.1 INLEIDING 

Dit hoofdstuk beschrijft de werkwijze voor het maken van Baseline maatregelen die wijzigingen in de Feature Datasets 

‘Locations’ en /of ‘Models’ aanbrengen. Voor elk van deze Feature Classes wordt in het Baseline 7 Dataprotocol de 

vereiste bestandsopbouw beschreven. 

 

De feature dataset ‘Locations’ bevat de volgende Feature Classes: 

- Bruggen en pijlers (bridge_routes en events); 

- debietraaien (cross_section_lines); 

- uitvoerlocaties (output_location_points); 

- bronnen en putten (sources_sinks_points); 

- kunstwerken (structure_lines). 

 

De feature dataset ‘Models’ bevat de volgende Feature Classes: 

- rivieras (branch_1d_lines); 

- kalibratie polygonen (calibration_section_polygons); 

- kalibratie invoer polygonen (calibration_section_input_polygons); 

- hoogwatervrije lijnen (flow_blocking_lines); 

- hoogwatervrije vlakken (flow_blocking_polygons); 

- secties (section_polygons). 

 

In onderstaande paragrafen wordt per Featureclass achtereenvolgens de definitie, te gebruiken bronnen en een 

workflow beschreven. Omdat deze Featureclasses normaal gesproken bij een actualisatie of in een ontwerp niet 

hoeven te worden aangepast is hier ook niet altijd een standaard werkwijze voor. In dat geval wordt overleg met RWS 

geadviseerd. 

 

NB. De Featureclasses in de Featuredataset Morphology zijn al wel aanwezig in het Baseline datamodel maar worden 

op dit moment nog niet gebruikt. Ze zijn daarom nog niet opgenomen in dit draaiboek. 

 

6.2 LOCATION LAYERS 

6.2.1 BRIDGE_ROUTES EN BRIDGE_EVENTS 

Definitie 

Hiervoor dient er voor elke brug een polyline te worden opgenomen in bridge_routes waarbij de pijlers van de brug op 

de vertices van de lijn liggen en zijn opgenomen in bridge_events. Hierbij geldt dat elke brug een naam en een uniek 

nummer moeten krijgen, hiervoor is een werkafspraak gemaakt binnen Rijkswaterstaat (Memo - Naamgeving 

conventies watermodellen Rijkswaterstaat, Versie 2.0, 21 november 2019). De bridge_events moeten hetzelfde 

nummer krijgen.  
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De default waarde voor de Pillar Diameter is 5 m, de default waarde voor CP is 1. Wanneer mogelijk dient de diameter 

bepaald te worden uit de breedte van de pijler. Hiervoor dient de grootste afstand genomen te worden die de stroom 

blokkeert.  

 

 
Figuur 28 Bepaling van de diameter van een pijler 

De tweede parameter is de CP, de weerstand coëfficiënt, ook wel Cdrag genoemd. De default waarde van 1,0 geeft een 

vloeiende cilindervorm weer. Voor andere coëfficiënten wordt verwezen naar Boschetti et al. (2024)11. In dit rapport 

wordt een relatie gelegd tussen de weerstand coëfficiënt Cdrag en δ0 bij onderstaande pijlervormen uit Reh (1958)12, zie 

Figuur 29.  

 

 
Figuur 29: δ0 waardes van verschillende pijlervormen (Reh, 1959) 

Het gebruik van een niet-default CP waarde is echter alleen toegestaan na overleg met Rijkswaterstaat. Soms is het 

benodigd om dummy-pijlers toe te passen. Dit is het geval wanneer de brug een bocht maakt zonder dat daar een pijler 

onder aanwezig is. Deze bocht introduceert echter wel vertices in Baseline waar een punt op moeten worden 

gedefinieerd. Hetzelfde geldt voor de uiteinden van de brug aansluitend op het landhoofd. Deze dummy-pijlers krijgen 

een diameter van -999 m.   

 

Elke rij pijlers dient een aparte bruglijn te worden, waarbij er een nummer aan de brugnaam wordt toegevoegd, bv. ‘-1’. 

Bruglijnen die te dicht bij elkaar liggen dienen te worden verwijderd, omdat D-Hydro deze dubbel telt. Het criterium 

hiervoor is het rekenrooster van het j-model. Wanneer meerdere in stromingsrichting achter elkaar staande pijlers 

geprojecteerd worden in dezelfde gridcel, dienen de extra pijlers verwijderd te worden. Neem voor de keuze welke 

pijlerrijen wel of niet opgenomen moeten worden contact op met de regionale dienst van RWS. 

 

Bronnen  

 
11 Boschetti, T., W. Ottevanger, and J. van Kester (2024), Inventarisatie mogelijkheden voor toepassing vormfactor bij 

brugpijlers in D-HYDRO, Memo, Deltares, the Netherlands, 11210334-013-ZKS-0001. 
12 Reh, U., 1958. “Vereinfachte Anwendung der Rehbock’schen Brückenstauformel.” Wasserwirtshaft 48. 
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Bestaande brugpijlers zijn opgenomen in DTB. Let hierbij wel op dat soms alleen de delen zijn opgenomen die op een 

luchtfoto zichtbaar zijn omdat ze onder het brugdek uitsteken. In dat geval is het raadplegen van aanvullende bronnen 

(Google Streetview, Cyclomedia) wenselijk.  

Voor een nieuwe brug zal een ontwerptekening als bron moeten dienen. 

 

Workflow 

Bridge_routes en bridge_events worden in Baseline met preparation tool ‘01. Routes & events to lines & points’ 

omgezet naar bridge_lines en bridge_points. Vervolgens kan een bridge line worden gedigitaliseerd of uit een andere 

bron worden gekopieerd. Na het vullen van de attribuut informatie van de bridge_lines kunnen met preparation tool 

‘02a. Position points on bridges’ de pijlers/bridge_points worden gemaakt. Na het eventueel aanpassen van de 

bridge_point parameters (diameter en CP) worden de bridge_lines en bridge_points met tool ’06. Lines & points to 

routes & events’ weer terug gezet naar bridge_routes en bridge_events. 

6.2.2 CROSS_SECTION_LINES 

Definitie 

Debietraaien worden door D-Hydro gebruikt om het cumulatieve debiet dat over de raaien stroomt weg te schrijven. 

De raaien lopen parallel aan de roosterlijnen van het rekenrooster. Meestal lopen ze van de ene rand van het 

watersysteem naar de andere rand en kruisen ze de hele rivierkilometers (output_location_points). Maar er zijn ook 

afwijkende locaties bij bijvoorbeeld splitsingspunten of ze liggen alleen over een specifieke locatie, bijvoorbeeld de 

instroomopening van een nevengeul.  

 

De richting van de debietraai bepaalt het teken van het debiet; een debietraai die van noord naar zuid loopt geeft een 

positief debiet als de stroming naar het westen is gericht.  

 

Bronnen 

Bij bestaande Baseline databases zullen debietraaien niet snel hoeven worden aangepast. Alleen indien een specifieke 

ingreep zoals een nevengeul wordt onderzocht kan het handig zijn om extra debietraaien te definiëren om de 

verandering in stroming over verschillende delen van een uiterwaard inzichtelijk te maken. 

 

Bij een modeluitbreiding dient met RWS te worden afgestemd of er in de uitbreiding aanvullende debietraaien 

benodigd zijn. 

 

Workflow 

Debietraaien worden handmatig aangemaakt door het digitaliseren van een polyline in een edit-sessie in ArcGIS Pro. 

6.2.3 OUTPUT_LOCATION_POINTS 

Definitie 

Uitvoerlocaties worden door D-Hydro gebruikt om allerlei parameters weg te schrijven.  

 

Bronnen 

Bij een modeluitbreiding dient met RWS te worden afgestemd of er in de uitbreiding aanvullende uitvoerlocaties 

benodigd zijn. 

 

Workflow 

Uitvoerlocaties worden handmatig aangemaakt door het digitaliseren van een punt in een edit-sessie in ArcGIS Pro. 
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6.2.4 SOURCE_SINK_POINTS 

Definitie 

Bronnen en putten (sources en sinks) zijn puntlocaties in of op de rand van het model waar een laterale uitwisseling van 

water plaatsvindt. Een bron is een plaats waar water het model instroomt (bijvoorbeeld een beek), een put is een 

plaats waar water uit het model onttrokken wordt (bijvoorbeeld een drinkwaterinnamepunt). 

 

Bronnen 

De locatie van bronnen en putten kan uit verschillende data-bronnen komen; gegevens van Waterschappen of 

drinkwatermaatschappijen maar ook uit vergunningensystemen van bijvoorbeeld lozingen en innames.  

 

Bij een modeluitbreiding dient met RWS te worden afgestemd of er in de uitbreiding aanvullende bronnen en putten 

benodigd zijn. 

 

Workflow 

Bronnen en putten worden handmatig aangemaakt door het digitaliseren van een punt in een edit-sessie in ArcGIS Pro. 

6.2.5 KUNSTWERKEN (STRUCTURE_LINES) 

Definitie 

Kunstwerken (structure_lines) zijn lijnelementen in of op de rand van het model waar water doorstroomt waarbij de 

hoeveelheid gestuurd kan worden, zoals sluizen, stuwen en stormvloedkeringen. 

De richting van de kunstwerk-lijn bepaalt het teken van het debiet; een kunstwerk die van noord naar zuid loopt geeft 

een positief debiet als de stroming naar het westen is gericht.  

 

Bronnen 

De globale locatie van kunstwerken kan uit verschillende data-bronnen komen; DTB is de meest voor de hand liggende.  

 

Bij een modeluitbreiding dient met RWS te worden afgestemd of er in de uitbreiding aanvullende kunstwerken 

benodigd zijn. 

 

Workflow 

Kunstwerken worden handmatig aangemaakt door het digitaliseren van een lijn in een edit-sessie in ArcGIS Pro. 

Let op dat kunstwerken niet overlappen met maar wel aansluiten op elevated_lines_routes en 

terrain_jump_3d_routes. 

De ligging en breedte van het kunstwerk dienen met RWS te worden afgestemd. 

6.3 MODEL LAYERS 

6.3.1 RIVIERAS (BRANCH_1D_LINES) 

Definitie 

De rivieras (branch_1d_lines) geeft de as van de rivier weer.  

 

Bronnen/workflow 

Dit bestand wordt over het algemeen in maatregelen niet aangepast. De werkwijze hiervoor wordt daarom niet 

beschreven in dit draaiboek. Indien aanpassing van de rivieras nodig is, wordt deze aanpassing uitgevoerd in overleg 

met RWS. 
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6.3.2 KALIBRATIE INVOER POLYGONEN 
(CALIBRATION_SECTION_INPUT_POLYGONS) 

Definitie 

Kalibratie van hydraulische modellen vindt plaats door middel van het bepalen van een geschikte kalibratiefactor. Deze 

kalibratiefactor bepaalt samen met de basisruwheid, gebaseerd op de fysische ondergrond, de ruwheid van het 

zomerbed. De kalibratiefactoren worden bepaald per kalibratievlak. 

 

Voor hydraulische en morfologische modellen is het van belang dat er geen abrupte overgangen aanwezig zijn tussen 

ruwheden. De calibration_section_input_polygons geven vlakken weer met een uniforme gekalibreerde ruwheid en 

definiëren de overgang tussen twee of meer aangrenzende vlakken met verschillende gekalibreerde ruwheden. Deze 

featureclass wordt gebruikt om de featureclass calibration_section_polygons te construeren die geleidelijke 

overgangen tussen aangrenzende vlakken met verschillende gekalibreerde ruwheden bevat. Hiervoor is een speciale 

tool in Baseline beschikbaar (create smooth transitions). 

 

Bronnen 

De polygonen in deze featureclass worden met de hand opgesteld. De omtrek komt overeen met het gebied van sectie 

1 en  trajectgrenzen liggen vaak terplekke van meetpunten. Deze featureclass wordt gemaakt als tussenstap bij het 

opstellen van de calibration_section_polygons en maakt daarom geen deel uit van een maatregel. 

 

Bij het maken van maatregelen in een bestaand gebied hoeven de calibration_section_input_polygons over het 

algemeen niet te worden opgesteld. Bij het maken van maatregelen voor nieuwe gebieden hoeven de 

calibration_section_input_polygons alleen te worden afgeleid, indien het een gebied betreft dat gekalibreerd kan 

worden.  

 

Workflow 

De werkwijze voor het opstellen van de polygonen wordt daarom niet beschreven in dit draaiboek. Indien de 

calibration_section_input_polygons moeten worden opgesteld gebeurt dit in overleg met RWS. RWS geeft aan hoe de 

polygonen moeten worden opgedeeld en welke codes gebruikt moeten worden. 

6.3.3 KALIBRATIE POLYGONEN (CALIBRATION_SECTION_POLYGONS) 

Definitie 

Kalibratie van hydraulische modellen vindt plaats door middel van het aanpassen van de ruwheid. Voor hydraulische en 

morfologische modellen is het van belang dat er geen abrupte overgangen aanwezig zijn tussen ruwheden. De 

calibration_section_polygons bevatten daarom een geleidelijke overgang tussen twee aangrenzende trajecten met 

verschillende gekalibreerde ruwheden (Figuur 30). 

 

 
Figuur 30 Principeschets overgang tussen kalibratievlak met waarde f1 (links) en een kalibratievlak met waarde f2 (rechts) in 

calibration_section_polygons 

Bronnen 

De geleidelijke overgang wordt gemaakt met behulp van calibration_section_input_polygons en een speciale tool in 

Baseline (create smooth transitions).  

 

Workflow 
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Bij het maken van maatregelen hoeven de calibration_section_polygons alleen voor nieuwe gebieden te worden 

afgeleid, indien het een gebied betreft dat gekalibreerd kan worden. Bij maatregelen in bestaande gebieden, zoals het 

aanpassen van de ruwheid, of het wijzigen van de hoogteligging, hoeven de kalibratie polygonen niet te worden 

aangepast. Alleen wanneer sectie 1 door een maatregel kleiner wordt, dienen de kalibratie polygonen te worden 

aangepast. Dit is niet het geval wanneer sectie 1 breder wordt door een maatregel.   

 

Omdat de kalibratie polygonen over het algemeen niet hoeven te worden opgesteld of aangepast, wordt de werkwijze 

hiervoor niet beschreven in dit draaiboek. Indien de calibration_section_polygons moeten worden afgeleid gebeurt dit 

in overleg met RWS.  

6.3.4 HOOGWATERVRIJE LIJNEN EN VLAKKEN (FLOW_BLOCKING_LINES, 
FLOW_BLOCKING_POLYGONS) 

Definitie 

Hoogwatervrije lijnen worden gebruikt om bepaalde gebieden van het watersysteem uit te sluiten in hydraulische 

modellen. In het model kan water niet door of over deze lijnen stromen. De lijnen kunnen zowel smalle elementen 

beschrijven die daadwerkelijk niet overstromen, of alleen theoretisch niet mogen overstromen. Hoogwatervrije lijnen 

worden bijvoorbeeld toegepast bij kunstwerken, om af te dwingen dat water niet langs een kunstwerk kan stromen, 

om stroming door gebouwen te blokkeren of om kades niet overstroombaar te maken. De locatie van hoogwatervrije 

lijnen worden niet gebaseerd op een specifieke bron, maar zijn een hulpmiddel voor de modelleur om stroming bij elke 

waterstand te blokkeren.  

 

Hoogwatervrije vlakken worden ook gebruikt om bepaalde gebieden van het watersysteem uit te sluiten in 

hydraulische modellen. In het model kan water niet door deze vlakken stromen. De vlakken kunnen zowel gebieden 

beschrijven die daadwerkelijk niet overstromen, of alleen theoretisch niet mogen overstromen. Hoogwatervrije vlakken 

worden met name toegepast bij concessiegebieden. Op deze locaties is een vergunning afgegeven voor een watervrije 

ophoging. In dat geval is de vergunning met bijbehorende tekeningen de bron voor het hoogwatervrije vlak. 

 

Hoogwatervrije lijnen en hoogwatervrije vlakken hebben dezelfde functie. Een gebied omgeven door hoogwatervrije 

lijnen heeft dezelfde werking als een hoogwatervrij vlak. Hoogwatervrije lijnen worden met name gebruikt voor smalle 

of kleine objecten, die in het hydrodynamische model één cel moeten blokkeren. Zodra polygonen gebruikt worden, 

wordt afhankelijk van de positie van het vlak ten opzichte van het rooster ten minste één cel geblokkeerd.  

 

Bronnen 

De belangrijkste bron voor het opstellen van hoogwatervrije vlakken en lijnen is het Digitaal Topografisch Bestand 

(DTB), dat de hoofdinfrastructuur beschrijft en in beheer is bij Rijkswaterstaat. Het DTB is opgebouwd uit punt-, lijn en 

vlakinformatie.  

 

Workflow 

Figuur 31 toont de workflow voor het aanmaken van een maatregel met hoogwatervrije lijnen en vlakken. In 

onderstaande paragrafen worden de stappen in het diagram verder toegelicht. De nummering van de paragrafen komt 

overeen met de nummering van de stappen in Figuur 31.  
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Figuur 31 Workflow voor opzetten maatregel flow_blocking_polygons en flow_blocking_lines 

1. AANMAKEN NIEUWE BASELINE MAATREGEL 

Gebruik hiervoor de Baseline tool ’00. Create variant/measure’. Houdt bij de naamgeving van de maatregel rekening 

met de naamgevingsconventies van Rijkswaterstaat (zie paragraaf 2.3.1.). 

 

2. SELECTEREN BRONNEN EN IDENTIFICEREN WIJZIGINGEN 

De volgende stap is het selecteren van de bronnen. Informatie over bestaande concessies wordt aangeleverd door 

RWS. Bij bestaande schematisaties is deze informatie opgenomen in de referentie database. Bij ontwerpmaatregelen 

volgt informatie over nieuwe of vervallen concessiegebieden uit het ontwerp van het project.  

 

3. AANMAKEN POLYGONEN EN LIJNEN 

Op basis van de bronnen die zijn geselecteerd in de vorige stap kunnen polygonen en lijnen worden opgesteld op de 

locaties van nieuwe of gewijzigde hoogwatervrije vlakken en lijnen. Rondom hoogwatervrije en vlakken en lijnen die 

komen te vervallen worden polygonen opgesteld.  

 

4. TOEVOEGEN AAN MAATREGEL 

Daarna worden de polygonen en lijnen toegevoegd aan de maatregel. Nieuwe vlakken worden toegevoegd aan de 

Feature Class ‘flow_blocking_polygons’ en nieuwe lijnen aan de Feature Class ‘flow_blocking_lines’. 

 

5. AFRONDEN MAATREGEL 

De volgende stap is het afronden van de maatregel met de Baseline preparation tools 8, 9, 10 en 11. Daarna wordt de 

maatregel gecontroleerd met behulp van de protocol- en contentcheck met behulp van Baseline tool ’13. Check 

variant/measure’ (zie paragraaf 2.3.5). 
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6. UITVOEREN PROEFMIX 

Met het resultaat van de proefmix kan visueel gecontroleerd worden of de hoogwatervrije lijnen en vlakken op de 

juiste locatie in het projectgebied aanwezig zijn (zie paragraaf 2.3.6). 

6.3.5 SECTIES (SECTION_POLYGONS) 

Definitie 

In Baseline wordt het modelgebied in vier delen (secties) onderverdeeld:  

- zomerbed (section = 1); 

- oevers en kribvakken (section = 2); 

- winterbed (section = 3); 

- retentiegebieden (section = 4, t.b.v. SOBEK-modellering). 

 

Het totale modelgebied is opgedeeld in secties. De secties beschrijven het watersysteem in termen van gemiddelde 

overstromingsomstandigheden. De omtrek van alle secties samen is gedefinieerd als de grens van het watersysteem en 

de buitengrens van het hoogtemodel en de hydrodynamische modellen.  

 

In het geval van een rivier ligt de buitengrens van de sectie om het overstroombare gebied. In de meeste gevallen is het 

aangrenzende gebied het winterbed. Deze zone is onder gemiddelde omstandigheden droog en wordt aangeduid als 

sectie 3. De overgangszone van nat naar droog is de oeverzone van het waterlichaam en wordt aangeduid als sectie 2. 

Deze grens is enigszins willekeuring vanwege de dynamiek van het watersysteem. Het zomerbed is onder gemiddelde 

omstandigheden constant overstroomd en wordt aangeduid als sectie 1. In genormaliseerde rivieren is deze sectie 

gedefinieerd tussen vloeiende lijnen over de koppen van de kribben. Als er geen kribben aanwezig zijn, wordt de grens 

gevormd door een vloeiende lijn over de gestrekte oever. Sectie 4 maakt geen deel uit van de Baseline-NL database, 

maar kan voor onderzoeken met SOBEK worden toegevoegd. Sectie 4 wordt alleen gebruikt ten behoeve van SOBEK-

modellen en geeft de locatie van retentiegebieden weer.  

 

Bronnen 

De section_polygons kunnen met behulp van onder andere DTB worden opgesteld: 

- sectie 1 is gebaseerd op een vloeiende lijn over de kribkoppen of de gestrekte oever en beschrijft het gebied waar 

bodemvormen voorkomen. In het geval van veranderingen aan kribben, langsdammen of gestrekte oevers kan 

sectie 1 veranderen;  

- sectie 2 is het gebied tussen sectie 1 en CTE-code W09 (oeverlijn) uit het DTB; 

- sectie 3 is het gebied tussen sectie 2 en CTE-code ZH7 (bovenkant talud) uit het DTB. De buitenste grens van sectie 

3 moet 10 cm buiten deze lijn worden geplaatst om een correcte generatie van het hoogtemodel te waarborgen. 

 

 

Workflow 

Figuur 32 toont de workflow voor het aanmaken van een maatregel met secties. In onderstaande paragrafen worden 

de stappen in het diagram verder toegelicht. De nummering van de paragrafen komt overeen met de nummering van 

de stappen in Figuur 32. Denk er aan dat bij een gebiedsuitbreiding (zoals bijvoorbeeld een dijkteruglegging) ook de 

Baseline clip featureclasses en modelboundaries moeten worden aangepast (hoofdstuk 7). 
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Figuur 32 Workflow voor opzetten maatregel section_polygons 

1. AANMAKEN NIEUWE BASELINE MAATREGEL 

Gebruik hiervoor de Baseline tool ’00. Create variant/measure’. Houdt bij de naamgeving van de maatregel rekening 

met de naamgevingsconventies van Rijkswaterstaat (zie paragraaf 2.3.1.). 

 

2. SELECTEREN BRONNEN EN IDENTIFICEREN WIJZIGINGEN 

Bij het opzetten van schematisaties van nieuwe gebieden kan gebruik gemaakt worden van het DTB. CTE-code W08 

(oeverlijn) vormt de grens tussen sectie 2 en sectie 3. CTE-code ZH7 (talud bovenkant) vormt de buitengrens van sectie 

3. De sectie 1 grens is gedefinieerd als een vloeiende lijn over de kribkoppen, langsdammen of gestrekte oever. Deze 

lijn is niet in het DTB aanwezig en moet handmatig geconstrueerd worden. 

 

Bij het opstellen van een ontwerpmaatregelen kunnen wijzigingen aan de secties worden afgeleid uit het ontwerp van 

het project. 

 

3. AANMAKEN POLYGONEN  

De volgende stap is het aanmaken van de nieuwe en de te verwijderen delen van polygonen. Naast elkaar gelegen 

polygonen moeten exact op elkaar aansluiten, omdat er anders kleine gaten kunnen ontstaan die leiden tot 

stromingsblokkering (een gat in het sectiebestand resulteert in een gat in het model_area_polygon).    

 

4. TOEVOEGEN AAN MAATREGEL 

De polygonen worden vervolgens toegevoegd aan de maatregel. Nieuwe vlakken worden toegevoegd aan de Feature 

Class ‘section_polygons’. Vlakken die te verwijderen delen van het sectiebestand beschrijven, worden toegevoegd aan 

de Feature Class ‘erase_section_polygons’. 
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5. AFRONDEN MAATREGEL 

De volgende stap is het afronden van de maatregel met de Baseline preparation tools 8, 9, 10 en 11. Daarna wordt de 

maatregel gecontroleerd met behulp van de protocol- en contentcheck met behulp van Baseline tool ’13. Check 

variant/measure’ (zie paragraaf 2.3.5). 

 

6. WIJZIGEN CALIBRATION_SECTION_POLYGONS 

Als sectie 1 smaller wordt, bijvoorbeeld wanneer kribben verlengd worden, moet ook de feature class 

calibration_section_polygons worden aangepast. Deze aanpassing vindt plaats in overleg met RWS. Wanneer sectie 1 

breder wordt, bijvoorbeeld in het geval van zomerbedverbreding, hoeven de calibration_section_polygons niet te 

worden aangepast. Wel dient dan de ruwheid aangepast te worden naar de daar geldende zomerbedruwheid (zie 

hoofdstuk over de ruwheden). 

 

7. UITVOEREN PROEFMIX 

Met het resultaat van de proefmix kan visueel gecontroleerd worden of de secties op de juiste locatie in het 

projectgebied aanwezig zijn (zie paragraaf 2.3.6). Belangrijk is om te controleren of er geen ongewilde gaten tussen de 

sectie polygonen aanwezig zijn. Deze gaten zijn toegestaan, maar zullen ook resulteren in een gat in het 

model_area_polygon en het hoogtemodel. 
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7 DRAAIBOEK BASELINE CLIP-
BESTANDEN EN MODEL-
BOUNDARIES 

 

7.1 INLEIDING 

Het draaiboek Baseline clip featureclasses en modelboundaries is alleen benodigd in het geval van 

gebiedsuitbreidingen. Dit kan zijn bij bijvoorbeeld een dijkteruglegging (landwaartse dijkverlegging) of wanneer er een 

nieuw watersysteem wordt toegevoegd aan Baseline-NL. 

 

Deltares/RWS beheren buiten Baseline filegeodatabases met daarin zogenaamde Baseline clip contouren en model 

boundaries, bijvoorbeeld Clipcontour_modelbound_j19_6-v2.gdb. In onderstaande paragrafen wordt beschreven hoe 

die zijn opgebouwd. 

 

7.2 BASELINE CLIP-CONTOUREN 

Definitie 

Baseline clip contouren worden gebruikt om vanuit de landelijke Baseline database Baseline-NL regionale uitsnedes te 

maken van watersystemen/modelgebieden met behulp van de Clip functie in de Baseline ribbon. 

De Baseline clip contour is een afgeleide van Baseline featureclass sections. Het bestand beschrijft een polygoon die 

200 meter ruimer is dan het Baseline sections_polygons bestand. Aan de boven- en benedenstroomse zijde van een 

watersysteem ligt de clip contour eveneens 200 meter ruimer dan de boven- of beneden-rand van het watersysteem. In 

geval van zee-randen liggen de clipcontouren 200 meter ruimer dan het gehanteerde model rooster. 

Er wordt een buffer van 200 meter gehanteerd rondom een modelgebied zodat de uiteindelijk geclipte Baseline 

database altijd wat ruimer is dan het bijbehorende modelgebied. Hiermee worden eventuele problemen (van 

bijvoorbeeld de hoogtes bij een bovenstroomse open modelrand) op de rand van het uiteindelijke model voorkomen. 

 

Bronnen 

Baseline featureclass section_polygons.  

 

Workflow 

In geval van een gebiedsvergroting in een regionaal model kan het sections_polygon bestand van de variant waarin de 

gebiedsvergroting is opgenomen worden gekopieerd naar de Clipcontour_modelbound_jXX_6-vX.gdb. Dit bestand 

wordt vervolgens via een dissolve omgezet naar één omhullende polygoon. Deze omhullende wordt gebufferd met 200 

meter. Resultaat is de nieuwe Baseline clip contour inclusief de gebiedsvergroting. 

 

7.3 MODEL-BOUNDARIES 

Definitie 
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Model boundaries zijn polygonen die worden gebruikt bij de conversie naar D-Flow FM. Daar waar een Baseline clip 

contour iets ruimer ligt dan het daadwerkelijk gewenste model is de model boundary een zo exact mogelijke 

beschrijving van het modelgebied. De conversie naar D-Flow FM schrijft alle Baseline informatie die binnen de model 

boundary ligt of die de modelboundary kruist weg naar D-Hydro bestanden.  

 

Model boundaries voldoen aan de volgende criteria 

 

• Zijdelings liggen een modelboundary 5 cm landwaarts van de buitengens van sections_polygons. 

• Van kunstwerken die aan de rand van een model liggen is het niet wenselijk dat de informatie in D-Hydro 

terecht komt. Daarom ligt de model boundary hier 10 cm rivierwaarts van het kunstwerk. 

• Bij een open modelrand ligt de model boundary exact over de rand van het model rooster. 

 

Bronnen 

• Baseline featureclass section_polygons 

• Baseline featureclass sructures_lines  

• Model rooster 

 

Workflow 

1. In geval van een gebiedsvergroting in een regionaal model kan het sections_polygon bestand van de variant 

waarin de gebiedsvergroting is opgenomen worden gekopieerd naar de Clipcontour_modelbound_jXX_6-

vX.gdb.  

2. Dit bestand wordt vervolgens via een dissolve omgezet naar één omhullende polygoon.  

3. Deze omhullende wordt gebufferd met 5 centimeter. 

4. Selecteer in de variant alle kunstwerken die op de modelrand liggen en die je niet in je model wilt opnemen. 

5. Buffer deze geselecteerde kunstwerken met 10 centimeter (both sides, square ends) en zet deze in een nieuwe 

Featureclass. 

6. Erase de omhullende uit stap 3 met de gebufferde kunstwerken uit stap 5. 

7. Snijdt de resulterende polygoon handmatig af op de open randen met behulp van het rooster (de featureclass 

faces_fm in een rooster.gdb die je maakt met de baseline functie ‘NetCDF to Bas2Fm input’. 

8. Resultaat is de nieuwe model boundary inclusief de gebiedsvergroting. 
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OVERZICHT BIJLAGE(N) 
Bijlage 1 

— Naamgeving RWS Gebieden 

Bijlage 2 

— Sjabloon metadata 

Bijlage 3 

— Conversiesleutel 
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1 NAAMGEVING RWS 
GEBIEDEN 

  

BIJLAGE 
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Nadere indeling Naam watersysteem Afkorting 

2- 

letterig 

  
 

Zeeuwse Delta Kanaal van Gent naar Terneuzen KG 

Zeeuwse Delta Schelde-Rijnkanaal SR 

Schelde-Estuarium Boven ZeeSchelde SO 

Schelde-Estuarium Beneden ZeeSchelde SE 

Schelde-Estuarium- Rivier Durne DU 

Schelde-Estuarium- Rivier Grote Nete NE 

Schelde-Estuarium- Rivier Nete NT 

Schelde-Estuarium- Rivier Rupel RP 

Schelde-Estuarium- Rivier Kleine Nete KL 

Schelde-Estuarium- Rivier Dijle DL 

Schelde-Estuarium- Rivier Zenne ZN 

Zeeuwse Delta Westerschelde WS  

Zeeuwse Delta Volkerak VO  

Zeeuwse Delta Zoommeer ZO 

Zeeuwse Delta Bathse Spuikanaal BT 

Zeeuwse Delta Rammegors RG 

Zeeuwse Delta Eendracht ER 

Zeeuwse Delta Oosterschelde OS  

Zeeuwse Delta Kanaal door Zuid-Beveland KB 

Zeeuwse Delta Veerse Meer VM  

Zeeuwse Delta Grevelingenmeer GR 

Benedenrivieren, Rijnmaas monding Biesbosch Brabant BB 

Benedenrivieren, Rijnmaas monding Biesbosch Dordt BD 

Brabantse Biesbosch Gat van Kampen GK 

Brabantse Biesbosch Midgatvanhetzand MZ 

Maas Rur RU 

Belgische Maas Meuse ME 

Benedenrivieren, Rijnmaas monding Amertak AT 

Maas Maas MA  

Maas Bergsche Maas BM  

Benedenrivieren, Rijnmaas monding Amer AM  

Maaskanalen Julianakanaal JK 

Maaskanalen Lateraalkanaal Linne-Buggenum LA 

Maas Roer RO 

Maaskanalen Maas-Waalkanaal MW 

Maas Afgedamde Maas AF  

Maas Heusdensch Kanaal HU 

Benedenrivieren, Rijnmaas monding Oude Maasje OJ 

Benedenrivieren, Rijnmaas monding Donge DO 

Benedenrivieren, Rijnmaas monding Steurgat SG 

Brabantse Biesbosch Spijkerboor SB 

Benedenrivieren, Rijnmaas monding Bakkerskil BA 

Brabantse Biesbosch Ruigt RG 

Brabantse Biesbosch Gat van de Noorderklip GN 

Brabantse Biesbosch Zuidergat van de Visschen ZG 

Brabantse Biesbosch Gat van Hardenhoek GH 

Brabantse Biesbosch Gat van Den Kleinen Hil GL 

Brabantse Biesbosch Noordergat van de Visschen NG 

Middenlimburgse- en Noord-Brabantse kanalen Zuid-Willemsvaart ZV 

Middenlimburgse- en Noord-Brabantse kanalen Kanaal Wessem-Nederweert KW 

Middenlimburgse- en Noord-Brabantse kanalen Noordervaart NV 

Middenlimburgse- en Noord-Brabantse kanalen Maximakanaal MX 

Middenlimburgse- en Noord-Brabantse kanalen Beatrixkanaal BX 

Middenlimburgse- en Noord-Brabantse kanalen Wilhelminakanaal WK 

Benedenrivieren, Rijnmaas monding Breeddiep BP 
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Benedenrivieren, Rijnmaas monding Biesbosch Sliedrecht BS 

Benedenrivieren, Rijnmaas monding Koningshaven KV 

Benedenrivieren, Rijnmaas monding Nijlhaven NH 

Benedenrivieren, Rijnmaas monding Rietbaan RB 

Benedenrivieren, Rijnmaas monding Sliksloot SL 

Benedenrivieren, Rijnmaas monding Zuiddiepje ZD 

Benedenrivieren, Rijnmaas monding Zuid Hollandsch Diep ZH 

Duitse Rijn Rhein DR 

Duitse Vecht Vechte DV 

Rijntakken Keteldiep KE  

Rijntakken Kattendiep KT  

Rijntakken Rijntakken RT 

 Kanaal van Sint Andries KS 

Duitse Rijn Rhein RH 

Rijntakken Boven-Rijn  BR  

Benedenrivieren, Rijnmaas monding Boven-Merwede BO  

Benedenrivieren, Rijnmaas monding Nieuwe Merwede NI  

Benedenrivieren, Rijnmaas monding Hollandsch Diep HD  

Benedenrivieren, Rijnmaas monding Haringvliet HV  

Benedenrivieren, Rijnmaas monding Vuile Gat VG 

Benedenrivieren, Rijnmaas monding Beneden-Merwede BE  

Benedenrivieren, Rijnmaas monding Oude Maas OM  

Benedenrivieren, Rijnmaas monding Wantij WT 

Benedenrivieren, Rijnmaas monding Noord NO  

Benedenrivieren, Rijnmaas monding Dordtsche Kil DK  

Benedenrivieren, Rijnmaas monding Spui SP 

Benedenrivieren, Rijnmaas monding Hartelkanaal HK 

Benedenrivieren, Rijnmaas monding Beerkanaal BK 

Benedenrivieren, Rijnmaas monding Calandkanaal CK 

Rijntakken Pannerdensch Kanaal PK  

Rijntakken Neder-Rijn NR  

Rijntakken Lek LE  

Benedenrivieren, Rijnmaas monding Nieuwe Maas NM  

Benedenrivieren, Rijnmaas monding Scheur SC 

Benedenrivieren, Rijnmaas monding Nieuwe Waterweg NW  

Benedenrivieren, Rijnmaas monding Hollandsche IJssel HY  

Rijntakken Ijssel IJ  

Rijntakken Veessen-Wapenveld VW 

 Ketelmeer KM  

Ijsselmeer Ijsselmeer YM  

Rijntakken Waal WL  

Rijntakken Reevediep RD 

 Vossemeer VS 

Veluwerandmeren Drontermeer DM  

Veluwerandmeren Veluwemeer VE  

Veluwerandmeren Wolderwijd WW 

Veluwerandmeren Nuldernauw NU 

Markermeer Eem EE 

Markermeer Nijkerkernauw NN 

Markermeer Eemmeer EM  

Markermeer Gooimeer GM 

Markermeer Ijmeer YR  

Markermeer Markermeer MM  

Duitse Vecht Vechte VT 

Vecht Overijsselsche Vecht OV  

Zwarte Water Zwarte Water ZW  

Zwarte Meer Zwarte Meer ZM 

 Zwolle-Ijsselkanaal ZK 
 Meppelerdiep MD 
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 Twentekanalen TK 

 Amsterdam-Rijnkanaal AR 

 Noordzeekanaal NK 

 Lekkanaal LK 

 Merwedekanaal MK 

 Lauwersmeer LM 

Duits Eems stroomgebied Eems ES 

Duits Eems stroomgebied Leda LD 

Duits Eems stroomgebied Jumme JU 

Waddenzee  Eems-Dollard ED 

Zuidwestelijke Delta, Kust Vlaanderen Kust Vlaanderen KU 

 Zeeuwse Kust KZ 

 Noordelijke Deltakust KN 

 Hollandse Kust KH 

 Waddenkust KA 

 Eems-Dollard Kust KD 

Noordzee  Ijmond YD 

Waddenzee  Waddenzee WZ 

Noordzee  Noordzee NZ 

 
  

Middenlimburgse- en Noord-Brabantse kanalen Markkanaal  
Hoofdvaarweg Lemmer Delfzijl Lemmer Delfzijl  
Hoofdvaarweg Lemmer-Delfzijl Prinses Margrietkanaal  
Hoofdvaarweg Lemmer-Delfzijl Eemskanaal  
Hoofdvaarweg Lemmer-Delfzijl Van Starkenborghkanaal  
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Metadata voor maatregel: <maatregelnaam> 

 
 
 

Beschrijving van de dataset 

 Wijzigingsbestanden van .... langs <de / het> <Riviertak> ter hoogte van km-raai      . 

 

Samenvatting 

 ..... 

 

Doel van vervaardiging 

 Jaarlijkse actualisatie en verbetering van de Baseline database (cyclus 2023). 

 

Producent van de dataset 

 <Naam van de dienst of het bureau>. 

 

Inhoudelijk contactpersoon 

 <AFDELING>: <Naam>. 
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Type bestand 

 File geodatabase voor gebruik met de “Assimilate Measures” in Baseline. Meegeleverde 
bestanden: 

  Gebruikte bronbestanden (data\source). 

  Aanvulling roughness_code (models\dflowfm). 

 

Karakteristieken en toepasssingseisen 

 Maatregel is gebaseerd op: <Naam referentieschematisatie>. 

 Ingemixte maatregelen: n.v.t. 

 Draaiboek:   Versie <versienummer> 

   N.v.t. 

 Baseline-protocol:  Protocol 7 

 Vegetatiecodering:  Handboek stromingsweerstand 

   Vegetatielegger 

   N.v.t. 

 Geschikt voor conversie naar:  D-Flow FM 
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Dataset herkomst 

 Elevation - lines  

  Elevated_line ➢ N.v.t. 

  Terrain_edge_3d_lines ➢ N.v.t. 

  Terrain_jump_3d_lines ➢ N.v.t. 

 Elevation - points  

  Bedlevel_points ➢ N.v.t. 

  Surfacelevel_points ➢ N.v.t. 

  Waterbody_level_points ➢ N.v.t. 

 Locations  

  Bridge ➢ N.v.t. 

  Cross_section_lines ➢ N.v.t 

  Output_location_points ➢ N.v.t 

  Source_sink_points ➢ N.v.t 

  Structure_lines ➢ N.v.t 

 Metadata  

  Measure_contour_polygons ➢ N.v.t. 

 Models  

  Branch_1d_lines ➢ N.v.t. 

  Calibration_section_polygons ➢ N.v.t. 

  Calibration_section_input_polygons ➢ N.v.t. 

  Flow_blocking_lines ➢ N.v.t. 

  Flow_blocking_polygons ➢ N.v.t. 

  Section_polygons ➢ N.v.t. 

 Morphology  

  D50_points ➢ N.v.t. 

  Dredging_polygons ➢ N.v.t. 

  Suppletion_polygons ➢ N.v.t. 

  Bed_characteristics_polygons ➢ N.v.t. 

  Bed_characteristics_input_polygons ➢ N.v.t. 

 Roughness  

  Land_use_points ➢ N.v.t. 

  Land_use_lines ➢ N.v.t. 

  Land_use_polygons ➢ N.v.t. 
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Opmerkingen 

 1) Geen. 

 
 
 

Kaart was / wordt 
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3 CONVERSIESLEUTEL 
  

 

BIJLAGE 
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# sleutel.asc. 

# 

# CSO, 25-6-2013 

# Uitgebreid met codes voor Zeeuwse Delta: ZES (Oosterschelde en Westerschelde) + AGI 2006 (Grevelingen en Veerse 

Meer) 

# 

# LievenseCSO, 12-3-2015 

# Uitgebreid met codes voor Meren naar aanleiding van opname ecotopen 2012. 

# 

# Lievense, 2019 

# Uitgebreid met nieuwe codes uit nieuwe en andere ecotopenkarteringen. 

 

# The first uncommented line should contain the fieldnames for ecotoopcode and ruwheidscode. 

# Empty lines will be skipped. 

 

# De volgende lijst met codes is de vorige versie van sleutel.asc inclusief nieuwe codes uit de ecotopenkartering. 

ecotoopcode,ruwheidscode 

 

GbD , 102 

GbM , 102 

GbO , 102 

GbZx , 102 

GoD , 102 

GoM , 102 

GoO , 102 

GoX , 102 

GoZx , 102 

GzD , 102 

GzDk , 104 

GzH , 106 

GzM , 102 

GzMk , 104 

GzO , 102 

GzOk , 104 

GzXa , 106 

GzXv , 106 

GzZx , 102 

HA-1 , 121 

HA-2 , 114 

HB-1 , 1244 

HB-2 , 1233 

HB-3 , 1242 

HB-4 , 1247 

HB-5 , 1246 

HG-1 , 1202 

HG-1-2 , 1202 

HG-2 , 1201 

HM-1 , 1807 

HP-1 , 1250 

HR-1 , 1212 

I.1 , 106 

I.3/IV.3 , 106 
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I.5 , 106 

II.2 , 111 

II.2-3 , 111 

II.4-5 , 111 

III.2-3 , 113 

III.2-4 , 113 

III.2-4/HA-2 , 113 

III.5 , 113 

III.8 , 113 

IV.1 , 1807 

IV.11 , 1807 

IV.1-2-6-8-9 , 1807 

IV.3 , 1224 

IV.8-9 , 1807 

IX.a , 121 

MzD , 106 

MzM , 106 

MzO , 106 

MzZ , 302 

O-UA-1 , 121 

O-UA-2 , 114 

O-UB-1 , 1245 

O-UB-2 , 1231 

O-UB-3 , 1242 

O-UB-4 , 1247 

O-UG-1 , 1202 

O-UG-1-2 , 1202 

O-UG-2 , 1201 

O-UK-1 , 1250 

O-UP-1 , 1250 

O-UR-1 , 1212 

REST-H , 1250 

REST-O , 1250 

REST-O-U , 1250 

REST-U , 1250 

RnD , 105 

RnM , 105 

RnO , 105 

RtD , 105 

RtM , 105 

RtO , 105 

RvD , 106 

RvM , 106 

RvO , 106 

RwD , 106 

RwM , 106 

RwO , 106 

RzD , 102 

RzM , 102 

RzO , 102 

UA-1 , 121 

UA-2 , 114 
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UB-1 , 1245 

UB-2 , 1231 

UB-3 , 1242 

UB-4 , 1247 

UB-5 , 1246 

UG-1 , 1202 

UG-1-2 , 1202 

UG-2 , 1201 

UM-1 , 1807 

UP-1 , 1250 

UR-1 , 1212 

V.1-2 , 1804 

V.1-2-3-4 , 1804 

V.1-2-3-4/HR-1 , 1804 

VI.2 , 1231 

VI.2/HB-2 , 1231 

VI.2-3 , 1231 

VI.4 , 1245 

VI.5 , 1242 

VI.5-6/HB-1 , 1245 

VI.6 , 1242 

VI.7 , 1232 

VI.8 , 1242 

VI.8/HB-3 , 1242 

VI.9 , 1247 

VII.1 , 1202 

VII.1-2 , 1202 

VII.1-2/HG-1 , 1202 

VII.1-2-3 , 1202 

VII.1-2-3/HG-1-2 , 1202 

VII.1-3 , 1202 

VII.3 , 1201 

VII.3/HG-2 , 1201 

VII.4 , 1250 

VII.4/HP-1 , 1250 

GbX , 102 

GbXa , 106 

GbXv , 106 

GzX , 102 

GzXk , 104 

Rv/wX , 106 

RvX , 106 

RwX , 106 

I.3 , 106 

I.4/IV.5 , 106 

II.1 , 111 

O-UB-5 , 1246 

RZd-1 , 102 

RZo-1 , 111 

RZo-2 , 111 

RZo-3 , 111 

RZs-1 , 111 
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RZs-2 , 111 

RZs-3 , 106 

RZs-4 , 1805 

RZs-5 , 112 

RZs-6 , 113 

ROb-1 , 1244 

ROb-2 , 1233 

ROb-3 , 1245 

ROb-4 , 1231 

ROb-5 , 1242 

ROb-5h , 1241 

ROb-5z , 1242 

ROr-1 , 1250 

ROr-2 , 1212 

ROr-2a , 1211 

ROr-2r , 1212 

ROr-3 , 121 

ROr-4 , 114 

ROr-4b , 114 

ROr-4v , 114 

ROg-1 , 1202 

ROg-2 , 1202 

ROg-3 , 1201 

ROh-1 , 1202 

ROh-2 , 1201 

ROh-3 , 121 

ROk-1 , 1250 

RUb-1 , 1244 

RUb-2 , 1233 

RUb-3 , 1245 

RUb-4 , 1231 

RUb-5 , 1241 

RUb-6 , 1242 

RUr-1 , 1212 

RUr-2 , 1211 

RUr-3 , 121 

RUr-4 , 114 

RUr-4b , 114 

RUr-4v , 114 

RUg-1 , 1202 

RUg-2 , 1202 

RUg-3 , 1201 

RUh-2 , 1201 

RUh-3 , 121 

RUk-1 , 1250 

RMb-1 , 1244 

RMb-2 , 1245 

RMb-3 , 1231 

RMb-4 , 1231 

RMr-1 , 1804 

RMr-2 , 1807 

RMr-3 , 1801 
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RMg-1 , 1202 

RMg-2 , 1201 

RMg-3 , 1202 

RWn-1 , 105 

RWn-2 , 104 

RWn-3 , 104 

RWs-1 , 104 

RWs-2 , 104 

RWs-3 , 104 

RWs-4 , 104 

RWs-5 , 104 

RWp-1 , 106 

RWp-2 , 106 

RWp-3 , 106 

RWp-4 , 106 

RHb-1 , 1244 

RHb-1h , 1244 

RHb-1z , 1245 

RHb-2 , 1233 

RHb-2h , 1233 

RHb-2z , 1231 

RHb-3 , 1242 

RHb-3h , 1241 

RHb-3z , 1242 

RHr-1 , 1212 

RHr-1a , 1211 

RHr-1r , 1212 

RHr-2 , 121 

RHr-3 , 114 

RHr-3b , 114 

RHr-3v , 114 

RHg-1 , 1202 

RHg-2 , 1202 

RHg-3 , 1201 

RHh-1 , 1202 

RHh-2 , 1201 

RHh-3 , 121 

RHk-1 , 1250 

MZn-0 , 302 

MZn-1 , 302 

MZn-2 , 302 

MZw-2 , 302 

MZz-0 , 302 

MZz-1 , 302 

MZz-2 , 302 

MDn-0 , 302 

MDn-1 , 302 

MDn-2 , 302 

MDw-0 , 302 

MDw-1 , 302 

MDz , 302 

MDz-0 , 302 
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MDz-1 , 302 

MDz-2 , 302 

MMn-0 , 302 

MMn-1 , 302 

MMn-2 , 302 

MMw-0 , 302 

MMw-1 , 302 

MMw-2 , 302 

MMz , 302 

MMz-0 , 302 

MMz-1 , 302 

MMz-2 , 302 

MMz-3 , 106 

MNw-2 , 303 

MNz , 302 

MOh-1 , 1806 

MOh-4 , 1807 

MOn-0 , 303 

MOn-1 , 303 

MOn-2 , 303 

MOw-0 , 303 

MOw-1 , 303 

MOw-2 , 303 

MOz , 303 

MOz-0 , 303 

MOz-1 , 303 

MOz-2 , 303 

MLk-1 , 111 

MLk-1f , 1250 

MLk-1m/b , 1250 

MLK-2 , 113 

MLk-2b , 113 

MLk-2v , 113 

MLr-1 , 1805 

MLr-2 , 1804 

MLr-2f , 1804 

MLr-2m/b , 1804 

MLr-3 , 1807 

MLr-4 , 1807 

MLr-5 , 121 

MLg-1 , 1202 

MLg-2 , 1202 

MLg-3 , 1201 

MLb-1 , 1231 

MLb-2 , 1245 

MNb-1 , 1231 

MNb-2 , 1245 

MNb-3 , 1242 

MNg-1 , 1202 

MNg-3 , 1201 

MNh-4 , 1807 

MNk-1 , 1250 
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MNk-2 , 114 

MNr-2 , 1212 

MNr-3 , 1807 

MH#k-1 , 1250 

MH#k-2b , 114 

MH#k-2v , 114 

MHk-1 , 1250 

MHk-1f , 1250 

MHk-1m/b , 1250 

MHk-2 , 114 

MHk-2b , 114 

MHk-2v , 114 

MH#r-0 , 1805 

MH#r-1 , 1212 

MH#r-2 , 1807 

MH#r-3 , 1807 

MH#r-4 , 121 

MHr-1 , 1212 

MHr-1f , 1203 

MHr-1m/b , 1203 

MHr-2 , 1807 

MHr-3 , 1807 

MHr-4 , 121 

MH#g-1 , 1202 

MH#g-2 , 1202 

MH#g-3 , 1201 

MHg-1 , 1202 

MHg-2 , 1202 

MHg-3 , 1201 

MH#b-1 , 1233 

MH#b-2 , 1244 

MH#b-3 , 1242 

MHb-1 , 1233 

MHb-2 , 1244 

MHb-3 , 1242 

BNn-1 , 304 

BZn-1 , 304 

BBz-2 , 304 

BBz-2b , 304 

BBz-3 , 304 

BBz-3b , 304 

BBz-6 , 304 

BDn-1 , 304 

BDn-3 , 304 

BMn-1 , 304 

BMn-3 , 304 

BMn-5 , 106 

BMn-6 , 106 

BOn-1 , 305 

BOn-2 , 305 

BOn-3 , 305 

BSh-1 , 113 
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BSn-1 , 111 

BSn-4 , 1250 

BBs-2 , 111 

BBs-2a , 1250 

BBs-3 , 106 

BBs-3a , 1250 

BBs-5 , 112 

BBs-6 , 113 

BKr-0 , 1805 

BKr-1 , 1804 

BKr-2 , 1807 

BKr-2a , 1807 

BKr-2b , 1807 

BKr-3 , 121 

BKr-4 , 114 

BKb-2 , 1245 

BKb-6 , 1232 

BKg-1 , 1202 

BKg-3 , 1201 

BKk-1 , 1250 

BGr-1 , 1212 

BGr-2 , 121 

BGr-3 , 114 

BGb-3 , 1245 

BGb-6 , 1232 

BGg-0 , 1202 

BGg-1 , 1202 

BGg-3 , 1201 

BGk-1 , 1250 

BOr-1 , 1250 

BHb-1 , 1233 

BHb-2 , 1244 

BHb-3 , 1242 

BNb-1 , 1231 

BNb-2 , 1245 

BNb-3 , 1242 

BHr-1 , 1212 

BHr-2 , 121 

BHr-3 , 114 

BNr-1 , 1212 

BNr-2 , 121 

BNr-3 , 114 

BHg-1 , 1202 

BHg-3 , 1201 

BNg-1 , 1202 

BNg-3 , 1201 

BHk-1 , 1250 

BNk-1 , 1250 

LGN4_1 , 1201 

LGN4_2 , 121 

LGN4_3 , 121 

LGN4_4 , 121 
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LGN4_5 , 121 

LGN4_6 , 121 

LGN4_8 , 114 

LGN4_9 , 1246 

LGN4_10 , 121 

LGN4_11 , 1244 

LGN4_12 , 1243 

LGN4_16 , 106 

LGN4_17 , 106 

LGN4_18 , 114 

LGN4_19 , 114 

LGN4_20 , 1244 

LGN4_21 , 1243 

LGN4_22 , 114 

LGN4_23 , 1201 

LGN4_24 , 1250 

LGN4_25 , 116 

LGN4_26 , 114 

LGN4_30 , 1303 

LGN4_31 , 1250 

LGN4_32 , 1203 

LGN4_33 , 1212 

LGN4_34 , 1212 

LGN4_35 , 1250 

LGN4_36 , 1212 

LGN4_37 , 1212 

LGN4_38 , 1212 

LGN4_39 , 1203 

LGN4_40 , 1245 

LGN4_41 , 1801 

LGN4_42 , 1807 

LGN4_43 , 1245 

LGN4_44 , 1202 

LGN4_45 , 1212 

LGN4_46 , 1250 

ATK_2111 , 115 

ATK_2112 , 115 

ATK_2113 , 115 

ATK_2114 , 115 

ATK_2121 , 115 

ATK_2122 , 114 

ATK_2123 , 115 

ATK_2126 , 115 

ATK_2127 , 115 

ATK_2129 , 115 

ATK_2132 , 115 

ATK_2133 , 115 

ATK_2134 , 115 

ATK_2135 , 115 

ATK_2201 , 114 

ATK_2202 , 1820 

ATK_2213 , 114 
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ATK_2221 , 115 

ATK_2222 , 116 

ATK_2223 , 115 

ATK_2224 , 114 

ATK_2227 , 1820 

ATK_2228 , 1821 

ATK_2230 , 1821 

ATK_2301 , 114 

ATK_2302 , 114 

ATK_2314 , 106 

ATK_2345 , 106 

ATK_3103 , 116 

ATK_3204 , 116 

ATK_3301 , 1201 

ATK_3302 , 1201 

ATK_3401 , 106 

ATK_3402 , 106 

ATK_3501 , 114 

ATK_3502 , 114 

ATK_3511 , 115 

ATK_3514 , 116 

ATK_4101 , 121 

ATK_4102 , 1201 

ATK_4103 , 1822 

ATK_4104 , 1212 

ATK_4105 , 1802 

ATK_4106 , 1804 

ATK_4107 , 1244 

ATK_4108 , 1823 

ATK_4109 , 1246 

ATK_4110 , 1212 

ATK_4111 , 1801 

ATK_4120 , 111 

ATK_4199 , 101 

ATK_5101 , 102 

ATK_5102 , 106 

ATK_5103 , 106 

ATK_5105 , 106 

ATK_5112 , 106 

ATK_5202 , 113 

ATK_5302 , 116 

ATK_5303 , 116 

ATK_5304 , 106 

B2.122x , 102 

Z2.122x , 102 

B2.223f , 106 

Z2.223f , 106 

B2.223s , 106 

Z2.223s , 106 

B2.221f , 106 

Z2.221f , 106 

B2.221s , 106 
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Z2.221s , 106 

B1.2x1 , 113 

B1.2x2 , 113 

Z1.2x1 , 113 

Z1.2x2 , 113 

B2.21f , 102 

Z2.21f , 102 

B2.222f , 106 

Z2.222f , 106 

B2.222s , 106 

Z2.222s , 106 

B2.123x , 102 

Z2.123x , 102 

B2.11x , 102 

Z2.11x , 102 

B1.3 , 113 

Z1.3 , 113 

B2.3x , 111 

Z2.3x , 111 

B2.31x , 1250 

Z2.31x , 1250 

B2.321 , 1250 

B2.32x , 1804 

Overig , 0 

Z2.321 , 1250 

Z2.32x , 1804 

a , 114 

b1 , 1245 

b2 , 1242 

b4 , 1231 

g1 , 1201 

g2 , 1202 

g3 , 121 

g4 , 1224 

g5 , 1807 

g6 , 1212 

k4 , 111 

m , 102 

o3 , 106 

p1 , 1250 

r , 1250 

t2 , 104 

t3 , 106 

z , 0 

V1.2x2h , 113 

Z1.2x2h , 113 

V1.3x2h , 113 

Z1.3x2h , 113 

V1.2x1 , 113 

V2.21f , 106 

V2.11x , 102 

V2.31x , 1250 
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V2.223f , 106 

V2.221f , 106 

V2.222f , 106 

V2.223s , 106 

V2.221s , 106 

V2.222s , 106 

V2.122x , 102 

V2.123x , 102 

V2.320 , 1250 

Z2.320 , 1250 

V2.x21 , 1250 

Z2.x21 , 1250 

V2.x22 , 1804 

Z2.x22 , 1804 

LGN5_1 , 1201 

LGN5_2 , 121 

LGN5_3 , 121 

LGN5_4 , 121 

LGN5_5 , 121 

LGN5_6 , 121 

LGN5_8 , 114 

LGN5_9 , 1246 

LGN5_10 , 121 

LGN5_11 , 1244 

LGN5_12 , 1243 

LGN5_16 , 106 

LGN5_17 , 106 

LGN5_18 , 114 

LGN5_19 , 114 

LGN5_20 , 1244 

LGN5_21 , 1243 

LGN5_22 , 114 

LGN5_23 , 1201 

LGN5_24 , 1250 

LGN5_25 , 116 

LGN5_26 , 114 

LGN5_30 , 1303 

LGN5_31 , 1250 

LGN5_32 , 1203 

LGN5_33 , 1212 

LGN5_34 , 1212 

LGN5_35 , 1250 

LGN5_36 , 1212 

LGN5_37 , 1212 

LGN5_38 , 1212 

LGN5_39 , 1203 

LGN5_40 , 1245 

LGN5_41 , 1801 

LGN5_42 , 1807 

LGN5_43 , 1245 

LGN5_44 , 1202 

LGN5_45 , 1212 
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LGN5_46 , 1250 

G1-2 , 1202 

GbDk , 104 

GbKz , 104 

GbMk , 104 

GbOk , 104 

GbXk , 104 

GoDk , 104 

GoH , 106 

GoMk , 104 

GoOk , 104 

GoXk , 104 

GzA , 106 

GzKz , 104 

GzP , 106 

Gz/o/bM , 102 

Gz/o/bO , 102 

Gz/o/bX , 102 

Gz/o/bXa , 106 

Gz/o/bXk , 104 

Gz/o/bXv , 106 

HK-1 , 1250 

HM-1-2 , 1807 

HM-3 , 1224 

I.1/MzO-M-D-Z , 106 

I.3/IV.4 , 106 

II.1-2 , 111 

II.2/HK-1 , 111 

II.2-3-4-5 , 111 

II.2-3/REST-O/T , 111 

II.2-3/REST-O-U , 111 

II.2-3-4-5/REST-O/T , 111 

II.4-5/REST-O/T , 111 

III.2-3/HA-2 , 113 

IV.1-2-6-8-9/HM-1 , 1807 

IV.1-2-6-8-9/HM-1-2 , 1807 

IV.1-8-11/HM-1 , 1807 

IV.3-8 , 1224 

IV.7 , 1807 

IX.a/HA-1 , 121 

MzD-v<100 , 106 

MzD-zv , 106 

MzM-v<100 , 106 

MzM-zv , 106 

MzO-zv , 106 

MzZ-v<100 , 106 

MzZ-zv , 106 

OK-1 , 1250 

REST , 1250 

REST-O-T , 1250 

REST-T , 1250 

RnM/RnO , 105 
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RvD/RvM , 106 

RvX/RwX , 106 

UK-1 , 1250 

V.2 , 1804 

VI.1 , 1231 

VI.1/HB-2 , 1231 

VI.4/HB-1 , 1245 

VI.9/HB-4 , 1247 

VI.10/HB-5 , 1246 

VI.10 , 1246 

 

# de volgende lijst bestaat uit codes uit TOP10LN, het betreft de visualisation code  

visualisation code, ruwheidscode 

 

14010 , Akker 

14020 , Steenbekleding 

14022 , Steenbekleding 

14030 , Bebouwd/verhard terrein 

14040 , Boomgaard hoogstam 

14050 , Productiebos zachthout 

14060 , Hardhoutooibos 

14070 , Griend 

14080 , Hardhoutooibos 

14090 , Productiebos naaldhout 

14100 , Steenbekleding 

14110 , Steenbekleding 

14122 , Boomgaard laagstam 

14130 , Natuurlijk gras/hooiland 

14140 , Droge ruigte 

14160 , Natuurlijk gras/hooiland 

14170 , Zachthoutooibos 

14190 , Kribvakstrand/Zandplaat/Grindplaat 

 

# de volgende lijst bestaat uit codes uit VEGWAD, het betreft de STRUCLEG code  

STRUCLEG, ruwheidscode 

nvt , 101 

K , 111 

L , 1203 

H , 1212 

D , 1211 

R , 1215 

S , 1231 

B , 1244 

 

# de volgende lijst bestaat uit codes uit OpenStreetMap, het betreft de fclass code  

fclass, ruwheidscode 

 

allotments , 1202 

cemetery , 121 

commercial , 114 

farm , 121 

forest , 1245 
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grass , 1202 

heath , 1212 

industrial , 114 

meadow , 1201 

military , 114 

nature_reserve , 1202 

orchard , 1242 

park , 1202 

quarry , 113 

recreation_ground , 1202 

residential , 115 

retail , 114 

scrub , 1202 

vineyard , 1242 

 

# de volgende lijst bestaat uit codes uit CorineLandCover, het betreft de Code_06 

Code_06, ruwheidscode 

111 , 114 

112 , 114 

121 , 114 

122 , 114 

123 , 114 

124 , 114 

131 , 113 

132 , 113 

133 , 113 

141 , 1202 

142 , 1202 

211 , 121 

221 , 1242 

222 , 1242 

231 , 1201 

242 , 121 

243 , 121 

311 , 1245 

312 , 1245 

313 , 1245 

321 , 1202 

322 , 1212 

324 , 1202 

333 , 1250 

411 , 1801 

412 , 1801 

511 , 102 

512 , 106 

 

# de volgende lijst bestaat uit codes uit ATKIS2013, het betreft de OBJART_TXT 

OBJART_TXT, ruwheidscode 

 

Wohnbauflaeche, 115 

FlaecheGemischterNutzung, 115 

Wald, 1244 
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IndustrieUndGewerbeflaeche, 115 

FlaecheBesondererFunktionalerPraegung, 115 

SportFreizeitUndErholungsflaeche, 1202 

Strassenverkehr, 114 

Gehoelz, 1823 

StehendesGewaesser, 104 

Friedhof, 114 

Platz, 116 

Moor, 1802 

UnlandVegetationsloseFlaeche, 111 

Fliessgewaesser, 104 

Bahnverkehr, 113 

Heide, 1212 

FlaecheZurZeitUnbestimmbar, 101 

TagebauGrubeSteinbruch, 114 

Flugverkehr, 114 

Halde, 1202 

Landwirtschaft, 121 

Schiffsverkehr, 106 

Sumpf, 1804 

Hafenbecken, 106 

Bergbaubetrieb, 115 

 

# de volgende lijst bestaat uit codes uit DTB, op basis van CTE code 

CTE, Ruwheidscode 

 

B010103,114 

B010103,114 

B010307,114 

B010309,114 

B010311,114 

B010315,114 

B010501,114 

B010503,114 

B03,114 

B0305,114 

B0311,114 

B0315,114 

B0335,113 

B034507,106 

B0349,114 

B0501,114 

B0503,114 

B0507,114 

B0509,114 

B0515,114 

B0517,114 

B0521,114 
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B0529,114 

B0535,114 

B0537,114 

B0539,114 

B0541,114 

F13,1202 

F15,1202 

F21,114 

F23,113 

F41,114 

F47,116 

F51,1202 

F57,114 

F59,1202 

F73,1202 

MD16,114 

MD33,116 

MD42,114 

MD49,106 

N010907,1250 

N030101,121 

N030103,1202 

N0307,1246 

N050101,1202 

N0501053,1814 

N0501091,1202 

N0503,1242 

N0503036,1233 

N0503051,1242 

N07,121 

Q01,106 

Q23,114 

Q29,114 

R27,114 

R3101,113 

R3105,113 

R3107,113 

R59,106 

R63,114 

R83,114 

T0103,114 

V010101,116 

V010103,116 
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V0103011,113 

V0103012,113 

V0103013,116 

V0103015,116 

V0103031,113 

V010305,113 

V010307,1202 

V0105,1202 

V030103,113 

V0303,113 

V0305,112 

W0101,102 

W0301,102 

W030703,106 

W0701,106 

B010301,114 

B0341,114 

B0351,114 

B0359,114 

B0527,114 

MD46,114 

N010903,1250 

N0309,121 

N0501051,1801 

W0705,106 
 

 

 


